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Introducción

 Revit es un software BIM que ofrece varias 
facilidades para desarrollar un proyecto, permitiendo 
el ingreso de información dentro de elementos de 
modelado, información que posteriormente puede 
ser extraída para gestiones varias mediante planos 
o Tablas de datos.

Por la importancia que se le está dando ya en el 
ámbito profesional, el uso de este programa es 
impartido en la Facultad de Arquitectura de la 
Universidad de San Carlos de Guatemala durante 
ya hace varios años y este se ha ido aplicando por 
los recién graduados en proyectos que desean 
generar en su vida profesional. 

Durante el uso del mismo surgen las interrogantes: 
¿Qué se debe entregar? ¿Qué solicita cada 
dependencia? ¿Qué se debe ver en cada plano? 
¿Cómo se puede lograr esto en Revit?

Debido a esto se plantea el interés por la creación 
de una guía de uso del software para planificación 
de proyectos de arquitectura, que muestra la forma 
en la que se puede extraer la información del 
modelo realizado dentro de Revit y su aplicación 
en planos con la ayuda de herramientas contenidas 
en el mismo software.

Para su planteamiento se realizaron encuestas 
a catedráticos y estudiantes que hacen uso del 
software o bien, que han visto los resultados de este  
día a día, conociéndose las fortalezas y deficiencias 
que se presentan al extraer la información de forma 
gráfica en planificaciones de proyectos.



Gracias a los resultados, el presente documento 
contiene capítulos varios en los que se explicará 
poco a poco el concepto de cada elemento de 
planificación, su aplicación para cada uno hasta 
llegar a las instrucciones detalladas de uso para 
lograr un fin mediante ejemplos concretos y visibles 
como lo son los mismos planos.

Contiene Tablas e información gráfica en donde el 
lector podrá hacerse una idea del juego de planos 
que debe entregar además de encontrarse con la 
explicación de algunas herramientas de Revit que le 
permitirán enriquecer estos planos de forma gráfica/
técnica.

En el último capítulo es donde las instrucciones de 
uso son acompañadas de planos ejemplo en donde 
se muestra paso a paso la forma de conseguir estos 
resultados y se guía al lector mostrando opciones 
de uso de herramientas, aconsejando cuál de estas 
es la opción correcta para cada situación.
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01
Descripción de 
Problemática

01.1. MARCO CONTEXTUAL

01.1.1 Antecedentes

 Durante los años se han implementado 
cursos para enriquecer la expresión gráfica desde 
los trazos a mano hasta los trazos a computadora. 
Estos cursos siempre han fortmado parte del pensum 
de estudios de la carrera de Arquitectura ya que 
uno de los objetivos de un arquitecto es plasmar sus 
ideas de forma gráfica, con el uso de líneas, color 
y textos que hacen que estas se comprendan y se 
vuelvan una realidad.

Para apoyo a estos cursos se han realizado diversos 
manuales, tesis o guías para el estudiante, en donde 
este puede aprender por su cuenta sobre el uso 
de estos elementos de expresión gráfica de forma 
manual. 
Todos estos elementos han sido necesarios desde 
siempre y desde los últimos años se hace necesaria 
su aplicación de forma digital.

La Unidad Digital históricamente ha carecido de 
documentos de apoyo a la docencia por lo tanto 
han empleado documentos cortos con relación a 
configuración de elementos de expresión gráfica 
complementado con clases magistrales; pero aún 
así el tiempo de desarrollo del curso se vuelve 
escaso y los catedráticos solamente logran dar de 
manera general los alcances del software en el cual 
es posible representar correctamente un proyecto 
arquitectónico de forma digital e impresa.

Igualmente, en la actualidad varias instituciones se 
han preocupado por  iniciar la implementación de 
BIM en proyectos guatemaltecos y ofrecen cursos 
en donde se asesora al estudiante en el modelado 

de un proyecto arquitectónico desde el inicio 
(importación de planos ya realizados en AutoCAD) 
hasta su “culminación”, en la cual solamente se 
obtiene un modelo de un proyecto arquitectónico 
sin haber extraído la información completa.

Algunos manuales entregados en estos cursos de 
pago y algunas guías trabajadas por los mismos 
desarrolladores del software han tratado de apoyar 
a los lectores en el uso del programa para aplicar 
a una planificación, lastimosamente estos se vuelven 
unos documentos con ejemplos diversos que se 
encuentran totalmente aislados.
Igualmente el resultado de estos no se puede 
visualizar como un plano completo o útil en gran 
manera, solamente tratan de guiar al estudiante 
para trabajar en el software sin tener un resultado 
medible como lo es una planificación básica.

Los alumnos o estudiantes han comprobado que 
es difícil guiarse de forma independiente con estos 
temas, ya que al realizar una búsqueda de las 
herramientas, estas solo muestran la forma de uso, no 
qué resultados puedan tener con estas.
Debido a esto, se hace necesaria una guía que 
aclare el tipo de uso de estas herramientas y el 
resultado que se puede tener con ellas.

Esta guía fue solicitada por la Unidad Digital como 
documento para apoyo a la docencia en el cual 
los estudiantes y profesionales recién egresados 
podrán tomar un ejemplo para iniciar a abrirse paso 
por el campo profesional de la arquitectura.
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Así mismo, además de contar con una guía que 
instruya al estudiante en el uso del programa, en 
este documento también se podrán estandarizar 
varios componentes de planificaciones para un 
proyecto, esto basado bajo experiencias laborales 
y lo observado al realizar entregas de proyectos a 
entidades públicas y privadas, conociendo así lo 
que se necesitará en el campo laboral.
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01.1.2 Identificación del problema

 Algunas empresas han comenzado a optar 
por profesionales que cuenten con el manejo de 
softwares BIM. Al contratar al personal, las empresas 
miden las competencias según lo descrito en 
las hojas de vida de los contratados donde se 
asegura un correcto manejo de las herramientas 
alojadas en Revit, todo va de manera correcta 
hasta que los encargados solicitan planos impresos 
de los proyectos; plantas, secciones, elevaciones 
y detalles en donde es necesaria una correcta 
expresión gráfica y en donde el profesional pone 
en evidencia el desconocimiento de la herramienta 
y de los temas que son necesarios conocer en los 
planos. 

La persona con “experiencia en Revit y en proyectos” 
presenta a sus encargados una documentación 
deficiente y con una representación en donde el 
proyecto no se comprende, lo que causa que los 
profesionales de las distintas disciplinas dejen de 
creer en dicho software y que los mismos arquitectos 
egresados en el pasado confíen más en la 
fidelidad de programas CAD y opten por rechazar 
inmediatamente al programa BIM y/o a quien 
asegura manejarlo.

Estos puntos han sido comprobados por algunos 
arquitectos, mostrando descontento con la 
herramienta y con entregas que presentan algunos 
estudiantes. Este inconveniente se ha tratado de 
solucionar con las asignaturas impartidas por el 
Área Digital, el Área de Sistemas Constructivos o 
tras asesorías en Diseño Arquitectónico, sin embargo 
es difícil que los estudiantes logren comprender por 
iniciativa propia contando con tan poco tiempo 
para cada tema o que traten de aprender durante 
el desarrollo de entregas programadas en cada 
curso.

Otro de los inconvenientes que se observa en 
Guatemala es que Revit algunas veces se utiliza 
simplemente como una herramienta de modelado  
para presentación o como una herramienta de 

dibujo. Esto causa inconvenientes ya que el 
programa debe ser utilizado para un entorno BIM, 
es decir, en un modelo en el cual se puede guardar 
información que posteriormente será plasmada en 
planos y Tablas de cuantificación, por lo tanto el 
uso incorrecto de este desde el entorno estudiantil 
puede causar equivocaciones sobre el manejo de 
la herramienta.

Debido a todas estas razones, el Área Digital 
propone una profundización de los temas 
mencionados para tener un documento de apoyo 
como auxiliar para las diferentes clases que tendrán 
durante los semestres. 

En este documento se pretende guiar al lector 
en el manejo de los diferentes componentes 
dentro del software BIM Autodesk Revit para la 
mejora de representaciones gráficas de modelos 
arquitectónicos desarrollados en dicho programa, en 
donde se colocarán instrucciones gráficas y escritas 
en el proceso de utilización de la herramienta. 
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01.1.3 Justificación

 La idea de la realización de este documento 
surge de la necesidad de los catedráticos y 
estudiantes de contar con un documento tipo 
manual de apoyo con el que podrán auxiliarse en los 
temas que son impartidos en la fase de arquitectura 
de Herramientas Digitales 3, en donde se instruye 
a los alumnos en el uso del software BIM Autodesk 
Revit para entregas de planos constructivos.

Debido a los resultados obtenidos mediante una 
encuesta realizada a catedráticos de FARUSAC 
durante el desarrollo de este documento, entre el 
70% y el 90% de los encuestados consideran que 
los alumnos presentan carencias en el manejo de la 
herramienta y la expresión gráfica realizada con ella; 
por lo que queda evidenciada la necesidad de 
material de apoyo que plantee de forma gráfica/
escrita las actividades y procesos que contribuyan a 
mejorar las técnicas de documentación empleadas 
por los usuarios.

Durante la existencia del software siempre ha 
habido manuales de implementación del programa, 
explicando el uso de cada herramienta con ejemplos 
varios que terminan siendo objetos aislados, al ver 
esto son instrucciones difíciles de aplicar ya que 
estas no fueron realizadas con el objetivo de 
apoyar una cátedra, sino solamente fueron hechas 
para brindar un apoyo rápido durante el uso del 
programa.

Por lo tanto, en esta guía se explicará diferentes 
métodos para lograr accesos fáciles para realizar 
los procedimientos de planificación y mejorar el 
tiempo que se invierte en fases de entregas de 
proyectos a lo largo de la carrera, o bien, dentro 
del campo profesional.

Este conocimiento les brindará una ventaja en el 
mercado laboral actual en el cual las empresas 
comienzan a optar por softwares que les permiten 
adaptarse a la metodología BIM y que solicitan 
tener un conocimiento básico del manejo de un 
proyecto arquitectónico. 

01.1.4 Delimitación del Problema

01.1.4.1 Temporal: 

 El período comprendido para la elaboración 
de este documento abarca de Julio de 2018 a 
Febrero de 2020, tiempo en el que se desarrollará 
el proceso de recopilación de contenido gráfico/
escrito. Al terminar el documento, este podrá ser 
utilizado en el curso de Herramientas Digitales 3 
por un tiempo aproximado de 3 años o hasta que 
se vean cambios considerables dentro del software 
Autodesk Revit.

01.1.4.2 Geográfica: 

 El documento será desarrollado y aplicado 
dentro del campus central de la Universidad de 
San Carlos de Guatemala, ubicada en 11 Avenida, 
Zona 12 de la Ciudad de Guatemala.

01.1.4.3 Poblacional: 

 Esta guía será de utilidad para los 
estudiantes del curso de Herramientas Digitales 
3 perteneciente a la carrera de arquitectura de la 
Universidad de San Carlos de Guatemala y para 
cualquier estudiante o usuario del software BIM 
Autodesk Revit que desee conocer los distintos 
procedimientos a seguir para conseguir una 
mejora en la representación gráfica de modelos 
arquitectónicos realizados en esta herramienta.

01.1.4.4 Teórica: 

 La guía se limitará a las herramientas para 
el mejoramiento de la representación gráfica 
englobadas en el software BIM Autodesk Revit, 
procedimiento apoyado por medio del desarrollo 
de pasos gráficos/escritos acoplados en distintos 
escenarios para su correcta comprensión y en 
indicar la forma de representar correctamente 
algunos elementos gráficos en planos.

El documento de apoyo se basará en el programa 
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de contenidos de la fase de planificación 
arquitectónica en la asignatura de Herramientas 
Digitales 3 en donde el catedrático del curso 
podrá proporcionar una guía adicional a las clases 
magistrales brindadas dentro de los laboratorios.

01.1.5 Objetivos

General:

Brindar una guía dirigida a los estudiantes de la 
Facultad de Arquitectura de la Universidad de San 
Carlos de Guatemala que cursan la asignatura 
de Herramientas Digitales 3 acerca del uso y 
configuraciones necesarias en Autodesk Revit para 
la presentación de planos de arquitectura.

Específicos:

• Comprender los requisitos técnicos y legales que 
debe cumplir una planificación de arquitectura 
para ser elaborada mediante un software digital 
sin faltar a la calidad de dibujo técnico con 
instrumentos.

• Identificar las configuraciones generales que 
permiten personalizar las herramientas de dibujo 
en un archivo de proyecto dentro del software.

• Definir configuraciones y plantillas de vista 
que permitan alcanzar líneamientos técnicos e 
información requerida en una planificación de 
arquitectura según cada tipo de plano.
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01.1.6 Herramientas Digitales en 
Arquitectura

 A través del tiempo se han implementado 
diferentes programas de computadora para 
realizar proyectos arquitectónicos además de la 
utilización del papel y lápiz, esto ha permitido que el 
trabajo sea más eficiente y que en caso de alguna 
modificación o discrepancia en el desarrollo de un 
proyecto, este pueda ser fácilmente modificado sin 
necesidad de realizar todo el dibujo desde cero. 
Estos programas hacen que también se pueda 
tener un proyecto histórico con versiones editables 
y reimprimibles para cualquier referencia.

Los diferentes tipos de software más utilizados en 
el campo de la arquitectura en el mundo son los 
Software CAD (Computer Aided Design) o CADD 
(Computer Aided Design & Drafting), que permiten 
realizar diseños en formatos 2D y 3D, cambiar su 
escala y manipular su forma en diferentes vistas y 
perspectivas ajustándose automáticamente; y los 
Software BIM (Building Information Modeling) que 
tienen la capacidad de ser una base de datos 
almacenada en modelos y archivos colaborativos, 
esta flexibilidad permite que de forma digital se 
represente el aspecto físico de un edificio para 
poder ser evaluado en sus diferentes etapas (diseño, 
construcción y operación).1

1  Craven, Jackie. “CAD and BIM Architecture and De-
sign Software.” ThoughtCo. https://www.thoughtco.com/what-is-
cad-or-bim-178399 (Acceso 20 de Agosto, 2018).  

01.1.6.1 Software CAD en arquitectura

 Como anteriormente fue mencionado, los 
software CAD permiten realizar diseños en formatos 
2D y 3D. Estos programas tienen sus orígenes desde 
hace aproximadamente 60 años; en 1957 el Dr. 
Patrick Hanratty creó el primer sistema de control 
numérico que más tarde sería llamado CAD, el 
programa revolucionó la ingeniería, arquitectura y 
la industria, permaneciendo en estos campos en la 
actualidad.2 

2  Ibíd.
 Caudill, Laura. “60 Years of CAD Infographic: The 
History of CAD Since 1957” Part Solutions. https://partsolu-
tions.com/60-years-of-cad-infographic-the-history-of-cad-sin-
ce-1957/ (Acceso, Agosto 2018)
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Historia de CAD

Imagen 1: The history of CAD. 
Elaborado por Cadenas 
PARTSolutions. Estados Unidos, 
2017.
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01.1.6.2 Software BIM en Arquitectura

 El concepto BIM (Building Information 
Modeling) es originado desde 1974 por el profesor 
Arq. Charles M. Eastman sobre una investigación 
titulada ”An outline of the building description 
System” en donde crea un sistema informático en 
el cual  almacena y manipula información de un 
proyecto para luego ser clasificada para su análisis, 
este es llamado BDS (Building Description System) o 
BPM (Building Product Modeling). 
Su necesidad surge de los inconvenientes y 
las pérdidas de tiempo que observadas en un 
proyecto ya que este debía modificarse varias 
veces antes, durante y después de cada fase 
(diseño, planificación y construcción).3  

3 BibLus “Nacimiento del BIM y el modelo virtual según 
Eastman”. BibLus. http://biblus.accasoftware.com/es/nacimien-
to-del-bim-eastman/  (Acceso Agosto, 2018)

Esta metodología comenzó a ser llamada BIM en el 
año 1986. 4 

A partir de esto, varias empresas comenzaron a 
desarrollar diferentes software BIM como:

• Allplan desarrollado por George Nemetschek 
(Alemania).

• ArchiCAD desarrollado por Graphisoft (Hungría).
• Revit desarrollado por Revit Technology 

Corporation el 5 de abril del 2000.5 (Texas, 
Estados Unidos).

4 Osca, Celia “Incidencia del BIM en el proceso-pro-
yecto construcción de arquitectura”. (Guadalajara, 2017)
5 Toribio, Rebeca. “¿De Dónde Salió el Concepto 
BIM? Algunas Aclaraciones”. BIM Blog. http://blog.triart.com.
do/2018/04/04/concepto-bim/ (Acceso Agosto de 2018)

Portada del documento “Esquema del Sistema de Descripción de Edificación”
(An outline of the building description System)

Imagen 2: Escaneo de portada del documento de investigación del profesor Arq. Charles M. Eastman. Publicado 
por Rebeca Toribio. Agosto de 2018 



18

M A R C O  C O N T E X T U A L

Historia de la Implantación 
BIM

Imagen 3: Historia de la Implantación 
BIM desde la investigación de Charles 
Eastman hasta su implementación 
obligatoria en Proyectos Públicos 
de España. Elaborado por Seys, 
Soluciones TICs. España, 2018. https://
seystic.com/bim-la-historia-del-building-
information-modelling/ (Acceso en 
Septiembre 2018).
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Durante el paso del tiempo se han ido desarrollando 
más programas BIM para arquitectos, ingenieros y 
constructores. Por ejemplo:

PROGRAMAS BIM PARA ARQUITECTOS, INGENIEROS Y CONSTRUCTORES

ARQUITECTURA INGENIERÍA CONSTRUCCIÓN

Revit Revit Buildertrend

ArchiCAD AutoCAD Civil 3D Edificius

Allplan Tekla Structures

AECOsim Building Designer AECOsim Building Designer

Vectorworks Architect Dassault Systemes BIM

Edificius Hevacomp

midas Gen

Tabla 1: Listado de algunos programas BIM para diferentes especialidades (Enero 2020). Por Melanie Orozco. 
Guatemala Enero de 2020. Información por Chang, Jenny. Polonia, Enero 2020. Disponible en:  https://financesonline.
com/building-information-modeling/ . (Acceso el 11 de Enero de 2020).

 En el campo de la arquitectura es posible 
elegir varias opciones de programas BIM según 
las necesidades personales o del proyecto, y 
con el paso del tiempo estos programas seguirán 
actualizándose, o bien, otras empresas comenzarán 
a desarrollar sus propias plataformas.

Este documento instruirá al alumno o arquitecto 
específicamente en el software BIM Autodesk Revit.
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Historia de Autodesk Revit

 Revit (nombre originado de “Revise It” o 
“Revise Instantly”) es un software paramétrico que 
fue creado para el trabajo en modelado BIM, este 
software permite que los cambios realizados en una 
vista sean modificados automáticamente en el resto. 
Anteriormente los software CAD permitían realizar 
fáciles modificaciones en líneas, que a diferencia de 
Revit, estas líneas debían ser modificados en cada 
plano o vista en un archivo. Revit es una base de 
datos que facilita este trabajo y que actualmente 
es utilizado para la arquitectura, ingeniería y 
construcción (AEC).6

El software inició como una idea de Leonald 
Raiz, quien laboraba para la empresa PTC 
desarrolladora del software llamado Pro-Engineer 
(software paramétrico creado para producir objetos 
mecánicos). Leonald se propuso crear un software 
similar para arquitectura, que en ese tiempo aún no 
había sido desarrollado. 

Leonald Raiz se unió con Irwin Jungreiz fundando en 
1997 la empresa Charles River Software que más 
tarde sería llamada Revit Technology Corporation. 
La primera versión de Revit (Revit 1.0) fue lanzada en 
abril del año 20007 y en el año 2002 fue adquirido 
por Autodesk.

 Revit es un software que genera un único 
modelo que concentra toda la información de un 
proyecto en un solo archivo. 

6 Demchak, Greg. Dzambazova, Tatjana. Krygiel, Eddy. 
“MASTERING Revit Architecture 2010”. Autodesk,  https://
books.google.cl/books?id=ov_hlub0eVQC&pg=PR23&l-
pg=PR23&dq=revit+history&source=bl&ots=BmH-GkYB-
TK&sig=LjIXj_5oblug4EyYvbJtOPl1ZYQ&hl=es&sa=X&ve-
d=0ahUKEwjUkeeSzfzLAhUJIpAKHUWBAEIQ6AEIbzAJ#v=one-
page&q=revit%20history&f=false. (Acceso en Noviembre de 
2018)
7 Medina, Alfredo. Forums Autodesk. “Qué es Revit y 
su Historia” https://forums.autodesk.com/t5/revit-bim-espanol/
que-es-revit-y-su-historia/td-p/5660059 
(Acceso en Noviembre de 2018)

Es importante resaltar que la existencia de softwares 
de diseño tridimensional como Vectorworks y 
ArchiCAD sirvieron como precedente para el 
lanzamiento de las propuestas de Autodesk:

- AutoCAD Arquitectura, como una versión de 
trabajo mediante tecnologías CAD para  facilitar  el  
modelado de objetos arquitectónicos;
- y posteriormente en Revit como una adaptación 
del software previamente conocido como 
Architectural Desktop luego de su adquisición por 
Autodesk, siendo esta la primera aproximación a la 
metodología BIM diferenciada de las herramientas 
CAD.

Herramientas de Objetos estándar en 
AutoCAD Architecture

Imagen 4: Paleta de herramientas de objetos 
dentro de la interfaz de AutoCAD Architecture. 
Autodesk Help, Acerca de las Herramientas. España, 
2018. https://knowledge.autodesk.com/es/support/
autocad-architecture/learn-explore/caas/CloudHelp/
cloudhelp/2019/ESP/AutoCAD-Architecture/files/GUID-
E9A068D0-1658-45C7-BFB2-A03B6A09B23D-htm.html 
(Acceso en Agosto de 2020).
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Desde 2006 Revit contaba con tres diferentes 
plataformas para su venta individual; Revit 
Architecture, dedicado a la arquitectura del 
proyecto; Structure, para  su estructura y MEP 
(Mecánica, Electricidad y Fontanería) para sus 
instalaciones. Estas plataformas permitían que todos 
los modelos fueran producidos y unidos durante la 
creación de un proyecto para detectar cualquier 
colisión entre los diferentes diseños. 
El programa facilita su control permitiendo que su 
desarrollo sea más productivo, eficiente y con un 
menor impacto ecológico al evitar los desperdicios 
en materiales y energías para su construcción.

En 2013 Autodesk une estas tres plataformas y crea 
solamente Revit que ya contiene las tres disciplinas 
en un solo software. 

Otro dato importante es que anteriormente también 
se debía instalar paquetes para que Revit pudiese 
funcionar en diferentes idiomas, pero a partir de Revit 
2016 solamente es necesario cambiar la extensión 
en sus configuraciones para poder contar con el 
idioma que se necesite. Los códigos disponibles 
pueden ser encontrados en la página oficial de 
Autodesk.8

8 Autodesk HELP. “Utilizar Revit en otros Idiomas”. https://
knowledge.autodesk.com/es/support/revit-products/troubles-
hooting/caas/CloudHelp/cloudhelp/2018/ESP/Revit-Installa-
tion/files/GUID-BD09C1B4-5520-475D-BE7E-773642EEB-
D6C-htm.html
(Acceso en Noviembre de 2018)

A continuación se presenta una Tabla en donde se 
puede observar la evolución del software a través 
de los años. En esta se evidencia que el software 
ha tenido pocos cambios fuertes en relación de las 
versiones lanzadas, sin embargo las herramientas, a 
pesar de ya existir en el software, van mejorándose 
poco a poco según comentarios de los usuarios del 
programa.
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DESARROLLO DEL SOFTWARE AUTODESK REVIT

VERSIÓN DESARROLLADOR
FECHA DE 

LANZAMIENTO
(MES, AÑO)

CAMBIOS 
SIGNIFICATIVOS

Revit 0.1 Charles River Software Noviembre, 1999

Revit 0.2 Charles River Software Enero, 2000

Revit 1.0
Revit Technology 

Corporation
Abril, 2000

Primer lanzamiento 
público

Revit 2.0
Revit Technology 

Corporation
Agosto, 2000

Revit 3.0
Revit Technology 

Corporation
Febrero, 2001

Revit 4.0
Revit Technology 

Corporation
Noviembre, 2001

Revit 4.5 Autodesk Mayo, 2002
Primer lanzamiento de 

Autodesk

Revit 5.0 Autodesk Diciembre, 2002

Revit 6.0 Autodesk Diciembre, 2003

Revit 7.0 Autodesk Diciembre, 2004

Autodesk Revit Building 
8.0

Autodesk Febrero, 2005
Cambio de nombre a 
Autodesk Revit Building

Autodesk Revit Structure Autodesk Desconocido, 2005
Crean la versión 

Structure

Autodesk Revit Building 
9.0

Autodesk Abril 2006

Autodesk Revit MEP Autodesk Desconocido, 2006 Crean la versión MEP

Revit Architecture 2008, 
Structure 2008 y MEP 

2008
Autodesk Abril, 2007

Cambio de nombre de 
Autodesk Revit Building 
a Revit (Architecture, 

Structure y MEP)

Revit Architecture 2009, 
Structure 2009 y MEP 

2009
Autodesk Abril, 2008
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Tabla 2 Desarrollo del Software Autodesk Revit desde su creación hasta el año 2020. Por Melanie Orozco. 
Guatemala, Noviembre de 2019. Información por Autodesk Revit. Noviembre 2019. Disponible en:  https://
knowledge.autodesk.com/es/support/revit-products/downloads/caas/downloads/downloads/ESP/content/autodesk-
revit-2015-product-updates.html

Autodesk Revit 
Architecture 2010, 

Structure 2010 y MEP 
2010

Autodesk Abril, 2009

Cambio de nombre 
de Revit (Architecture, 

Structure y MEP) 
a Autodesk Revit 

(Architecture, Structure y 
MEP)

Autodesk Revit 
Architecture 2011, 

Structure 2011 y MEP 
2011

Autodesk Abril, 2010

Autodesk Revit 
Architecture 2012, 

Structure 2012 y MEP 
2012

Autodesk Abril, 2011

Autodesk Revit 2013 Autodesk Marzo, 2012
Architecture, Structure y 
MEP en un sólo software

Autodesk Revit 2014 Autodesk Marzo, 2013

Autodesk Revit 2015 Autodesk Abril, 2014
Se abandona el 

soporte para 32-bit

Autodesk Revit 2016 Autodesk Abril, 2015
Incluye todos los idiomas 

sin instalación de 
paquetes adicionales.

Autodesk Revit 2017 Autodesk Abril, 2016

Autodesk Revit 2018 Autodesk Abril, 2017

Autodesk Revit 2019 Autodesk Abril, 2018

Se añade la ficha 
“Steel” o “Acero” en 
la para darle mayor 
versatilidad y mejor 

funcionamiento a estos 
elementos.

Autodesk, Revit 2020 Autodesk Abril, 2019
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01.1.7  Herramientas Digitales en 
FARUSAC

 La Unidad Digital ha sufrido algunos 
cambios desde el momento de su inicio, estos han 
sido efectuados por distintos coordinadores en la 
búsqueda de la mejora de los cursos de Herramientas 
Digitales dentro de la carrera de Arquitectura.9

Para la unidad siempre hubo altibajos durante los 
años previos a su oficialización, sin embargo esta 
logró ser instaurada para el mejoramiento del 
pensum de estudios en el área de Tecnología.

Imagen 5: Línea de tiempo, conformación de la Unidad 
Digital y Tecnología. En conversación con Dra. Arq. Sonia 
Fuentes. Ver imagen completa en Anexos. Por Melanie 
Orozco, diciembre 2020.

9 Dra. Sonia Fuentes, entrevista, conferencia de 
Google Meet, octubre de 2020.

Se planteó la idea de implementar la propuesta de 
enlace de cursos durante el año 2020, sin embargo, 
debido a los acontecimientos del mismo año, fue 
necesario posponer esta implementación hasta una 
nueva fecha.
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01.2. MARCO CONCEPTUAL

01.2.1 Metodología

Dicha investigación y guía práctica será resuelta 
bajo el método deductivo, en cuál pretende, de 
manera intuitiva y experimental, dar a conocer la 
realidad de datos recabados en el orden jerárquico 
de macro a micro; en la búsqueda de organizar la 
información obtenida y los pros y contras que la misma 
representa. Esto complementando la síntesis con el 
auxilio de parámetros técnicos-representativos que 
contribuyan a la mejora continua de la temática 
analizada.

La investigación es dividida en segmentos de la 
siguiente manera:

01.2.1.1 Los Indicadores

 Datos o información recopilada y ordenada 
de una forma temática, información íntimamente 
ligada con observación, encuestas y reportes de 
levantamiento de datos físicos; estos parten de datos 
y valores intangibles que evidencian la situación en 
la que se encuentra el elemento analizado.

01.2.1.2 Las Variables

 Luego de analizados los indicadores 
se procede al proceso de segmentación e 
identificación de las variables, mismas que pueden 
ser causa o efecto directo de la problemática, 
por lo que la evidenciarlas con antelación permite 
organizarlas del lado de la balanza en que deban 
ser agrupadas.

01.2.1.3 Los Sujetos

 Proceso mediante el cual se evidencian 
los elementos a intervenir en la investigación, de 

forma positiva hacia la misma, dentro de los cuales 
podríamos mencionar el diseño y plan estratégico 
de la investigación y los recursos asignados a la 
misma.

01.2.1.4 Los Instrumentos

Elementos generalmente tecnológicos aplicados 
directamente en búsqueda de plantear una solución 
lógica a la problemática suscitada.

01.2.2 Glosario de Términos

2D: Elementos que solamente se representan como 
líneas o elementos que contienen ancho y alto pero 
carecen de profundidad. 

3D: Son elementos en 3 dimensiones, esto significa 
que cuentan con medidas en ancho, alto y 
profundidad.

AEC: Por sus siglas en inglés Architecture, Engineering 
and Construction. Se refiere a la industria de la 
arquitectura, ingeniería y construcción. 

Alfabeto de Líneas: Se refiere al uso de espesores 
o colores de líneas según el plano en el que se 
encuentra el elemento representado por estas. 

Software BIM: Por sus siglas Building Information 
Modeling, son programas que permiten el ingreso 
de información dentro de elementos de modelado 
para después poder ser utilizados en gestión de 
información.

Sofware CAD: Por sus siglas en inglés Computer-
Aided Design, son programas que permiten el diseño 
de proyectos asistidos por un computador. 

Colisiones entre Instalaciones: Se refiere a los 
problemas que se dan al tener topes o interferencias 
entre accesorios, equipos o tuberías de diferentes 
instalaciones.

Composición en planos: Ciertos elementos de 
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visualización (vistas, simbologías, notas, etiquetas) 
que organizados y relacionados entre sí conforman 
un plano ordenado y legible visualmente.

Dependencia Municipal: Diferentes oficinas 
municipales que se encargan de brindar 
aprobaciones de ejecución de proyectos según el 
tema que abarcan (Ej. Impacto Vial).

Dibujo Técnico: Representación gráfica y técnica 
de un elemento que brinda información suficiente 
para su construcción o interpretación mediante un 
dibujo en 2D.

Disciplinas: Se refiere a los diferentes tipos de 
profesiones o de especialidades en un tema que se 
involucran en un proyecto.

DWF: Por sus siglas en inglés Design Web Format. Es 
un tipo de archivo de tamaño mínimo en el cual se 
pueden compartir los planos de un proyecto. Este 
tipo de archivo puede ser generado en programas 
CAD o en Revit y es utilizado simplemente para 
compartir documentos de proyectos o para anotar 
observaciones dentro del mismo.

DWG: Significa DraWinG. Es la extensión de los 
archivos generados desde el programa AutoCAD o 
para ser abiertos dentro de este.

Emplazamiento: Se refiere al entorno en el que se 
encuentra ubicado el proyecto.

Especialistas: Son los expertos en diferentes temas 
(instalaciones, estructuras, manejo del ambiente)  
que se encuentran involucrados en un proyecto 
arquitectónico.

Expresión Gráfica: Es una técnica por la cual se 
comunican las ideas de un todo de forma visual. Esta 
se conforma de distintos elementos que permiten 
que se mejore la comunicación sin necesidad de 
explicación textual.

Gestión: Es el proceso que se realiza para manejar 
o administrar un proyecto.

Herramienta:  Es el conjunto de elementos o 
instrumentos que sirven para desempeñar una tarea.

HVAC: Por sus siglas en inglés Heating, Ventilation 
and Air Conditioning. Llamado así al sistema de 
ventilación y climatización de un ambiente.

Institución: Es una organización que desempeña o 
cumple con una tarea para el interés público.

Interfaz: Es el contenido gráfico de una aplicación 
que permite la interacción del usuario con el 
programa.

Margen: En este documento es el límite de uso de 
una página o formato, todo el contenido de un 
plano debe estar dentro de este.

MEP: Por sus siglas en inglés Mechanical, Electrical 
& Plumbing. Se refiere a estos aspectos de la 
construcción.

Parámetros: Características o datos que definen o 
condicionan un elemento.

Planos de Taller: Son planos detallados de 
construcción que se realizan después de la 
realización de planos constructivos, estos se basan 
en la información brindada dentro de los planos 
constructivos y los utilizan para detallar ensamblajes, 
uniones o piezas de cada uno de los elementos 
del objeto arquitectónico (Ej. Puertas, ventanas, 
mobiliario).

Programa Paramétrico: Programa o software 
mediante el cual es posible añadir parámetros o 
variables que condicionen o manipulen al proyecto 
que se está trabajando dentro de él.
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01.2.3 Importancia de la Correcta 
Expresión Gráfica

 Al desarrollar un proyecto es necesario que 
el profesional o estudiante de arquitectura elabore 
planos que expresen de forma correcta los ingresos, 
recorridos, niveles, muros, ventanas, mobiliario, gradas, 
rampas o cualquier elemento que lo compone. Esto 
no solo ayudará a que el proyecto se comprenda 
a  simple vista por cualquier involucrado sino 
también a que las personas que vean la calidad de 
información entregada comiencen a confiar cada 
vez más en dicho profesional.

Una de las situaciones que se presenta es que 
algunas veces se entregan renders y visualizaciones 
de algunos ambientes del proyecto que 
permiten “vender” o sorprender al posible cliente, 
convenciéndolo de un contrato pero al entregar 
la planificación, el constructor no comprende de 
forma correcta lo que representa cada contenido, 
construyendo y aplicando acabados, volúmenes 
o detalles arquitectónicos de forma incorrecta. 
Esto implica pérdidas en presupuesto y pérdidas 
de tiempo que harán que al final no se entregue 
el resultado esperado y haga que perdamos 
credibilidad en el campo laboral. 

Además de esto, cuando se empieza a desempeñar 
profesionalmente, se evidencia que la carrera no 
sólo implica la comunicación entre arquitectos sino 
también con profesionales de otras especialidades 
que necesitarán trabajar sobre el proyecto que se 
está desarrollando; entre estos se puede mencionar: 
Especialistas Hidrosanitarios, Eléctricos, 
Mecánicos, Topógrafos, especialistas en 
Iluminación, diseño del paisaje, etc.

Al compartir información con el resto de involucrados, 
algunas veces se observan discrepancias en 
lo expuesto en reuniones y lo que se observa en 
los planos machotes entregados; es de suma 
importancia que los planos entregados representen 
de la forma más clara posible la función o lo que 
representa cada línea para evitar tener colisiones 

entre instalaciones y elementos arquitectónicos 
o incluso que alguna instalación no pase en los 
lugares donde se le necesita.

Al entregar la información necesaria para desarrollar 
el proyecto también debemos entregar a cabalidad 
los contenidos para EMPAGUA, Municipalidad, 
CONRED, CONADI, IDAEH o para cualquier 
otra división de la que necesitemos permisos para 
comenzar a construir el proyecto. Es necesario 
que esta información pueda ser lo suficientemente 
clara para la comprensión del personal que nos 
acompañará en todo el proceso de aprobación 
de licencias para evitar malentendidos y exceso 
de observaciones para añadir información que 
ya está indicada en planos pero que es difícil de 
comprender.

01.2.4 Elementos del Lenguaje Técnico en 
Revit

Durante los años se han adoptado algunos tipos de 
elementos o componentes gráficos para representar 
lo que se necesita en un plano técnico; estos 
elementos es posible realizarlos de forma manual 
y, aunque algunas veces se piense lo contrario, 
también es posible representarlos en el software 
Autodesk Revit.

La intención de este inciso es solamente demostrar a 
grandes razgos qué herramientas es posible utilizar 
en Revit para lograr un equivalente del elemento 
del lenguaje gráfico a mano y dar una muestra de 
lo que se puede lograr con el uso del programa.. 
Más adelante en este documento (capítulo 04 
inciso 04.1) se indicará el proceso de elaboración  
o configuración del elemento en Revit.
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FORMAS EQUIVALENTES DE LOS ELEMENTOS DEL LENGUAJE GRÁFICO

ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN Y APLICACIÓN 
EN DIBUJO MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

LÍ
N

EA

De Contorno Principal

Esta puede ser una línea 
principal en una hoja,   
línea de margen o el 
contorno de  una hoja 
de trabajo.

Representación:

Se logra de la siguiente forma:

Realizando un trazo fuerte con mina 
o un lápiz HB

Trazo con Rapidógrafo 0.8 - 1.2

Representación:

En Proyecto 
se logra 
utilizando las 
herramientas:

Línea de 
detalle (DL)

Línea de 
modelo (LI)

Tipo de línea 
(LW)

En Familias 
se logra 
utilizando las 
herramientas:

Línea simbólica:

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Line Styles 
y/o Line Weights
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

LÍ
N

EA

De Contorno General

Estas pueden ser líneas 
que indican filos o caras 
de una pieza.
Esta pieza debe ocupar 
un primer plano para 
hacer uso de este tipo 
de línea.

Representación:

Se logra de la siguiente forma:

Realizando un trazo con mina HB o F

Trazo con Rapidógrafo 0.5 - 0.6

Representación:

En Proyecto 
se logra 
utilizando las 
herramientas:

Línea de 
detalle (DL)

Línea de 
modelo (LI)

Tipo de línea 
(LW)

En Familias 
se logra 
utilizando las 
herramientas:

Línea simbólica:

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Line Styles 
y/o Line Weights
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

LÍ
N

EA

De Corte o Sección

Este tipo de línea indica 
los puntos o la franja 
que recorre el corte o 
sección y los elementos 
que alcanzará a cubrir y 
mostrar en el detalle.

Representación:

Se logra de la siguiente forma:

Realizando Trazos con 
mina HB

 
Realizando trazos con 
Rapidógrafo 0.8 - 1.2

Representación:

En Proyecto 
se logra 
utilizando las 
herramientas:

Herramienta 
Sección

En Familias 
se logra 
utilizando las 
herramientas:

Línea simbólica:

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Section Tags,  
Line Styles y/o Line Weights
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT
LÍ

N
EA

De Proyección

Esta línea representa 
las caras o filos de un 
objeto que se encuentra 
en segundo plano en 
una vista.

Representación:

Realizando Trazos con mina H

Realizando trazos con 
Rapidógrafos 0.2 - 0.4

Representación:

En Proyecto 
se logra 
utilizando las 
herramientas:

Línea de 
detalle (DL)

Línea de 
modelo (LI)

Tipo de línea 
(LW)

Modelando 
cualquier tipo 
de elemento.

En Familias 
se logra 
utilizando las 
herramientas:

Línea simbólica:

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Line Styles 
y/o Line Weights
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

LÍ
N

EA

De Centro o Eje

Esta línea sirve para 
representar los ejes de 
un proyecto o para 
representar el centro o 
eje de un objeto en una 
vista.

Representación:

Realizando Trazos con mina H

Realizando trazos con 
Rapidógrafos 0.2 - 0.4

Representación:

En Proyecto 
se logra 
utilizando las 
herramientas:

Eje (GR)

En Familias 
se logra 
utilizando las 
herramientas:

Línea simbólica:

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Line Styles 
y/o Line Weights
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

LÍ
N

EA

Dimensión o Cota

Estas en realidad son un 
conjunto de líneas que 
indican una dimensión, 
estas marcan de dónde 
a dónde corresponde la 
dimensión anotada. 
En sus intersecciones se 
colocan símbolos (con 
un espesor mayor) que 
marcan de mejor manera 
los límites de la cota.

Representación:

Realizando Trazos con mina H

Realizando trazos con 
Rapidógrafos 0.2 - 0.4

Representación:

En Proyecto se logra 
utilizando las herramientas:

Dimensión o cota (DI):

O bien, dentro de la ficha 
Annotate > Dimensions > 
Seleccionando el tipo de cota 
que se desee utilizar.

Configuración de este tipo de 
línea en el programa:

Edición de tipo en panel de 
propiedades

   
Y creación de tipos de puntas 
de flecha:
Dentro de la ficha Manage > 
Aditional Settings > Arrowheads

Al crearlas, es necesario 
asignarlas a la cota deseada 
dentro de cada tipo. Esto se 
realiza seleccionando la cota y 
editando el tipo en el panel de 
propiedades.
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

LÍ
N

EA

De Ruptura

Se utiliza cuando al 
dibujar un volumen 
demasiado largo o 
una vista que ocupa 
demasiado espacio en 
plano debe dividirse 
en diferentes vistas o 
diferentes hojas.

Esta línea se coloca en 
la primera vista justo en 
el punto donde se está 
cortando y finaliza el 
elemento, y lógicamente 
donde inicia en la 
próxima vista.

Representación:

Realizando Trazos con mina H

Realizando trazos con 
Rapidógrafos 0.2 - 0.4

Representación:

En Proyecto se logra 
utilizando las herramientas:

Línea de detalle (DL)

Regiones

Componente de Detalle

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Line Styles 
y/o Line Weights

  

Línea Guía

Delimita los trazos a 
trabajar e indica el 
espacio que guía al 
dibujante para rotular o 
dibujar la representación 
de un volumen.

Representación:

Realizando los Trazos con mina 2H

Representación:

En Proyecto y en creación de 
falimias se logra utilizando las 
herramientas:

Planos de Referencia (RP)
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT
LÍ

N
EA

De Límites de Terreno 
o Diseño

Estas líneas sirven para 
representar las limitantes 
municipales de un 
proyecto.  
(Alineación, Retiro 
Municipal, Servidumbres 
de Paso).

Representación:

Realizando Trazos fuertes con mina 
HB

Realizando trazos con
Rapidógrafo 1.2

Representación:

En Proyecto se logra 
utilizando las herramientas:

Línea de detalle (DL)

Línea de modelo (LI)

Líneas de Propiedad

Configuración de tipos de 
líneas en el programa:

Dentro de la ficha Manage > 
Aditional Settings > Line Styles 
y/o Line Weights

  
O bien utilizando la herramienta:
Plantillas de Vista > Filters

    



36

M A R C O  C O N C E P T U A L

ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

PL
A

N
O

S 
Y

 H
O

JA
S 

D
E 

TR
A

BA
JO

Planos
(Márgenes y 
Formatos):

Se obtienen realizando 
un margen con línea 
de contorno principal 
siguiendo dimensiones 
definidas por el 
dibujante dentro de los 
siguientes formatos:

• A4 (21.0x29.7cm)
• A3 (29.7x42.0cm)
• A2 (42.0x59.4)
• A1 (59.4x84.1)
• A0 (84.1x118.9cm)
• Oficio (21.6x35.6cm)
• Tabloide 

(27.9x43.2cm)

Representación:

Se adquiere un pliego del tipo de 
papel deseado y se realizan cortes 
para conseguir el formato que se 
necesita.
O bien, si está disponible, se adquiere 
el formato ya con las dimensiones 
necesarias.

Luego se realizan los márgenes.

Realizando un trazo fuerte con mina 
o un lápiz HB

Trazo con Rapidógrafo 0.8 - 1.2

Representación:

En Proyecto se logra 
utilizando las herramientas:

Herramienta Sheets:

Se crea una familia con el 
formato deseado, se le coloca 
la línea de margen y se carga en 
el proyecto.
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

PL
A

N
O

S 
Y

 H
O

JA
S 

D
E 

TR
A

BA
JO Cajetín

Recuadro que contiene 
los datos de las personas 
o empresas involucradas 
en el proyecto, datos 
del contenido del plano 
y datos de ubicación y 
título de proyecto.

Se dibuja a mano en cada hoja, su 
procedimiento involucra colocación 
de líneas guía a lápiz, rotulado y 
colocación de datos a tinta.

Se logra de la siguiente forma:
Realizando líneas guía trazando con 
mina 2H

Realizando el contorno del cajetín 
con trazos fuertes utilizando mina HB 
o trazos con rapidógrafos 0.8-1.2

Realizando separaciones de 
recuardros que contendrán los 
datos del proyecto con mina HB o 
Rapidógrafos 0.4-0.5

Llenando datos con mina HB o 
rapidógrafos 0.2-0.4

Se realiza el diseño del cajetín y 
se coloca dentro de cada familia 
por tamaño de formato. Luego 
se crean hojas que por defecto 
traen el cajetín listo para llenar. 

Es posible auxiliarse de 
parámetros en Revit para llenar 
automáticamente los datos en 
cada hoja o en todas las que se 
incluyan en el proyecto.
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

PL
A

N
O

S 
Y

 H
O

JA
S 

D
E 

TR
A

BA
JO

Rotulados

Se le llama así a la 
colocación de letras o 
escritura definiendo un 
tipo de letra y dimensiones 
de ocupación de las 
mismas.
 

Representación:

Elaboración del rotulado con líneas 
guía cuidando la dirección del trazo 
al rotular y la distancia entre cada 
letra - número.

Lápices o minas B o HB:

Rapidógrafos 0.2-0.5

  

Ejemplo de alturas a escala 1:100:
Títulos a 5.00mm
Subtítulos a 4.00mm
Contenido a 2.50mm

Representación:

Se crean tipos de texto en panel 
de propiedades, se configura su 
tamaño, fuente, distancia entre 
carácter, etc.

En Proyecto y en creación de 
familias se logra utilizando las 
herramientas:

Herramienta texto (TX)
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT
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A

N
O
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O
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S 

D
E 

TR
A

BA
JO

Escalas

1:5, 1:10, 1:20, 1:25, 
1:50, 1:75, 1:100, 1:125, 
1:200, 1:250, 1:500, 
1;750, 1:1000, etc.,... 

Proceso de aplicación a mano:

Con ayuda del escalímetro se define 
la escala del dibujo a trabajar según 
el formato. Antes de comenzar a 
dibujar se debe confirmar la escala 
para evitar borrar o desperdiciar la 
hoja.

Proceso de aplicación en Revit:

Se realizan pruebas en la hoja 
antes de proceder con la 
documentación para conocer 
qué tipos y dimensiones 
de anotación  utilizar, esto 
colocando las vistas y jugando 
con las distintas escalas 
para verificar cuál es la más 
conveniente.

Notas

Anotaciones que se 
realizan en un plano para 
indicar especificaciones 
u observaciones en el 
dibujo.

Proceso de aplicación a mano:

Elaboración del rotulado con líneas 
guía cuidando la dirección del trazo 
al rotular y la distancia entre cada 
letra - número.

Proceso de aplicación en Revit: 

En Proyecto se logra 
utilizando las herramientas:

Leyendas de Plano

Etiqueta de Multicategoría, 
Etiqueta de Material

 
Texto (TX)
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

PL
A

N
O

S 
Y
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O
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S 

D
E 
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A

BA
JO

Simbologías y Planillas

Estos son elementos 
que apoyan en la 
comprensión de la 
lectura de un plano, en 
ellos es posible indicar 
representaciones en 
plantas, elevaciones 
y secciones; así 
como cantidades y 
cuantificaciones que 
apoyen en el proyecto.

Representación:

Proceso de aplicación a mano:

Se dibujan con la ayuda de 
instrumentos en cada plano.

Se crean líneas guía y se marcan los 
recuadros con los puntos o minas 
que se desee y se procede a rotular, 
igualmente, con ayuda de líneas guía.

Representación:

En Proyecto se logra 
utilizando las herramientas:

Leyendas de Plano

Tablas
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

EL
EM

EN
TO

S 
VA

RI
O

S 
EN

 V
IS

TA
S

Ejes
Secciones
Elevaciones
Detalles
Título de Vista
Simbología de 
Acabados, Etiquetas

Representación:

  

Proceso de aplicación a mano:

Cada elemento de anotación se 
dibuja donde es necesario con la 
ayuda del escalímetro, escuadras, 
regla T, plantillas de círculos, etc.

Según el criterio del dibujante, estos 
símbolos se pueden realizar utilizando 
los siguientes puntos o minas:
Trazo con mina H (Líneas Guía)

Trazo con mina HB 

Rapidógrafo 0.2 - 0.4 (Rotulado de 
contenido o líneas de ejes)

Rapidógrafo 0.8 - 1.2 (Círculos de 
Ejes, Subrayado de títulos, flechas de 
ingresos)

Representación:

  

  

 
En Proyecto se logra 
utilizando las herramientas:

Eje (GR)

Cota de elevación (EL)

Símbolo

Elevación

Sección

Etiquetar por categoría (TG), 
multicategoría, material.

Las configuraciones de cada 
elemento se realizan dentro de 
cada familia o en la paleta de 
propiedades al seleccionarlos.
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ELEMENTO DEL LENGUAJE 
GRÁFICO

REPRESENTACIÓN EN DIBUJO 
MANUAL

REPRESENTACIÓN EN 
AUTODESK REVIT

EL
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S 
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O

S 
EN
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IS

TA
S

Materiales

Representación:

Proceso de aplicación a mano:

Se dibuja la representación del 
material en donde se desea con la 
ayuda de instrumentos de dibujo, 
el uso de rapidógrafos y lápices a 
mano alzada.

Se indican con Rapidógrafos 0.2 - 
0.4 ya que deben ser trazos suaves o 
menos notorios.

Aplicación en Revit:
Se le asignan materiales a los 
distintos elementos del modelo.

O bien, se colocan regiones 
solamente para representación 
en 2D.

En Proyecto 
se utilizan las 
herramientas:
Regiones

Materiales

En Familias 
se utilizan las 
herramientas:
Materiales

Mobiliarios

Representación:

Proceso de aplicación a mano:
Se dibuja la representación del 
mobiliario en donde se desea con 
la ayuda de instrumentos de dibujo 
y aplicando texturas con el uso de 
instrumentos o a mano alzada.

Se trazan con Rapidógrafos 0.2 - 0.4 
siempre conservando un lenguaje de 
líneas

Se colocan las familias donde se 
necesiten.

En Proyecto se logra 
utilizando las herramientas:
Componente (CM)

Otros componentes
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EL
EM
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S 
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O

S 
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IS

TA
S

Vegetación

Representación:

Proceso de aplicación a mano:

Se dibuja la representación de los 
árboles con la ayuda de líneas guía 
y plantilla de círculos aplicando 
texturas y trazos a mano alzada con 
el uso de rapidógrafos o lápices.

Se trazan con Rapidógrafos 0.2 - 0.4 
siempre conservando un lenguaje de 
líneas

Representación:

Se crean las familias que se 
deseen con la representación y 
color que se quiere. 
Se cargan estas familias al 
proyecto y se colocan los 
componentes en donde son 
necesarios.

En Proyecto se logra 
utilizando las herramientas:

Componentes de Sitio

Componentes de Detalle

Tabla 3 Formas equivalentes de los elementos de expresión gráfica (A mano y en Revit). Por Melanie Orozco. 
Guatemala, Noviembre de 2018. Información por William García. “Método Práctico de Dibujo e Interpretación de 
Planos”. Guatemala, 2000. Edwin Valdez. “Dibujo Técnico para Estudiantes de Arquitectura”. Guatemala, noviembre 
de 1989.

Como se puede observar en la Tabla anterior, es 
posible igualar e incluso mejorar la representación 
de los elementos gráficos de un plano a mano. Para 
poder realizar la correcta planificación en una fase 
de Arquitectura es necesario que se conozca cada 
una de las herramientas que nos pueden auxiliar en 
este proceso; según las necesidades y la rapidez 

con la que se desee realizar el proyecto podemos 
hacer uso de una gran variedad de opciones.

El uso de las herramientas para planos de 
anteproyecto y planos constructivos de arquitectura 
será descrito paso a paso más adelante en este 
documento. 
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01.3. MARCO LEGAL

01.3.1 Normativa y Estándares de 
Expresión Gráfica y Planificación en 
Guatemala

 Con relación a la planificación y 
representación gráfica de proyectos; actualmente 
en Guatemala no existe alguna normativa que 
estandarice o que indique con qué requisitos deben 
cumplir los planos de un proyecto; algunas empresas 
solamente le dan su “estilo” y colocan lo que creen 
que es necesario leer en un plano. 

A pesar de optar por la experiencia propia al 
planificar, una de las pocas normativas que se 
siguen en todas las oficinas son las normas del 
Instituto Centroaméricano de Investigación 
Tecnológica Industrial - ICAITI. Estas indican los 
formatos a utilizar para documentación legal de 
proyectos, esta normativa también es solicitada 
por instituciones guatemaltecas cuando necesitan 
papeleo para aprobación de licencias de una 
construcción. 

Instituciones como CONRED, CONADI, FHA, etc.,   
solicitan planificaciones tomando en cuenta estas 
normas y también contribuyen enlistando cuáles tipos 
de planos se deben entregar para un proyecto, 
estos describen de una forma muy vaga qué es 
lo que se debe observar en cada vista y algunos 
profesionales solamente conocen la información 
complementaria después de algunas revisiones. 

Por otro lado, a pesar de que dentro de la 
arquitectura es difícil regirse sobre un estándar BIM, 
actualmente, en el campo de la construcción en 
Guatemala, recién fue el lanzamiento de la Guía de 
Aplicación de Estándares BIM (implementado 
por la Asociación Guatemalteca de Estándares 
BIM - AGEBIM-), el cual se rige en la aplicación 
local  de la norma ISO 19650. Esta guía brinda 
los lineamentos sobre gestión de información de 
proyectos trabajados bajo la metodología BIM. 
Gracias a esta será posible obtener una mejor 

organización de entregables a lo largo de todos 
los ciclos de vida de un proyecto para eficientizar la 
búsqueda y entrega de información entre diferentes 
partes involucradas.

Con esta guía también se define un orden para 
trabajar sobre los programas. Esto para que, no 
importando el software que se utilice en cada 
especialidad, el manejo de información dentro de 
este sea el mismo que en el resto.

Gracias a este manual es posible tener un orden 
de información, pero para obtenerla, es necesario 
tener una idea de qué es lo que se debe 
entregar para un proyecto. Para lo cual, como se 
mencionó anteriormente, las diferentes entidades 
gubernamentales en Guatemala crean una  lista de 
documentos que solicitan a los desarrolladores de 
proyectos. 
A pesar de que estas guías solamente dan una  lista 
de entregables, este listado puede ser útil como un 
checklist en el que es posible basarse para evitar 
contratiempos o información rechazada al momento 
de solicitar alguna licencia o cualquier tipo de 
autorización.

En la siguiente Tabla se indican (por nombre de 
institución) los documentos que pueden solicitar 
estas entidades a cualquier desarrollador de 
proyectos dentro del municipio de Guatemala. (Este 
listado se actualiza cada cierto tiempo según cada 
institución, por lo que este es una  lista básico del 
año en vigencia, 2020).
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O B S E R V A C I Ó N

02
Nivel de Conocimiento - 

Recabación de Datos

02.1. OBSERVACIÓN

 Para comprender un poco más la necesidad 
de un documento que guíe en el tema de la 
representación gráfica y la importancia que esta y 
la planificación tienen en un proyecto, se realizaron 
dos encuestas que serían efectuadas a estudiantes 
y catedráticos de FARUSAC.
Serán encuestados los estudiantes que se encuentren 
cursando la carrera de arquitectura a partir del 
Séptimo Semestre en adelante. Los catedráticos 
a encuestar son los que  imparten las asignaturas 
de Práctica Integrada, Diseño Arquitectónico y 
Herramientas Digitales..

En estas encuestas se le consulta a los catedráticos 
qué tan bueno es el desempeño de los estudiantes 
en las asesorías y entregas, y a los estudiantes 
qué tan bien conocen el programa o qué tanto 
comprenden la importancia de la planificación en 
un proyecto.

02.1.1 Encuestas de Evaluación de 
Lenguaje Gráfico en Revit (Catedráticos)

 Realizada a docentes de las asignaturas 
de Práctica Integrada, Diseño Arquitectónico y 
Herramientas Digitales. Los resultados de estas 
encuestas nos mostrarán el punto de vista de los 
catedráticos de las asignaturas antes mencionadas 
ante los resultados de los alumnos dentro del 
semestre, mismas que serán realizadas de forma 
física y digital al finalizar o al iniciar uno de estos 
para tener la opinión de los recién egresados.

Las respuestas son de selección múltiple y en 
algunas se les solicita a los docentes dar una breve 
explicación del porqué de sus respuestas. 

Preguntas Incluidas en la Encuesta

Dentro de las preguntas que podrían ser incluidas  
se realizó una selección y se aplicaron las que  
permitieran  conocer resultados directos acerca del 
desempeño de los alumnos al presentar un proyecto. 
Esto siempre con relación al tema de expresión 
gráfica.

02.1.2 Encuestas de Evaluación de 
Lenguaje Gráfico en Revit (Estudiantes)

 Estas encuestas nos darán el punto de vista 
de los estudiantes que se encuentran cursando 
desde el séptimo semestre en adelante para 
verificar qué tanto fue aprendido de los cursos y 
qué tan preparados se consideran para abordar un 
proyecto arquitectónico en el programa Autodesk 
Revit.

Al igual que las encuestas a catedráticos, en 
algunas preguntas se les solicita a los alumnos 
que den una breve explicación del porqué de 
las respuestas. Además de eso, estas también se 
realizarán al finalizar o iniciar el semestre para 
evaluar los resultados. desde el punto de vista de 
los recién egresados.

Preguntas Incluidas en la Encuesta

Las preguntas seleccionadas permitirán tener una 
opinión de los alumnos acerca de su desempeño 
en los diferentes cursos. Estas también servirá como 
una autoevaluación ya que se le consulta sobre 
conceptos básicos que se adquieren al principio 
de la carrera.
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02.2. ANÁLISIS

02.2.1 Resultados de Encuestas

 El  objetivo de la encuesta, como 
anteriormente fue descrito, es el de lograr recabar los 
datos necesarios entre catedráticos y estudiantes 
sobre la  necesidad que tienen los mismos para 
contar con un documento que los guíe durante 
el semestre con respecto al tema de expresión 
gráfica y que de la misma forma sea un documento 
de consulta que indique a los estudiantes sobre 
las entregas de documentos que se realizan a 
la Municipalidad de Guatemala, a las diferentes 
entidades gubernamentales y a los clientes al 
desarrollar un proyecto arquitectónico.  

Debido a lo observado al cursar estas asignaturas, 
es importante contar con un documento guía para 
la expresión gráfica y las entregas a realizar, sin 
embargo se solicitan opiniones de los alumnos que 
recién las cursaron y de los catedráticos que han 
observado los resultados de varias generaciones a 
través de los años y que podrán dar una opinión 
más acertada al haber impartido los mismos cursos 
a diferentes generaciones.

Las encuestas fueron realizadas al inicio del primer 
semestre del año 2020.
A continuación se presentan los resultados. 

Estadística Encuestas de Evaluación de 
Lenguaje Gráfico en Revit para Catedráticos 
(10 en total)

 Las encuestas indicadas en el inciso 2.1.1 
de este documento (Ver Anexos) fueron realizadas 
al iniciar el primer semestre del 2020 de forma física 
y digital logrando los siguientes resultados:

10 en total:
• 4 encuestas respondidas de forma física
• 6 encuestas respondidas de forma digital

Para tener más facilidad en tabular la información y 

contando con las herramientas que brinda Google, 
se utilizó Google Forms, ya que esta herramienta 
genera diagramas de pie para visualizar de mejor 
forma los resultados. de las encuestas. Debido a 
esto, las encuestas que se realizaron a mano, fueron 
trasladadas a esta herramienta digital para obtener 
toda la información en el mismo lugar.

A continuación se presentan los gráficos de los 
resultados de cada pregunta.

Gráficos de respuestas de formularios. 

Pregunta 1
¿Cómo considera la claridad y calidad de las 
proyecciones ortogonales con la que los alumnos 
presentan sus proyectos en asesorías? (Plantas, 
elevaciones, secciones, vistas de detalle).
Número de respuestas: 10 respuestas.

Gráfico 01:  Diagrama de resultados en pregunta 1 
para catedráticos. Elaborado por Melanie Orozco, 

Guatemala, 2020. 
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Pregunta 2
¿Cómo considera la claridad y calidad de los planos 
con la que los alumnos presentan sus proyectos en 
entregas? (Plantas, elevaciones, secciones, detalles). 
Número de respuestas: 10 respuestas.

Gráfico 02: Diagrama de resultados en pregunta 2 
para catedráticos. Elaborado por Melanie Orozco, 

Guatemala, 2020. 

Pregunta 3
En un proyecto arquitectónico, ¿considera tan 
importante la representación bidimensional como la 
tridimensional (renders y/o maquetas)?. ¿Por qué?
Número de respuestas: 10 respuestas.

Gráfico 03: Diagrama de resultados en pregunta 3 
para catedráticos. Elaborado por Melanie Orozco, 

Guatemala, 2020. 

En esta pregunta se le solicitó a los catedráticos 
dar un porqué de su respuesta, esto para conocer 
la razón por la que ellos piensan que es importante .
Según las respuestas brindadas, los catedráticos 
comparten que los planos son la forma mediante 
un proyecto se termina de comprender y llevar a la 
realidad.

Igualmente expresan que en algunos casos no es 
necesario el desarrollo de planos, todo depende 
del tipo de proyecto o entrega por la que el 
profesional haya sido contratado.

Pregunta 4
¿Considera que los estudiantes toman en cuenta 
los criterios aprendidos en la asignatura de Dibujo 
Técnico para los cursos de Práctica Integrada, 
Herramientas Digitales y Diseño Arquitectónico?. 
Número de respuestas: 10 respuestas.

Gráfico 04: Diagrama de resultados en pregunta 4 
para catedráticos. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 5
¿Considera que los alumnos comunican de mejor 
manera sus proyectos al entregar planos hechos 
a mano comparados con los elaborados con la 
ayuda de herramientas digitales?. ¿Por qué? 
Número de respuestas: 10 respuestas.

Gráfico 05: Diagrama de resultados en pregunta 5 
para catedráticos. Elaborado por Melanie Orozco, 
Guatemala, 2020. 
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En las respuestas brindadas textualmente al 
preguntar el porqué de cada respuesta, la mayoría 
de catedráticos consideran que esto no depende 
del método de entrega, sino del mismo alumno. 
Esto porque en la mayoría de ocasiones no se 
conoce qué se debe entregar o no se tiene un 
claro concepto de qué representar en los planos 
a entregar. 

Estas razones ocasionan una entrega deficiente sin 
importar con qué herramienta se realice.

Pregunta 6 
¿Considera que los alumnos deben instruirse un 
poco más por su cuenta en el uso de herramientas 
digitales para mejorar la calidad de presentación?. 
Número de respuestas: 10 respuestas.

Gráfico 06: Diagrama de resultados en pregunta 6 
para catedráticos. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 7
¿Considera adecuada la implementación de una 
guía que instruya al alumno en el uso de herramientas 
digitales previo y durante las asignaturas?. 
Número de respuestas: 10 respuestas.

Gráfico 07: Diagrama de resultados en pregunta 7 
para catedráticos. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 8
¿Considera importante el uso e implementación de la 
tecnología para realizar proyectos arquitectónicos 
dentro de la facultad para nuestra época actual? 
¿Por qué?
Número de respuestas: 10 respuestas.

Gráfico 08: Diagrama de resultados en pregunta 8 
para catedráticos. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Según las respuestas brindadas por los catedráticos 
al consultarles el porqué de su postura, respondieron 
que es imprescindible el uso de la tecnología en 
la actualidad ya que es lo que se utiliza en este 
momento y los egresados de la carrera deben ir con 
una base clara para desenvolverse en el campo 
laboral. Otro punto que también recomiendan es 
que el estudiante debe instruirse más en conceptos 
de dibujo técnico y geométrico.
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Estadística Encuestas de Evaluación de 
Lenguaje Gráfico en Revit para Estudiantes (30 
en total):

 Las encuestas indicadas en el inciso 2.1.2 
de este documento (Ver Anexos) fueron realizadas 
al iniciar el primer semestre del 2020 de forma física y 
digital a los estudiantes a partir del séptimo semestre 
(que ya han cursado Herramientas Digitales 1 y 2) 
y a algunos egresados logrando los siguientes 
resultados:

• 8 encuestas respondidas de forma física
• 22 encuestas respondidas de forma digital

Gráficos de respuestas de formularios. 

Pregunta 1
¿Considera adecuados los documentos de 
apoyo brindados en Herramientas Digitales para 
la comprensión y el estudio de los alcances de 
documentación arquitectónica del software Revit? 
¿Por qué?.
Número de respuestas: 30 respuestas.

Gráfico 09: Diagrama de resultados en pregunta 1 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

En el caso de los estudiantes que no están de 
acuerdo con los documentos respondieron que 
no los consideran suficiente ya que las guias y las 
referencias se realizan paso a paso y que ellos 
siguen este procedimiento solamente para lograr 
las entregas. 
Que igualmente sienten que solo se les muestra una 
base y que al momento de desarrollar sus propios 

proyectos, se guían en tutoriales externos ya que 
deben resolver problemas que se les presentan al 
trabajar de lleno en el software.

Por otra parte, en el caso de los que sí están 
de acuerdo consideran  que las guías y vídeos 
elaborados para aprendizaje son adecuados 
ya que los pueden guardar en su PC y consultar 
en cuanto consideren que tienen problemas 
para desempeñar cada tarea. Igualmente sienten 
que si en clases no pudieron comprender algo a 
cabalidad, pueden consultar estas guias en el 
momento que tengan más concentración.

Pregunta 2
¿En qué lugares ha realizado entregas de juegos de 
planos trabajados en Revit durante su carrera?. 
Número de respuestas: 30 respuestas.

Gráfico 10: Diagrama de resultados en pregunta 2 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 3
¿Conoce las herramientas que se pueden utilizar 
en Revit para mejorar el lenguaje gráfico en 
una planificación y que sirven para simplificar su 
manipulación?. 
Número de respuestas: 30 respuestas.
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Gráfico 11: Diagrama de resultados en pregunta 3 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 4
¿Cuáles herramientas de Revit ha utilizado para 
eficientizar el trabajo en entregas de juegos de 
planos? 
Número de respuestas: 30 respuestas.

En la mayoría de respuestas brindadas se mencionan:
• Vistas
• Hojas
• Familias
• Leyendas
Las cuales son herramientas que sí se utilizan en Revit 
pero que no significan una mejora en el trabajo, sino 
son herramientas de uso básico.

Por otra parte ya hay algunos alumnos que expresan 
la utilización de plantillas de vista, filtros, etiquetas, 
tablas, uso de Dynamo y otros plugins que de verdad 
permiten simplificar el trabajo en sus entregas. Sin 
embargo, estas respuestas se dieron solamente en 
el 20% de los encuestados (6 respuestas).

Pregunta 5
A su criterio, ¿qué software cree que es más 
conveniente para realizar una planificación de 
forma digital?. 
Número de respuestas: 30 respuestas.

Gráfico 12: Diagrama de resultados en pregunta 5 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 6
¿Conoce la diferencia entre los planos entregables 
para una fase de diseño y los planos entregables 
para una planificación arquitectónica?. Si la conoce 
¿Cuál es?
Número de respuestas: 30 respuestas.

Gráfico 13: Diagrama de resultados en pregunta 6 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

En las respuestas brindadas se puede observar 
que el 36.7% de los encuestados (11 de ellos) no 
conocen la diferencia entre estos. 
Sin embargo el resto de ellos, al dar una explicación 
de su respuesta, explicaban claramente y de una 
forma corta cuál es la diferencia entre estos dos 
conceptos.
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Debido a que se asumió que algunos de los 
encuestados no conocerían la diferencia entre los 
dos tipos de planificaciones, se colocó una breve 
descripciós de ambas antes de proceder con el 
resto de preguntas.

“Ya que hay una diferencia entre ambas y la definición 
de las dos es:
FASE DE DISEÑO: Todo lo que corresponde a 
presentación arquitectónica para dar a conocer un 
diseño.
FASE DE PLANIFICACIÓN: Todo lo que corresponde a 
planos constructivos de arquitectura.

Al saber esta diferencia, responda lo siguiente:“.

Pregunta 7
¿Ha realizado planos de presentación  
arquitectónica en Revit?. 
Número de respuestas: 30 respuestas.

Gráfico 14: Diagrama de resultados en pregunta 7 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 8
¿Ha realizado una planificación arquitectónica 
completa en Revit?. 
Número de respuestas: 30 respuestas.

Gráfico 15: Diagrama de resultados en pregunta 8 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 9
¿Considera correcto desarrollar un proyecto en 
Revit y realizar su planificación arquitectónica en el 
mismo software para entregas de Práctica Integrada 
I, II y Diseño Arquitectónico?. 
Número de respuestas: 30 respuestas.

Gráfico 16: Diagrama de resultados en pregunta 9 
para estudiantes. Elaborado por Melanie Orozco, 
Guatemala, 2020. 

Pregunta 10
Si ha desarrollado un proyecto en Revit, ¿se ha 
auxiliado de otros softwares para desarrollar plantas, 
elevaciones y secciones en entrega de planos y 
láminas de arquitectura?. 
Número de respuestas: 30 respuestas.
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Gráfico 16: Diagrama de resultados en pregunta 10 
para estudiantes. Elaborado por Melanie Orozco, 

Guatemala, 2020. 

Indique cuáles:

Al indicar con qué programas se auxiliaban para 
realizar sus entregas, en su mayoría mencionaban:

• Lumion, 3ds Max y Sketchup para creación 
de modelos para renders.

• Photoshop e Illustrator para posproducción 
de renders y creación de láminas.

• Powerpoint para láminas.
• AutoCAD para creación de planos.

Al ver estas respuestas es posible darse cuenta 
que los estudiantes tienen claro el uso de cada 
programa, lo cual es una gran ventaja al tratar de 
ejecutar los proyectos personales ya que conocen 
las bondades de cada software y pueden 
distribuirlos en sus distintas fases.

Pregunta 11
A su criterio, ¿cuáles son los planos a entregar en 
fase de Diseño?
Número de respuestas: 30 respuestas.

En el 100% de las respuestas se indicó el siguiente 
contenido:

• Plantas de arquitectura
• Elevaciones
• Secciones
• Diagramas
• Apuntes

Esto indica que el 100% de los encuestados tienen 
claridad de los planos que se incluyen en una 
entrega de diseño.

Pregunta 12 
A su criterio, ¿cuáles son los planos a entregar para 
una planificación arquitectónica?
Número de respuestas: 30 respuestas.

El 20% (6 respuestas) de los alumnos encuestados 
indicó no conocer o solamente enlistó los mismos 
planos que se entregan en la fase de diseño.

El 6.6% (2 respuestas) de los encuestados incluyó 
planos de estructuras e instalaciones en su 
respuesta, esto es correcto cuando se habla de una 
planificación completa del proyecto. Sin embargo 
estos planos son responsabilidad del especialista en 
esta área. En caso el arquitecto sea el encargado 
del proyecto completo, está bien, pero en este 
inciso se consulta sobre los planos específicos de 
una planificación arquitectónica.

El 53.3% (16 respuestas) de los estudiantes indicó la 
inclusión de los planos correctos (plantas detalladas, 
elevaciones, secciones, detalles específicos). Lo cual 
es correcto pero aún faltaría mencionar algunos 
tipos, esto quiere decir que al menos la mitad de los 
estudiantes encuestados conocen la base de una 
planificación arquitectónica.

Solamente el  20% (6 respuestas) de los 
encuestados indicó agregar planos de topografía, 
emplazamiento, conjunto, plantas arquitectónicas, 
elevaciones, secciones y detalles. 

Los resultados indican que casi el 75% de los 
alumnos y egresados conocen qué planos incluir 
en la planificación arquitectónica, lo que significa 
que están preparados para el entorno laboral. 
Posiblemente el resto de los encuestados sean los 
de semestres menores, ya que este contenido se 
les explica en los cursos de Herramientas Digitales, 
Práctica Integrada y se solicitan en Diseños 
Arquitectónicos del Nivel de Formación Profesional. 
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02.2.2 Clasificación de Proyectos 
(Arquitectura, Estructuras, Instalaciones)

 Dentro del programa Autodesk Revit es 
posible desarrollar un proyecto en diferentes 
especialidades. El software permite que se 
puedan albergar distintos tipos de especialidades 
(Estructuras, Instalaciones Mecánicas, Eléctricas e 
Hidrosanitarias) en un sólo proyecto auxiliándose de 
links y de plantillas de vista que nos permiten apagar 
y encender los elementos dependiendo del tipo de 
planificación que se va a elaborar.

A continuación se dará una breve descripción 
de las especialidades que puede abarcar. Es 
importante recalcar que en este documento 
solamente se explicará el proceso de mejoramiento 
de la expresión gráfica en una plantilla para 
planificaciones arquitectónicas.

02.2.2.1 Proyecto de Arquitectura

Cuando se habla de un proyecto de arquitectura 
lo que es importante visualizar son volúmenes, 
distribuciones de ambientes, mobiliario, ambientación, 
niveles, acabados, etc. Por lo tanto es importante 
que todos estos elementos se muestren y que ningún 
otro que no forme parte de la arquitectura interrumpa 
al momento de estudiar el diseño de un proyecto.

Para configurar las vistas en Revit y lograr que la 
arquitectura se proyecte adecuadamente podemos 
jugar con las herramientas para modificar gráficos en 
vistas y lo más importante, modificar plantillas de vista 
para que estas configuraciones permanezcan en 
las demás vistas que se creen durante el proyecto.

EJEMPLOS DE PLANOS PARA ENTREGA DE 
PLANIFICACIÓN ARQUITECTÓNICA

Imagen 4: Ejemplo de plano de acabados en muros 
trabajado para un proyecto de Edificio de Apartamentos 
solicitado para Diseño Arquitectónico 7. Elaborado por 

Jonathan Rodriguez. Guatemala, Octubre de 2017.

Imagen 5: Ejemplo de plano de acabados en muros, 
pisos y cielos trabajado para un proyecto de Edificio 
del Colegio de Ingenieros solicitado para Diseño 
Arquitectónico 7. Elaborado por Melanie Orozco. 
Guatemala, Marzo de 2017.
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02.2.2.2 Proyecto de Estructuras

 Al crear las estructuras de un proyecto 
es importante poder visualizar los elementos que 
ayudarán al edificio a sostenerse. En este tipo de 
planos no interesa visualizar mobiliario ni aspectos 
de diseño interior, fuera del tema de muros de 
mampostería o tabiques, solamente importa lo 
correspondiente a la forma pura del edificio. 

En estos planos se detallarán los componentes 
constructivos que solucionarán columnas, losas, vigas, 
muros, rampas, pérgolas, gradas, etc. El programa 
Autodesk Revit contiene una plantilla adaptada 
para temas estructurales, esta se incluye en el 
paquete de instalación automática del software en 
la cual es posible realizar modificaciones para crear 
una propia que será útil para próximos proyectos.    

EJEMPLOS DE PLANOS PARA ENTREGA DE 
PLANIFICACIÓN DE ESTRUCTURAS.

Imagen 6: Ejemplo de plano de armado de columnas 
y amarre con vigas de cimentación trabajado para la 
entrega de juego de planos estructurales del Edificio T1 
del Campus Central de la Universidad de San Carlos 
de Guatemala solicitado durante el desarrollo de la 
Práctica Intermedia 2. Elaborado por Melanie Orozco. 
Guatemala, diciembre de 2017.

Imagen 7: Ejemplo de plano de armado de gradas 
trabajado para la entrega de juego de planos 
estructurales del Edificio Colegio de Ingenieros de 
Guatemala solicitado durante el desarrollo de la 
Práctica Técnica 1. Elaborado por Melanie Orozco. 
Guatemala, Abril de 2017.

02.2.2.3 Proyecto de Instalaciones 
Mecánicas, Eléctricas e Hidrosanitarias 
(En inglés Mechanical, Electrical & 
Plumbing. MEP)

En un proyecto de instalaciones es importante 
visualizar la estructura y la arquitectura del edificio 
(incluyendo artefactos y mobiliario) para poder 
ubicar las instalaciones en los puntos donde sean 
necesarias y que ninguno de los componentes de 
estas pase por algún ducto de elevadores, vigas, 
escaleras, ventanas, etc.

Para las instalaciones Revit también contiene por 
defecto una plantilla de proyectos MEP la cual 
alberga todo lo básico para desarrollar cualquier 
proyecto de instalaciones y que igualmente puede 
ser modificada para la especialidad que se desea 
trabajar. 
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EJEMPLOS DE PLANOS PARA ENTREGA DE 
PLANIFICACIÓN DE INSTALACIONES

Imagen 8: Ejemplo de plano de instalaciones 
hidrosanitarias trabajado para la entrega de juego de 
planos de instalaciones del Edificio de Apartamentos 
solicitado para Diseño Arquitectónico 7. Elaborado por 
Jonathan Rodriguez. Guatemala, Abril de 2017.

 En conclusión, Revit es un software que puede 
manejar distintas disciplinas tanto en modelado 
como en su planificación, esto brinda una mayor 
facilidad del manejo de información y de esta forma 
se podría garantizar una correcta organización del 
proyecto y evitar contratiempos en la revisión de 
modelado. Gracias a esto podremos reducir tiempo 
para trabajar en demás asuntos como diseño, 
planificación, proceso de aprobación de licencias 
y ejecución del proyecto.
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02.3. ASPECTOS ACADÉMICOS

 En este inciso se realizará una breve 
descripción de lo que consisten cada una de las 
asignaturas en las cuales los alumnos podrán poner 
en práctica lo que se indicará en esta guía.

02.3.1 Herramientas Digitales 1

 El objetivo del curso es instruir al estudiante 
dentro de los programas digitales para comenzar a 
implementar la tecnología dentro de sus proyectos. 
Se hace una introducción dentro de los programas 
CAD (AutoCAD) y BIM (Revit) para que los 
alumnos se familiaricen con ellos y logren iniciar el 
modelado de proyectos en la asignatura de Diseño 
Arquitectónico.

Al finalizar la asignatura los estudiantes son 
capaces de realizar familias básicas de anotación 
y mobiliario. También desarrollan una entrega de 
proyecto que abarca un modelado arquitectónico 
básico más planos de diseño con vistas ortogonales 
del proyecto basados en conocimientos de la 
expresión gráfica inicial.

EJEMPLOS DE VISTAS TRABAJADAS EN 
HERRAMIENTAS DIGITALES 1

Imagen 9: Ejemplo de vistas trabajadas para la 
entrega final de diseño solicitada en la asignatura de 
Herramientas Digitales 1. Elaborado por Melanie Orozco. 
Guatemala, Mayo de 2014.

02.3.2 Herramientas Digitales 2

 Después de haber comprendido y 
practicado las herramientas básicas del programa 
en Herramientas Digitales 1, el objetivo del curso es 
guiar al alumno para poder realizar presentaciones 
de proyecto en forma bidimensional y tridimensional, 
aplicando texturas y efectos en el programa 
Autodesk Revit.

En la asignatura se auxiliarán de software 
adicionales para lograr una correcta visualización 
arquitectónica, esto para familiarizarse con las formas 
de presentación digital de proyectos como paseos 
virtuales y renders dentro y fuera del proyecto.

EJEMPLOS DE VISTAS TRABAJADAS EN 
HERRAMIENTAS DIGITALES 2

Imagen 10: Ejemplo de vista exterior del edificio de 
apartamentos del proyecto Escuela Municipal de 
Lenguas solicitado para la asignatura de diseño 
Arquitectónico 3. Elaborado por Melanie Orozco. 
Guatemala, noviembre de 2014.
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Imagen 11: Ejemplo de vista interior del dormitorio 
principal del apartamento 1, Edificio de Apartamentos 
del proyecto Escuela Municipal de Lenguas solicitado 
para la asignatura de Diseño Arquitectónico 3. 
Elaborado por Melanie Orozco. Guatemala, noviembre 
de 2014.

02.3.3 Herramientas Digitales 3

 En esta asignatura se comienza a profundizar 
en la representación gráfica en planos. Se integran 
modelos de diferentes especialidades dentro 
del modelo de arquitectura y se desarrolla la 
planificación del proyecto (arquitectura, estructuras 
y MEP).

Se profundiza en el uso de plantillas para 
especialidades y la creación de planillas de 
elementos arquitectónicos, estructurales  e 
instalaciones. Al finalizar el curso se hace entrega 
de planos considerando todos los elementos que 
componen una vivienda (incluyendo MEP). Estos 
planos ya son considerados como entregables 
para un proceso de aprobación de licencias por 
el mayor nivel de detalle que se implementará y el 
nivel de expresión gráfica que se necesita y debe 
ser aplicado.

EJEMPLOS DE PLANOS TRABAJADOS EN 
HERRAMIENTAS DIGITALES 3

Imagen 12: Ejemplo de plano de plantas de 
arquitectura realizado para la entrega de planificación 
arquitectónica solicitada para la asignatura de 
Herramientas Digitales 3. Elaborado por Melanie Orozco. 
Guatemala, marzo de 2015.

Imagen 13: Ejemplo de plano de secciones realizado 
para la entrega de planificación arquitectónica 
solicitada para la asignatura de Herramientas Digitales 
3. Elaborado por Melanie Orozco. Guatemala, marzo 
de 2015.

02.3.4 Herramientas Digitales 4

 En esta etapa se desarrolla el uso de 
las herramientas de Autodesk Revit para realizar 
cuantificaciones y trabajos especializados que 
el programa puede brindar. Adicional se tiene un 
manejo de herramientas de modelado específicas 
y métodos de uso de las mismas para un correcto 



66

A S P E C T O S  A C A D É M I C O S

modelo arquitectónico, estructural y MEP; también se 
procede a guiar a los alumnos en las configuraciones 
necesarias para el proceso de impresión de sus 
proyectos en impresoras 3D.

Al finalizar el curso se hace entrega de una 
planificación arquitectónica de un proyecto 
específico.

02.3.5 Diseño Arquitectónico

 En los cursos de Diseño Arquitectónico se 
instruye al alumno a lograr comprender la relación 
de las forma de un objeto arquitectónico con la 
función que este tendrá. A lo largo de la carrera 
se abordan proyectos de diferente complejidad 
iniciando por pequeños proyectos de vivienda o 
de interés social hasta proyectos que integran las 
diferentes edificaciones que son necesarias a nivel 
urbano en un solo conjunto.

En las asignaturas se crean objetos arquitectónicos 
en los cuales se tomará en cuenta las distintas 
disciplinas que lo conforman (arquitectura, estructuras 
e instalaciones) más las necesidades que cada una 
requiere para lograr espacios habitables. Al finalizar 
el estudiante es capaz de desarrollar conjuntos 
arquitectónicos de forma individual y en equipo.

Como requisitos de entregas finales siempre es 
necesario brindar láminas de presentación, planos 
de proyecto, esquemas de funcionamiento, áreas 
de conjunto, áreas de cada edificio, elementos 
de visualización arquitectónica y en algunos 
casos (dentro del nivel de formación profesional) 
cuantificaciones, presupuesto y tiempos de 
ejecución.   

EJEMPLOS DE LÁMINAS DE PRESENTACIÓN 
TRABAJADOS EN DISEÑO ARQUITECTÓNICO

Imagen 14: Ejemplo de lámina de presentación de 
los diferentes edificios en conjunto, Ciudad Deportiva 
Universitaria, proyecto solicitado para Diseño 
Arquitectónico 8. Elaborado por Melanie Orozco. 
Guatemala, marzo de 2017.

Imagen 15: Ejemplo de lámina de presentación de los 
diferentes edificios en conjunto, Central de Transferencia, 
proyecto solicitado para Diseño Arquitectónico 9. 
Elaborado por Melanie Orozco. Guatemala, octubre de 
2017.
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02.3.6 Práctica Integrada

 En las asignaturas de Práctica Integrada 
I y II se procede a desarrollar la planificación de 
un proyecto arquitectónico en cada una de sus 
disciplinas. Es necesario que los juegos de planos 
que se entregan en estos cursos cuenten con un 
alto nivel de representación gráfica y claridad en 
el proyecto ya que estos funcionarán para poner 
en práctica los documentos de entrega para un 
correcto proceso de construcción.

En cada fase del curso de Práctica Integrada 
1 es necesario entregar un juego de planos que 
contiene documentos que han sido desarrollados 
y asesorados en tiempos de clase. Mientras en la 
asignatura de Práctica Integrada 2 se solicita la 
entrega de planos de instalaciones especiales y 
documentos que son necesarios para el desarrollo 
de la construcción del proyecto.

EJEMPLOS DE PLANOS CONSTRUCTIVOS 
TRABAJADOS EN PRÁCTICA INTEGRADA I Y II

Imagen 16:  Ejemplo de plano de plantas acotadas  
trabajados para la entrega de planos de arquitectura 
del proyecto Edificio de Colegio de Ingenieros, 
solicitados en la asignatura de Práctica Integrada I. 
Elaborado por Melanie Orozco. Guatemala, octubre de 
2017.

Imagen 17:  Ejemplo de plano de detalles de armado 
de gradas, trabajados para la entrega de planos 
estructurales del proyecto Edificio de Colegio de 
Ingenieros, solicitados en la asignatura de Práctica 
Integrada I. Elaborado por Melanie Orozco. Guatemala, 
octubre de 2017.

 Como se puede observar, en cada una 
de las asignaturas antes mencionadas siempre es 
necesario hacer entrega de planos de diseño y 
planos arquitectónicos para poder comprender los 
proyectos. 

El objetivo de este documento es guiar al estudiante 
en el uso del software Autodesk Revit para simplificar 
y reducir la acumulación de problemas que se 
ven a lo largo de asesorías y entregas en el tema 
de representación gráfica. Esto logrará reducir el 
tiempo invertido en dudas en el curso Herramientas 
Digitales logrando el enfoque en temas que llevarán 
al alumno a tener los resultados esperados en las 
demás áreas de cada asignatura.
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03
Configuración de 

Parámetros

03.1. ASPECTOS TÉCNICOS

03.1.1 Descripción Fase de Arquitectura 
(Tipo de carpeta)

 Cuando se habla de una carpeta a entregar 
en fase de arquitectura inmediatamente se piensa 
que la entrega es puramente de diseño en la que 
se abarca el contenido de plantas que muestren 
texturas y colores, elevaciones que muestren niveles, 
texturas en fachadas, vegetación; y secciones que 
muestren texturas en muros y mobiliario de cada 
ambiente. Desafortunadamente estos elementos 
sólo forman parte de una entrega de diseño en 
la cual se aprobará el diseño del proyecto para 
proceder con su planificación.

 La planificación del objeto arquitectónico 
abarca planos en los que se indicarán niveles, 
mobiliarios, distancias clave entre elementos 
arquitectónicos, acabados, ingresos, salidas de 
emergencia, rutas de evacuación, etc. Elevaciones 
que irán más allá de mostrar texturas, como por 
ejemplo perfiles de terreno, alturas máximas, distancias 
de elementos arquitectónicos, voladizos, altura de 
ambientes dentro del edificio, límites de aeronáutica, 
etc. Secciones que nos indicarán niveles de sótano 
(si los hubiera), perfiles de topografía existente, 
geometría de los módulos de circulación vertical, 
etc.

Adicional a esto se indican detalles específicos del 
proyecto como, mobiliario a utilizar en sanitarios, 
mobiliario en lobby, diseño de puertas, buzones, 
recepciones, pérgolas, etc.; elementos  que le dan 
un carácter específico a nuestro proyecto y que 

guiarán al constructor para plasmar las ideas del 
papel a la realidad.

03.1.2 Contenido Fase de Arquitectura 
(Tipos de plano)

 Los tipos de planos a utilizar para cada fase 
de entrega serán los indicados a continuación (ver 
Tabla en siguiente página),  adicional se coloca 
una breve descripción del tipo de plano para 
conocer un poco más la función y qué se necesita 
ver en cada uno.
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PLANOS DE DISEÑO (PRESENTACIÓN)

Este tipo de planos son necesarios para que la persona o empresa que contratará, pueda observar 
claramente el tipo de arquitectura utilizada en su proyecto. Es obligatorio el uso de color, texturas, sombras, 
lenguaje de líneas y notas específicas que sirvan para una mejor comprensión. Esta fase se centra más 
en brindar información enriqueciendo la expresión gráfica y considerando aspectos técnicos específicos 
que influyan directamente en el presupuesto o el diseño y que el cliente necesite conocer previo a una 

aprobación.

TIPOS DE PLANO O VISTAS FUNCIÓN

Planta de Conjunto

Nos sirve para visualizar caminamientos, texturas utilizadas en conjunto, 
diferencias de altura en volúmenes, pendientes en cubiertas, sombras 
proyectadas, etc.
En este plano es donde el cliente puede ver las conexiones de su 
proyecto con las del entorno inmediato, corresponde a información 
de accesos al proyecto y relaciones entre él mismo.

En este plano se proyectarán los distintos bloques que forman un 
conjunto (si aplica) y si es necesario, se indicarán las fases que lo 
conforman. 

Plantas de Arquitectura

Se visualizan las distribuciones de cada nivel, nos ayuda a comprender 
de mejor forma las relaciones entre ambientes y comprender los 
espacios según la función del proyecto. 
Nos indica cambios de niveles interiores, cambios de niveles en 
jardines, cambios de texturas en piso, restricciones municipales, 
dimensiones de ambientes y uso de mobiliario y vegetación. 

Elevaciones

En estas vistas se observará alturas de cubiertas, voladizos y pérgolas 
que formen parte de las fachadas del proyecto.
Se muestran texturas en fachadas, niveles de terrazas, anotaciones de 
niveles para conocer en dónde inicia el nivel inmediato superior, ejes, 
pendientes de cubierta (en donde permita visualizar la elevación), 
puertas y ventanas al exterior, uso de vegetación, jardineras, balcones 
y barandillas.
En estas vistas es posible mostrar materiales, cerramientos o cualquier 
tipo de elemento que afecte las fachadas del proyecto. 
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Secciones

Se mostrarán cambios de alturas entre ambientes, niveles (NPT y 
MSNM), uso de mobiliario fijo, vegetación; se proyectan pérgolas, 
terrazas y voladizos.

En estas se podrá ver el perfil natural del terreno para comprender 
qué tanto deberá ser modificado, alturas máximas de aeronáutica 
y/o municipalidad y la altura máxima del edificio.

Visualización

Capturas del modelo en Revit, estas vistas solamente nos auxiliarán 
en caso sea necesario mostrar elementos específicos del modelo y 
que sean solicitados por el cliente.
Preferiblemente estas vistas deben ser renders rápidos donde se 
muestren variaciones u opciones de diseño que fueron solicitados o 
que se deseen mostrar por algún motivo.

Si se cuenta con más tiempo para realizarlas es adecuada la pre-
sentación de renders más elaborados o generados por programas 
adicionales.

Tabla 5 Elementos a visualizar en planos según la información a entregar durante la fase de diseño. Por Melanie 
Orozco. Guatemala, Diciembre de 2018.
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PLANIFICACIÓN ARQUITECTÓNICA
El contenido de estos planos es para guiar al constructor en el proceso de construcción de un proyecto. 
Son utilizados para proceso de aprobación de licencias ya que brindan información técnica importante 
para conocer el proyecto a profundidad. Estos planos, al ser constructivos, deben llevar una mayor riqueza 
y claridad en la expresión gráfica, datos técnicos y especificaciones que nos servirán para desarrollar la 

arquitectura de la obra de forma correcta.

TIPOS DE PLANO O VISTAS FUNCIÓN

Plano Matriz (Machote)

Sin color, sin texturas, sin sombras, sin mobiliario. La función de estos 
planos es contar con la geometría básica del proyecto, mobiliario 
fijo, muros, losas, pérgolas, dobles alturas, voladizos, pendientes.

Son los planos que se compartirán a especialistas, estos necesitan la 
información lo más limpia y clara posible para poder trabajar en sus 
propias especialidades.
Los planos deben ser sobre la última versión de arquitectura, por lo 
cual si hay un cambio significativo en el proyecto, estos deben ser 
actualizados y compartidos para evitar contratiempos y problemas 
con instalaciones.

Plano de Localización

Sin color, sin texturas, sin sombras, sin mobiliario.
Estos planos nos sirven para visualizar el contexto del proyecto y sus 
rutas de acceso (vías principales y secundarias).
Se indicará la ubicación del terreno, calles y avenidas principales que 
rodean el proyecto, polígono del terreno y restricciones municipales.  

Plano de Ubicación

Sin color, sin texturas, sin sombras, sin mobiliario.
En este plano se indica la ubicación del terreno en su contexto 
inmediato, se observa con claridad la calle o avenida de acceso, 
servidumbres de paso (si aplica), polígono del terreno, áreas verdes 
y áreas construidas.

Planta de Conjunto

Uso de colores suaves, texturas en grises, sombras suaves.
Estos planos continuarán proporcionando la información que 
brindaban en la fase de diseño. Serán un poco más detallados 
mostrando  bloques  de  conjunto con sus nombres, cubiertas, 
pendientes  de cubiertas, alineaciones, retiros, límites de 
permeabilidad, límites del terreno, servidumbres de paso (si aplica), 
plazas de estacionamiento (si son visibles), niveles, pendientes en 
circulaciones, dirección de escaleras (si aplica), nombre de vías de 
acceso, colindancias, ingreso al proyecto/edificio.
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Planta de implantación de 
geometría arquitectónica

Sin color, sin texturas, sin mobiliario, sin niveles.

Se indicará la implantación de la huella del edificio basándose 
en un Banco de Marca o puntos de trazo de terreno indicados 
en topografía (idealmente puntos que no se pierdan al haber 
movimientos de tierra)  y colocando coordenadas X y Y que ayuden 
a ubicar vértices del edificio dentro del terreno.

Derrotero del polígono con ubicación y distancia entre puntos.

Planta de Arquitectura

Una planta por nivel.

Sin color, texturas en grises. Solamente se resaltará la vegetación en 
colores suaves (áreas verdes, jardineras, árboles).
Indican distribuciones interiores del edificio y de cada nivel que lo 
conforma, brinda información un poco más detallada que las plantas 
en fase de diseño.
Se le da prioridad a lo técnico indicando niveles (NPT y MSNM), 
porcentaje de pendientes, datos de áreas y notas específicas de la 
arquitectura en general.

Planta Acotada

Sin color, sin texturas, sin mobiliario.
Se indicarán cotas parciales, cotas totales, cotas a muros, cotas a 
ejes, niveles (NPT y MSNM), mobiliario fijo, porcentaje y dirección de 
pendientes, pendiente de cubiertas, dirección de escaleras.

Planta de Acabados

Sin color o colores con poca saturación, texturas en grises, sin 
mobiliario.
En esta planta se podrá observar los acabados utilizados en 
el proyecto y el inicio de modulación en azulejos en donde sea 
necesario aplicarlos; nos brindará información técnica de los 
acabados en muros, pisos y cielos falsos en donde podremos ver 
detalles de colocación de material, alturas específicas y datos 
requeridos por parte de fabricantes (datos generales).
Incluirá planillas de acabados (muros, pisos, cielos falsos).

Planta de Puertas y Ventanas

Sin color, sin texturas, sin mobiliario.
Estas plantas solamente indicarán las ubicaciones de puertas y 
ventanas en los niveles proyectados. Se colocarán etiquetas que 
brindarán datos básicos de la geometría.
Incluirá planillas de puertas y ventanas.
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Elevaciones

Sin color, texturas en grises, sin mobiliario.
Uso de lenguaje de líneas.
Su uso no difiere del indicado en fase de diseño. Habrá más riqueza 
de información en las vistas colocando datos técnicos y notas en 
donde sea necesario.

Secciones

Sin color, texturas en grises, sin mobiliario.
Uso de lenguaje de líneas.
Su uso no difiere del indicado en fase de diseño. Habrá más riqueza 
de información en las vistas colocando datos técnicos y notas en 
donde sea necesario.

Tabla 5 Elementos a visualizar en planos según la información a entregar durante la fase de planificación 
arquitectónica. Por Melanie Orozco. Guatemala, Diciembre de 2018.
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DETALLES ARQUITECTÓNICOS

En estos planos se muestran las vistas de detalle que nos ayudarán a comprender mejor 
geometrías, datos y dimensiones de los elementos específicos del proyecto.

Estos planos a pesar de ser un poco más detallados no mostrarán datos de fabricación de carpintería o 
herrería.

TIPOS DE PLANO O VISTAS FUNCIÓN

Detalles de Puertas y Ventanas

Se mostrarán detalles de puertas y ventanas, geometría básica y 
específica según el diseño.
Se colocan dimensiones generales correspondiente a anchos, altos 
y dinteles; sillares de ventanas y puertas, además de los materiales a 
utilizar sin entrar a detalle de datos de fabricación (perfiles a utilizar, 
tornillos, soldaduras, etc).

Detalles de Baños

Sin colores, texturas en gris.
Se mostrarán plantas, secciones y detalles tridimensionales según 
sea necesario. El objetivo es poder visualizar el uso de artefactos 
sanitarios, accesorios, materiales específicos, alturas y dimensiones de 
azulejos y listelos.

Detalles de Cocinas

Sin colores, texturas en gris.
Se mostrarán plantas, secciones y detalles tridimensionales según 
sea necesario. El objetivo es poder visualizar uso de artefactos de 
cocina, accesorios, materiales específicos, alturas y dimensiones de 
azulejos y listelos.

Cortes de Muros

Secciones de tipos de muros utilizados en el proyecto. Cambios de 
materiales en los mismos, refuerzos, etc. En estos se podrá visualizar 
cambios de materiales dependiendo si hay mobiliarios fijos anclados 
al muro.

Detalles de Gradas y Rampas

El objetivo de estos planos es mostrar la geometría de las gradas y 
rampas del proyecto, alturas de escalones, alturas y geometría de 
barandillas (datos útiles para CONRED), niveles de inicio y final de 
los mismos; y niveles y alturas de descansos.

Detalles de Muebles fijos y/o de 
Obra

En estos se brindarán datos de mobiliarios específicos del proyecto 
como: tops de lavamanos, tops de cocina, closets, recibidores, 
buzones, etc.
Se indicarán dimensiones de geometría en general y de materiales a 
utilizar sin entrar a detalle de fabricación. 

Tabla 6 Elementos a visualizar en planos según el tipo de detalles a incluir en una planificación arquitectónica. Por 
Melanie Orozco. Guatemala, Diciembre de 2018.
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03.1.3 Complemento Fase de Arquitectura 
(Información)

Trabajar en la planificación de arquitectura no 
solamente consiste en cumplir con una cantidad 
de planos, estos deben contener cierta información 
que permita conocer el proyecto, estos datos varían 
según el tipo de plano.

En este inciso se indica en una Tabla tipo “checklist” 

Planta de Conjunto

Norte

Ejes de Conjunto (Si aplican)

Proyección de Restricciones Municipales 
(polígonos de terreno, alineaciones)

Proyección de Restricciones de Incentivos 
(si aplica)

Cotas parciales y totales a ejes

Cotas relevantes (Anchos de calles, vías y 
caminamientos)

Límites de Fase (si aplica)

Nombre de calles y vías de acceso

Indicación de ingresos

Bloques

Caminamientos

Ambientación de conjunto (jardineras, 
vegetación, mobiliario urbano, vehículos)

Niveles NPT y MSNM en caminamientos, 
plazas, espacios de estacionamiento, 
ingreso de bloques

Colores, texturas y sombras (opcional)

Pendientes de calle, rampas, cubiertas.

Notas de Plano

Simbología de plano

Planta de Arquitectura

Norte

Ejes

Proyección de Restricciones Municipales 
(polígonos de terreno, alineaciones)

Proyección de Restricciones de Incentivos 
(si aplica)

Cotas parciales y totales a ejes

Cotas relevantes (anchos de calles, vías y 
caminamientos)

Límites de Fase (si aplica)

Nombre de calles y vías de acceso

Indicación de ingresos a zonas o 
ambientes importantes del proyecto

Ambientación de conjunto (jardineras, 
vegetación interior y exterior, mobiliario 
urbano, vehículos)

Todo tipo de mobiliario

Dimensiones o área de ambiente

Nombre de ambientes del nivel

Niveles NPT y MSNM

Colores, texturas y sombras (opcional)

Notas de Plano

Simbología de plano

los elementos visibles que deberá tener cada 
plano, más la información técnica y notas que lo 
complementan. El objetivo es comenzar a tener una 
idea de lo que estos planos deben contener antes 
de proceder al aprendizaje de cómo colocarlos 
o representarlos en planos con la ayuda de 
herramientas del software Revit y que este sea para 
uso del estudiante en el momento que necesite 
realizar estas plantas.

PLANOS DE DISEÑO
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Elevaciones

Ejes

Proyección de Restricciones Municipales
(alturas máximas DGAC)

Perfiles de topografía (Proyección de 
perfil natural, proyección a 1.20m y 
proyección a altura máxima según POT).

Cotas parciales y totales entre niveles

Cotas relevantes alturas de niveles (losa a 
losa), pérgolas, voladizos o cenefas.

Ambientación de conjunto (jardineras, 
vegetación exterior, mobiliario urbano, 
vehículos)

Nombre de espacios de jardín, áreas 
verdes y áreas de juegos

Nombre de ambientes visibles

Indicación de niveles NPT y MSNM

Colores, texturas y sombras en fachadas

Figura Humana

Notas de Plano

Simbología de plano

Secciones

Ejes

Proyección de Restricciones Municipales
(alturas máximas DGAC)

Perfiles de topografía (Proyección de 
perfil natural, proyección a 1.20m y 
proyección a altura máxima según POT).

Cotas parciales y totales entre niveles

Cotas relevantes alturas de niveles (losa a 
losa), pérgolas, voladizos o cenefas.

Ambientación de conjunto (jardineras, 
vegetación interior y exterior, mobiliario 
urbano, vehículos)

Nombre de espacios de jardín, áreas 
verdes y áreas de juegos

Nombre de ambientes visibles

Indicación de niveles NPT y MSNM

Colores, texturas y sombras

Figura Humana

Notas de Plano

Simbología de plano

PLANOS DE DISEÑO
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Plano Matriz (Machote)

Norte

Ejes

Muros y losas. (Geometría principal del 
proyecto)

Caminamientos

Cotas relevantes (Anchos de calles, vías y 
caminamientos)

Cotas totales y parciales a ejes

Indicación de ingresos principales

Límites de Fase (si aplica)

Mobiliario Fijo y Urbano (si aplica)

Niveles NPT y MSNM en caminamientos, 
plazas, espacios de estacionamiento, 
ingreso de bloques

Nombre de calles y vías de acceso

Proyección de Restricciones Municipales 
(polígonos de terreno, alineaciones)

Proyección de Restricciones de Incentivos 
(si aplica)

Simbología de plano

Vehículos no detallados (para indicar 
cumplimiento de radios de giro)

Planta de Conjunto

Norte

Ejes

Ambientación importante de conjunto 
(jardineras, vegetación exterior)

Bloques de edificio

Caminamientos

Cotas relevantes (Anchos de calles, vías y 
caminamientos)

Cotas totales y parciales a ejes

Colores, texturas y sombras suaves. 
Solamente para hacer representación de 
materiales utilizados y diferenciación de 
vegetación, pavimentos y caminamientos 
peatonales.

Indicación de ingresos principales

Todo tipo de mobiliario

Niveles NPT y MSNM en caminamientos, 
plazas, espacios de estacionamiento, 
ingreso de bloques, cubiertas.

Nombre de calles y vías de acceso

Proyección de Restricciones Municipales 
(polígonos de terreno, alineaciones)

Proyección de Restricciones de Incentivos 
(si aplica)

Simbología de plano

Vegetación

Vehículos no detallados (para indicar 
cumplimiento de radios de giro)

PLANOS DE ARQUITECTURA

 Este tipo de plano será utilizado en plantas 
Acotadas, de Acabados, Ubicación de Puertas y 
Ventanas y Detalles, ya que para estos tipos de vista 
será necesario ver solamente elementos específicos 
y que resalten los símbolos o códigos de cada 
elemento. 
En el capítulo 04 de este documento se verá más 
a detalle el funcionamiento y representación de las 
plantas enlistadas en el capítulo 3.1.2.
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Planta de Arquitectura

Norte

Ejes

Ambientación (jardineras, vegetación 
interior)

Colores y texturas suaves. Solamente 
para hacer representación de materiales 
utilizados.

Cotas relevantes (Anchos de calles, vías y 
caminamientos)

Cotas totales y parciales a ejes

Indicación de ingresos principales

Límites de Fase (si hubiere)

Todo tipo de mobiliario

Niveles NPT y MSNM en caminamientos, 
plazas, espacios de estacionamiento, 
ingreso de bloques

Nombre de ambientes visibles

Nombre de calles y vías de acceso.
(En niveles superiores al nivel de acceso, 
se proyectará la geometría de calle en 
grises, esto solamente para ubicar los 
ambientes interiores con respecto a la 
calle principal)

Proyección de Restricciones Municipales 
(polígonos de terreno, alineaciones)

Proyección de Restricciones de Incentivos 
(si aplica)

Simbología de plano

Vegetación

Vehículos

PLANOS DE ARQUITECTURA

Elevaciones

Ejes

Proyección de Restricciones Municipales
(alturas máximas DGAC)

Perfiles de topografía (Proyección de 
perfil natural, proyección a 1.20m y 
proyección a altura máxima según POT).

Cotas parciales y totales entre niveles

Cotas relevantes alturas de niveles (losa a 
losa), pérgolas, voladizos o cenefas.

Ambientación de conjunto (jardineras, 
vegetación exterior, mobiliario urbano, 
vehículos)

Nombre de espacios de jardín, áreas 
verdes y áreas de juegos

Nombre de ambientes visibles

Indicación de niveles NPT y MSNM

Colores y texturas suaves de fachadas. 
Solamente para hacer representación de 
materiales utilizados.

Notas de Plano

Simbología de plano
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PLANOS DE ARQUITECTURA

Secciones

Ejes

Proyección de Restricciones Municipales
(alturas máximas DGAC)

Perfiles de topografía (Proyección de 
perfil natural y proyección a altura máxima 
según POT).

Cotas parciales y totales entre niveles

Cotas relevantes alturas de niveles (losa a 
losa), pérgolas, voladizos o cenefas.

Ambientación de conjunto (jardineras, 
vegetación interior y exterior, mobiliario 
urbano, vehículos)

Nombre de espacios de jardín, áreas 
verdes y áreas de juegos

Nombre de ambientes visibles

Indicación de niveles NPT y MSNM

Colores y texturas suaves de fachadas 
o ambientes interiores. Solamente para 
hacer representación de materiales 
utilizados.

Notas de Plano

Simbología de plano
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03.2. ASPECTOS PRÁCTICOS

03.2.1 Uso de herramientas de Revit 
(Interfaz)

 En la interfaz de Revit se visualizan varias 
herramientas que son útiles para modelado, 
anotaciones y análisis. En este inciso sólo se dará 
una breve descripción de estas y al avanzar en el 
desarrollo del documento se profundizará en las 
herramientas de anotación y de mejoramiento de 
representación gráfica.

Para este inciso se colocarán capturas de la interfaz 
en español y su equivalente en inglés demostrando 
así que las herramientas tienen la misma ubicación 
sin importar el idioma en que se use el software.

Es necesario que el usuario de esta guía se familiarice 
con el software en idioma inglés ya que de esta 
forma es como se le facilita a las empresas compartir 
su información de forma internacional y como al 
usuario se le facilitará integrarse en caso realice 
un viaje de negocios o para conseguir proyectos 
internacionales.

CINTA DE OPCIONES

En la cinta de opciones de Revit se encuentran las 
fichas:

• Arquitectura
• Estructura
• Acero
• Sistemas
• Insertar
• Anotar
• Análisis
• Masa y Emplazamiento
• Colaborar
• Vista
• Gestionar
• Complementos
• Modificar

Estas fichas se ajustan según la resolución de pantalla 
del usuario, de igual forma todas las herramientas se 
encuentran disponibles en cualquier tipo de monitor. 
Estas herramientas se encuentran clasificadas según 
su función.

Interfaz en Español

Interfaz en Inglés



83

A S P E C T O S  P R Á C T I C O S

FICHA ARQUITECTURA

En esta ficha es posible encontrar diferentes 
herramientas que podrán auxiliar al usuario para el 
modelado de un proyecto de arquitectura. Cada 
herramienta tiene sus opciones y configuraciones 
específicas para lograr el modelado del elemento 
arquitectónico que necesitamos, es importante 
utilizar cada herramienta según la función que tiene 
y no reemplazar por herramientas que al final no 
guardarán la categoría del elemento que están 
representando.

Podremos encontrar los botones para iniciar un 
modelado de muros, puertas (familias), ventanas 

(familias), componentes (familias con anfitrión, sin 
anfitrión, etc.), cubiertas, cielos falsos. pisos, muros 
cortina, barandillas, etc.

Estas herramientas de modelado se encuentran 
clasificadas dentro de los siguientes grupos:

• Construir
• Circulación
• Modelo
• Habitación y Área
• Hueco
• Referencia
• Plano de Trabajo

FICHA ESTRUCTURA

En la ficha estructura, como el nombre lo indica, 
encontramos herramientas de modelado estructural. 

Estas herramientas cuentan con sus propias 
configuraciones que permitirán realizar un cálculo 
aproximado o exacto (dependiendo de los valores 
que se ingresen en las opciones de modelo) de los 
diferentes elementos que soportarán la edificación 
para lograr tener un estudio estructural y una memoria 
de cálculo automática.

Estos son los grupos de herramientas que se incluyen 
dentro de esta ficha:

• Estructura
• Conexión
• Cimentación
• Refuerzo
• Modelo
• Hueco
• Referencia
• Plano de Trabajo

Interfaz en Español

Interfaz en Inglés

Interfaz en Español

Interfaz en Inglés
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FICHA ACERO

En esta ficha se ubican herramientas útiles y que 
son exclusivamente para estructuras o elementos 
arquitectónicos de acero, con estas herramientas 
se podrá simplificar el modelado de este sistema 
estructural.

Nota: La ficha Acero solamente podrá ser 
encontrada desde Revit 2019 y versiones 
posteriores, las versiones anteriores no cuentan con 
este tipo de herramientas.

FICHA SISTEMAS

En esta ficha se encuentran herramientas que 
sirven para modelado de sistemas de tubería en 
instalaciones hidrosanitarias, eléctricas y mecánicas.

Dentro de las configuraciones desplegables es 
posible configurar cada herramienta de sistema, 
se configura su representación y cada ángulo de 
tubería, también es posible configurar las fórmulas 
de cálculo utilizadas para el modelado.

Dentro de la ficha sistemas, se incluyen los siguientes 
grupos de herramientas:

• Climatización
• Fabricación
• Configuración de P&ID (Piping and  

Instrumentation Diagram)
• Mecánica
• Fontanería y Tuberías
• Electricidad
• Modelo
• Plano de Trabajo

Estos son los grupos de herramientas que se incluyen 
dentro de esta ficha:

• Conexión
• Elementos de Fabricación
• Modificadores
• Cortes Paramétricos
• Plano de Trabajo

Interfaz en Español

Interfaz en Inglés

Interfaz en Español

Interfaz en Inglés
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FICHA INSERTAR

Las herramientas de esta ficha permiten insertar 
otros archivos al modelo de Revit como apoyo al 
proyecto. Estos archivos pueden ser archivos Revit, 
IFC, CAD, DWF, DxF, Imágenes, RFA., etc. En Revit 
2020 ya es posible encontrar la opción de insertar 
archivos PDF al modelo.

Dentro de esta ficha se encuentran los siguientes 
grupos de herramientas:

• Vincular
• Importar
• Cargar desde Biblioteca

Interfaz en Español

Interfaz en Inglés

Interfaz en Español

Interfaz en Inglés

FICHA ANOTAR

Son las herramientas que apoyan al usuario en 
el desarrollo de la planificación del proyecto y 
cuestiones de expresión gráfica, igualmente son 
utilizados para la corroboración de datos durante 
el proceso de modelado, estas herramientas a 
pesar de ser puramente de anotación (notas en 2D) 
es posible utilizar algunas de ellas en una vista 3D, 
siempre y cuando esta se encuentre bloqueada y 
renombrada. 

Las herramientas ubicadas en esta ficha son:
• Cota
• Detalle
• Texto

• Etiqueta
• Relleno de Color
• Símbolo

De esta ficha se dará una explicación un poco 
más detallada para cada herramienta, ya que es 
importante que se conozcan sus funcionamientos 
para ponerlos en práctica.
Las herramientas observadas en esta cinta de 
opciones son las que apoyarán en el desarrollo del 
capítulo 4 y que se irán conociendo más a detalle 
a lo largo de este documento. 
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• Cota

En este grupo se encuentran las herramientas que 
brindan una medida, dimensión, nivel o coordenada 
a algún elemento 2D o 3D. Es posible utilizarlas 
dentro de vistas 3D ubicando planos de trabajo 
para su colocación, pero se recomienda crearlas y 
eliminarlas cuando ya no se necesiten o colocarlas 
en una vista bloqueada.

Interfaz en Español

Interfaz en Inglés

Ficha Anotar

En el menú desplegable del grupo se pueden 
configurar los diferentes tipos de cotas, para las 
cotas es necesario cambiar su dimensión o diseño 
según la documentación o el plano a realizar, las 
configuraciones se conocerán más adelante en 
este documento.

Interfaz en Español

Interfaz en Inglés

• Detalle

Estas herramientas son de utilidad para anotaciones 
2D dentro de vistas en planta, secciones, 
elevaciones, detalles, drafting views, leyendas y 
hojas. Las herramientas de este grupo no pueden 
ser utilizadas en vistas 3D.

En la parte inferior de algunas fichas aparece 
un botón con una imagen de un pequeño pin 

(  ), este se utiliza para sujetar la ficha 
de opciones de las herramientas pudiendo 
dar clicks fuera y probar el tipo de opción 
que vamos chequeando sin que este menú 
se oculte. Cuando se termine de configurar 
las preferencias de la herramienta es posible 
volver a dar click en este botón y así la ficha 
se oculta.

NOTA

Interfaz en Español

Interfaz en Inglés

Ficha Anotar
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• Texto

Como el nombre lo indica, son herramientas que 
permiten insertar, modificar y revisar textos dentro de 
vistas 2D y 3D.

Es posible realizar revisiones ortográficas y  
reemplazar textos dentro de todo el proyecto o una 
sola vista.

Interfaz en Español

Interfaz en Español Interfaz en Inglés

Interfaz en Inglés

• Etiqueta

Herramientas útiles para anotar tipos de elementos 
del modelo, estas etiquetas pueden crearse según 
las necesidades del proyecto, más adelante se 
conocerán las instrucciones para modificar y crear 
este tipo de familias.

Dentro de sus configuraciones desplegables, es 
posible verificar los tipos de familias de etiqueta 
que ya se encuentran cargados en el proyecto 
y seleccionar entre estas cuál es la que se quiere 
colocar por defecto al abrir y utilizar la herramienta.

Interfaz en Español

Interfaz en Inglés

Ficha Anotar

Interfaz en Español

Interfaz en Inglés

Ficha Anotar
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• Relleno de Color

Con estas herramientas es posible colocarle un 
código de color a diferentes espacios o elementos 
de modelo para identificarlos según cualquier 
categoría. Los esquemas de color son colocados 
dentro de las vistas.

Interfaz en Español

Interfaz en Inglés

Ficha Anotar

• Símbolo

Son utilizadas para colocar símbolos de anotación 
en planos y vistas para una mejor representación 
del dibujo.

Interfaz en Español

Interfaz en Inglés
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FICHA ANALIZAR

Las herramientas ubicadas en esta ficha sirven 
para realizar análisis de sistemas y de proyecto 
conforme a los datos que se ingresaron en cada 
elemento del modelo, estos datos se indican en 
las características de cada tipo de familia.

Es responsabilidad de cada especialista 
corroborar que los datos que se hayan 
ingresado en el modelo sean los adecuados 

Interfaz en Español

Interfaz en Inglés

FICHA MASA Y EMPLAZAMIENTO

Estas herramientas sirven para modelar, dentro del 
mismo archivo de Revit, elementos con geometría 
muy específica o con características especiales 
que se necesiten en el proyecto. Esto quiere decir 
que no es necesaria la realización de familias para 
obtener el mismo fin. 
Adicional alberga las herramientas para colocar 
familias de emplazamiento que serán útiles para 

complementar la información del entorno del 
proyecto.
Dentro de esta ficha se encuentran los siguientes 
grupos de herramientas:

• Masa Conceptual
• Modelo por Cara
• Modelar Emplazamiento
• Modificar Emplazamiento

Interfaz en Español

Interfaz en Inglés

para que las demás especialidades puedan 
avanzar correctamente.

Dentro de esta ficha se encuentran los siguientes 
grupos de herramientas:

• Modelo Analítico
• Herramientas de Modelo Analítico
• Espacios y Zonas
• Comprobar Sistemas
• Optimización de Energía
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FICHA COLABORAR

Dentro de Revit es posible trabajar proyectos por 
medio de modelos centrales, estos pueden ser 
alojados en la nube (BIM360) o en un servidor. 
Las herramientas que se encuentran en la ficha 
Colaborar solamente se activan cuando el modelo 
es creado y configurado como modelo central, de 
lo contrario las herramientas aparecen inactivas.

Dentro de esta ficha se encuentran los siguientes 
grupos de herramientas:

• Comunicar
• Gestionar Colaboración
• Sincronizar
• Gestionar Modelos
• Coordinar

Interfaz en Español

Interfaz en Inglés

FICHA VISTA

En estas herramientas es posible crear vistas, realizar 
modificaciones o cambiar sus propiedades y 
visualización. 

Igualmente, en esta ficha se encuentran las 
herramientas para modificar las configuraciones en 
la interfaz de Revit, gracias a ellas se pueden ocultar 
y añadir botones, configurar teclas de acceso 
rápido y modificar las formas de visualización de las 
pestañas abiertas. 

Las herramientas ubicadas en esta ficha son:
• Gráficos
• Presentación
• Crear
• Composición de plano
• Ventanas

De esta ficha igualmente se dará una explicación un 
poco más detallada para cada herramienta, ya que 
es importante que se conozcan sus funcionamientos 
para ponerlos en práctica.

Interfaz en Español

Interfaz en Inglés



91

A S P E C T O S  P R Á C T I C O S

• Gráficos

Este grupo de herramientas permite modificar los 
elementos de modelo que se quieren visualizar 
en cada vista creada, gracias a estas es posible 
configurar las vistas necesarias para crear tipos de 
planos obteniendo ayuda también de las plantillas 
de vista.

Adicional, dentro de la ventana de configuración 
de gráficos es posible modificar características 
de visualización como por ejemplo el tipo de 
visualización del modelo, la visualización de los 
bordes en la vista que se está trabajando, la 
intensidad de las sombras, etc.; y que al finalizar, 
todas estas configuraciones se puedan guardar 
como una plantilla para utilizar en otras vistas del 
modelo.

Interfaz en Español

Interfaz en Inglés

Ficha Vista

• Presentación

Dentro de este grupo se encuentran las herramientas 
necesarias para realizar renderizaciones de vistas 
en 3D para presentación de proyectos, estas 
auxilian para mostrar en mejor calidad (una vez se 
configure correctamente) el modelo o los ambientes 
diseñados.

Interfaz en Español

Interfaz en Inglés

Grupo Gráficos

Es posible renderizar en el mismo equipo donde se 
está trabajando o bien, siempre que se cuente con 
un usuario de Autodesk, es posible subir estas vistas 
a la galería de renderizado de esta compañía y los 
servidores se encargarán de renderizar la imagen.

• Crear

Dentro de estas opciones se encuentran las 
herramientas para poder crear vistas (plantas, 
elevaciones, secciones, llamados a detalle, vistas 
3D, etc.).

Interfaz en Español

Interfaz en Inglés

Ficha Vista

Interfaz en Español

Interfaz en Inglés

Ficha Vista



92

A S P E C T O S  P R Á C T I C O S

• Composición de Plano

Herramientas utilizadas para poder crear y ordenar 
los planos necesarios para el proyecto a trabajar, 
es posible realizar revisiones en los mismos o crear 
notas en planos para referenciar demás hojas en 
donde se detallan mejor los elementos visibles.

• Ventanas

Herramientas que permiten modificar la interfaz 
del software. Con estas herramientas es posible 
modificar qué botones, ventanas u opciones es 
necesario ver según su utilidad. Adicionalmente se 
pueden configurar las teclas de acceso rápido 
para comodidad del usuario.

Interfaz en Español

Interfaz en Inglés

Ficha Vista

Interfaz en Español

Interfaz en Inglés

Ficha Vista
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FICHA GESTIONAR

Dentro de esta ficha es posible modificar las 
configuraciones del proyecto. Son herramientas 
que permiten la utilización de parámetros para 
modelado y anotación, configuraciones básicas de 
elementos de anotación, etc. 
Además, dentro de este grupo de herramientas, 
una vez se haya instalado, es posible encontrar 
la herramienta de programación llamada Dynamo, 
la cual por medio de elementos de programación 
permite automatizar las funciones del modelado y 
anotación dentro de Revit. 

Interfaz en Español

Interfaz en Inglés

FICHA COMPLEMENTOS

Dentro de este grupo de herramientas es 
posible encontrar las extensiones instaladas en 
el equipo. Algunas sirven para simplificar tareas 
en Revit o para realizar las tareas para las que 
este software no fue creado.

Adicional encontramos herramientas de 
exportación o de chequeo en las que el modelo 
es creado bajo otro formato para su revisión en 
otros software.

Estos son los grupos de herramientas que se incluyen 
dentro de esta ficha:

• Configuración
• Ubicación de Proyecto
• Opciones de Diseño
• Gestionar Proyecto
• Fases de Proyecto
• Selección
• Consultar
• Macros
• Programación Visual

Interfaz en Español

Interfaz en Inglés
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FICHA MODIFICAR

Gracias a estas herramientas es posible modificar 
los elementos dentro del archivo que se está 
trabajando.
Dentro de esta ficha se encuentran los siguientes 
grupos de herramientas:

• Propiedades
• Portapapeles

• Geometría
• Modificar
• Vista
• Medir
• Crear

Interfaz en Español

Interfaz en Inglés
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La Barra de Navegación muestra las herramientas 
asignadas por defecto pero puede ser 
personalizada según la comodidad del usuario. 

BARRA DE HERRAMIENTAS DE 
ACCESO RÁPIDO

Dentro de esta barra aparecen las herramientas 
que Revit asigna por defecto, estas pueden ser 
las herramientas que más se utilizan al trabajar un 
proyecto. Esta puede ser personalizada con las 
herramientas que mejor se adapten a la forma 
de trabajar del usuario.

ÁREA DE DIBUJO

Es la ventana que muestra el área de modelo (vista 
de plano), Tabla o área de dibujo según el tipo de 
vista que se haya abierto, esta se adapta según las 
características. 

En una vista de plano, vista 3D, leyendas o vistas 
de diseño aparecen las barras de navegación en 
la parte lateral de la ventana. En esta se alojan 
las herramientas Rueda de Navegación y Ampliar 
Región.

Rueda de 
Navegación / 
Ampliar Región

BARRA DE CONTROLES DE VISTA

La barra de controles de vista aparece en la 
parte inferior izquierda de la vista de plano, 
esta contiene herramientas que son útiles en la 
configuración gráfica de la vista a trabajar. Estas 
apoyan en la realización de plantillas de vista 
(se verá un ejemplo de aplicación en el inciso 
03.2.4 Creación y configuración de plantillas de 
vista).

Vista de Plano

Tabla

Leyenda

Vista 3D
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Las herramientas asignadas por defecto son las 
siguientes:

• Escala: Esta herramienta permite la colocación 
de escalas a cada vista. Por defecto, es posible 
colocar las escalas que aparecen en el listado, 
o bien, es posible colocar una escala diferente 
seleccionando la opción “Personalizado…”.

Al seleccionar una escala personalizada, es 
posible teclear la que se necesita sin ningún 
tipo de restricción. Sin embargo se recomienda 
solamente utilizar las que enlista el software ya 
que son las manejadas internacionalmente y las 
que se pueden leer por medio de una conversión 
al utilizar una regla o un metro en obra. 

También se pueden colocar las encontradas en 
el escalímetro (Ej. 1:75 y 1:125) pero se deben 
utilizar sólo si es absolutamente necesario.

Si se desea colocar una escala diferente a las 
utilizadas (Ej. 1:30, 1:40, 1:300, 1:4500, etc.), por 
ejemplo para vistas 3D o planos de ubicación 
(vistas que solo sirven para referencia de otra) 
es recomendable colocarle a la vista la nota 
“SIN ESCALA” y auxiliarnos en el título de la misma, 
para que el constructor no base sus medidas en 
estas sino se referencie en las vistas ortogonales 
específicas de cada tema.

• Nivel de Detalle: Herramienta que, como su 
nombre lo dice, modifica el nivel de detalle de la 
vista que se está trabajando. El nivel de detalle 
muestra y oculta características de los elementos 
modelados dependiendo su configuración.
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• Estilo Visual: Esta herramienta es útil para 
cambiar el estilo visual de la vista que se está 
trabajando, esta se coloca dependiendo del 
tipo de plano en el que se ubicará. Los tipos de 
estilo visual son los siguientes:

• Estructura alámbrica
• Línea Oculta
• Sombreado
• Colores Coherentes
• Realista
• Trazado de rayos

ESTRUCTURA ALÁMBRICA

LÍNEA OCULTA

SOMBREADO

COLORES COHERENTES

REALISTA

Esta herramienta también cuenta con una 
ventana de configuraciones, en ella es posible 
modificar la visualización del modelo, tipo de 
sombras, niebla, modificación de tipo de trazo 
del croquis, iluminación y exposición fotográfica.
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• Camino de Sol: Esta herramienta sirve para 
activar o desactivar el camino de sol para el 
proyecto, este se utiliza para estudios solares. 
Igualmente es posible configurar los gráficos 
para este estudio, personalizando el sol según 
las condiciones que se deseen aplicar.

• Sombras: Esta herramienta, como su nombre lo 
indica, sirve para activar o desactivar sombras 
en la vista que se está trabajando. 

DESACTIVADAS

ACTIVADAS

• Recorte de Vista: Herramienta que sirve para 
activar o desactivar el recorte de vista.

DESACTIVADO

ACTIVADO
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• Ocultar / Mostrar Región de Recorte

• Ocultar / Aislar temporalmente: Como su 
nombre lo indica, sirve para ocultar o aislar 
elementos de forma temporal. Estos cambios 
pueden ser aplicados a la vista o pueden 
restablecerse al terminar de utilizarlos.

• Mostrar elementos Ocultos

• Visualización de Compartición de Proyectos: 
Esta herramienta solamente aparece al lado 
de la anterior cuando se está trabajando un 
modelo de forma colaborativa.
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El orden en el que se presentan es el siguiente:

• Estado de Pertenencia (Checkout Status): 
En este tipo de visualización es posible ver 
los elementos del modelo sobre los que el 
usuario es propietario, sobre los que otro 
usuario del mismo proyecto es propietario y 
sobre los que no tienen ningún propietario.

• Propietarios (Owners): Dentro de esta 
configuración de vista es posible visualizar 
los elementos de modelo que son de 
diferentes propietarios.

• Actualizaciones de Modelo (Model 
Updates): Dentro de esta opción se 
pueden visualizar los elementos de modelo 
que fueron creados por otros usuarios y que 
aún no han sido sincronizados, además de 
los elementos del modelo que ya fueron 
borrados en el modelo central pero que aún 
no han sido actualizados.

• Subproyectos (Worksets): Esta 
configuración de vista nos muestra los 
elementos de modelo que pertenecen a los 
subproyectos definidos en el archivo.

• Propiedades de Vista Temporal: Herramienta 
útil para aplicar plantillas de vista o ediciones de 
vista de forma temporal. Esta puede ser útil para 
verificar el correcto modelado del proyecto con 
ayuda de las plantillas o para probar plantillas 
de vista antes de aplicarlas en un plano.

• Mostrar Modelo Analítico: Herramienta útil 
para visualizar los puntos y líneas de análisis de 
la estructura del modelo.

• Mostrar restricciones: Herramienta útil para 
visualizar las cotas o líneas de referencia a las 
que está restringido el modelo.

 Algunas de las herramientas anteriormente 
descritas se bloquean o desbloquean según el 
tipo de vista que se está trabajando o si la vista 
ya cuenta con alguna plantilla aplicada en sus 
propiedades.

Como se observó en la descripción de los grupos 
de herramientas, cada una de estas tiene su 
función específica. Es imprescindible utilizar cada 
una para lo que fue creada, esto con el objetivo 
de evitar volver a modelar objetos que no están 
en la categoría correcta, volver a crear vistas o 
bien; en un proyecto que es trabajado de forma 
colaborativa, se evite modificar o eliminar elementos 
que otras personas necesitan visualizar de forma 
específica en sus propias vistas de plano.
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03.2.2 Organización Básica de Revit

 Al abrir una plantilla de Revit, el navegador 
de proyectos muestra una organización por defecto, 
esta se conforma de vistas de planta, vistas de 
cielo reflejado y elevaciones (norte, sur, este, oeste) 
colocadas automáticamente en la interfaz de Revit.

La plantilla nos muestra la siguiente organización del 
árbol de proyecto organizando principalmente por 
tipo de elemento a trabajar (vista, Tabla, leyenda, 
etc.).

Es posible cambiar este tipo de organización pero 
se recomienda verificar bien el orden en el que 
se desea trabajar para evitar el retraso al buscar 
vistas dentro de una gran cantidad de menús 
desplegables.

Esta se puede cambiar con las siguientes opciones:

1. Dentro de la cinta de opciones > Ficha Vista > 
Grupo Ventanas > Menú desplegable Interfaz 
de Usuario > Herramienta Organización del 
navegador

2. Dando un clic derecho sobre la opción “Vistas 
(todo)” dentro del Navegador de proyectos 
> Menú desplegable > Opción Organización 
del Navegador.
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Al ingresar a la Organización del navegador en 
cualquiera de las dos formas indicadas, Revit 
mostrará la siguiente ventana emergente:

En esta es posible modificar la organización de 
las fichas Vistas, Planos y Tablas de Planificación 
chequeando las opciones existentes dentro de estas 
fichas, o bien, es posible crear nuevos parámetros 
de organización para modificar el orden del árbol 
de Revit según convenga en el proyecto. 

Como fue indicado anteriormente, se recomienda 
estudiar y consultar con los involucrados en el 
proyecto si es posible cambiar esta organización 
y de qué forma es más conveniente personalizarla.
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03.2.3 Interpretación Fases de proyecto

Como fue indicado en la descripción de los 
elementos de la cinta de opciones, dentro de 
esta y la ficha “Gestionar”, es posible encontrar la 
herramienta “Fases”.

Esta herramienta permite la organización del modelo 
por fases. Esto dependiendo de la temporalidad 
que le haya dado el cliente al ciclo de vida del 
proyecto y en el que solicite la construcción virtual 
de la misma forma en la que se organizará en la 
realidad.

Dentro de la ventana emergente se visualizan 
las configuraciones por defecto en la plantilla 
arquitectónica de Revit.
Al ingresar se visualizan tres diferentes fichas:

• Fases del Proyecto (Ej. Existente, Demolición, 
Intervención, Fase 1, Fase 2, etc.), donde se 
configura el orden de las fases colocando 
en primer lugar la más antigua (PASADO) 
descendiendo a las últimas (FUTURO).

• Filtros de Fases, donde se configura qué fases 
serán visibles dentro de cada filtro.

• Modificaciones de Gráficos, donde se 
configura la forma en que serán vistos los 
elementos de modelo de fases pasadas o 
futuras (proyección, corte, materiales, tramados) 
al aplicar los filtros de fase en una vista de plano.

Gracias a la ficha “Modificaciones de Gráficos” 
es posible configurar la representación gráfica que 
se quiera proyectar en una vista de plano. 
Esta personalización se realiza modificando las 
líneas o patrones de corte para poder representar, 
por ejemplo, en una planta de demolición cuáles 
elementos permanecerán dentro del proyecto y 
que solo tendrán una modificación y los elementos 
que se demolerán para dar lugar a otros que serán 
parte de la propuesta de diseño.
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03.2.4  Creación y configuración de 
plantillas de vista

 Dentro de Revit es posible configurar vistas 
con los elementos de modelo que deseamos ver y 
cómo deseamos verlos para interpretar el proyecto 
según el tipo de plano que se está trabajando, 
estas configuraciones se guardan como plantillas 
de vista para poder ser utilizadas en detalles u otros 
niveles del proyecto. A continuación se explicará la 
forma para crear estas plantillas.

Al tener una vista preparada para documentar o 
para visualizar de la forma que se desea, se comienza 
a ocultar y a resaltar los elementos de modelo que 
serán necesarios en la vista. En el siguiente ejemplo 
de proyecto se realizará una planta de arquitectura 
para planos constructivos.

El proyecto consiste en una torre de apartamentos 
y para este ejercicio de configuración de plantilla 
se tomará la planta de un apartamento como un 
detalle de arquitectura.
Para iniciar, se realizará un chequeo de las 
condiciones que esta planta debe tener, 
condiciones que fueron planteadas en la página 
67, inciso 03.1.2 Contenido Fase de Arquitectura 
(Tipos de plano); y en el checklist de la página 76, 
inciso 03.1.3 Complemento Fase de Arquitectura 
(Información).

El contenido con el que debe cumplir una planta de 
arquitectura para planos constructivos se muestra 
en las siguientes Tablas:

PLANIFICACIÓN 
ARQUITECTÓNICA

TIPO DE 
PLANO O 

VISTA
FUNCIÓN

Planta de 
Arquitectura

Una planta por nivel.

Sin color, texturas en grises. 
Solamente se resaltará la 
vegetación en colores suaves 
(áreas verdes, jardineras, 
árboles).
Indican distribuciones interiores 
del edificio y de cada nivel que 
lo conforma, brinda información 
un poco más detallada que las 
plantas en fase de diseño.
Se le da prioridad a lo 
técnico indicando niveles 
(NPT y MSNM), porcentaje de 
pendientes, datos de áreas 
y notas específicas de la 
arquitectura en general.

Checklist para Plantas de Arquitectura

Norte

Ejes

Ambientación

Colores y texturas suaves. Solamente 
para hacer representación de materiales 
utilizados.

Cotas relevantes

Cotas totales y parciales a ejes

Indicación de ingresos principales

Límites de Fase (si hubiere)

Todo tipo de mobiliario

Niveles NPT y MSNM

Nombre de calles y vías de acceso.

Proyección de Restricciones Municipales

Proyección de Restricciones de Incentivos

Simbología de plano

Vegetación

Vehículos
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Después de haber analizado las condicionantes 
del tipo de vista, se procederá a realizar las 
configuraciones para la plantilla.

La plantilla de vista se puede crear antes de realizar 
las configuraciones o al finalizarlas. Se recomienda 
crear la plantilla basado en una vista ya configurada 
(al finalizar) ya que al realizarlo así, se tendrá más 
rapidez para manejar las categorías y, mientras se 
trabaja, se podrá hacer uso de la tecla de acceso 
rápido a las configuraciones de gráficos en vista 
(uso de VG o VV). En este ejemplo la plantilla se 
creará de la forma descrita anteriormente.

Por defecto, Revit crea una planta en donde 
aparecen todos los elementos insertados en 
el modelo, con nivel de detalle bajo, modo de 
visualización en Línea Oculta y a escala 1:100.  
Para tener mejor claridad del proceso, se realizará 
un recorte de vista al apartamento deseado.

VISTA CREADA POR DEFECTO

INGRESAR A MODO EDICIÓN DANDO CLICK 
EL BOTÓN “EDIT CROP”

Para esto se utilizará la herramienta recorte de vista 
situada en la parte inferior de esta ventana y se 
modificará la geometría de esta con las guías que 
aparecen al seleccionar el polígono de recorte.

El marco de recorte de vista, al ser específico 
de cada una, no puede ser guardado en una 
plantilla y debe editarse de forma individual. 
La única solución rápida para realizar este 
proceso en caso se necesite un recorte 
ya configurado, es editando el boceto de 
recorte en la vista que ya está recortada, se 
copia y después se pega alineado a la vista 
donde se quiere aplicar el recorte mientras 
se está en el modo de edición de boceto.

NOTA
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SELECCIONAR EL BOCETO QUE SE NECESITA 
REPLICAR EN LA OTRA VISTA Y HACER CLICK 
EN MODIFY > “COPY TO CLIPBOARD” PARA 
COPIARLO.

EN LA VISTA DONDE SE DESEE APLICAR 
LA REGIÓN DE RECORTE, SE DA CLICK DE 
NUEVO A “EDIT CROP” Y DENTRO DEL MODO 
EDICIÓN SE PEGA EL BOCETO COPIADO CON 
LA OPCIÓN MODIFY > PASTE > ALIGNED TO  
CURRENT VIEW (ALINEADO A LA VISTA).

Ahora que el recorte ya se ha configurado, se 
cambiará el modo de vista del archivo para 
comenzar a configurar lo necesario en una planta 
de arquitectura.

• Debido a que es una planta de detalle, se 
colocará a una escala mayor. Para esto se 
configurará a una escala 1:50.

• Se colocará un nivel de detalle medio, esto para 
ver los elementos de modelo en su forma pura 
y que no muestren elementos más pequeños o 
más detallados.

Al realizar la modificación de la escala de 
dibujo dentro de la vista, se visualiza un 
cambio en los elementos de anotación, 
sin embargo Revit siempre mantendrá las 
dimensiones con las que estos fueron creados. 

NOTA
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• Se verificará que la vista se haya creado en 
línea oculta (para evitar ver colores fuertes y 
texturas en relieve en los materiales del modelo).

Al finalizar este proceso se verificará que los 
elementos de la Barra de Controles de Vista que son 
innecesarios para este tipo de planta se encuentren 
desactivados.

1. Sin camino de sol
2. Sin sombras
3. Región de recorte aplicada y oculta
4. Ningún elemento aislado u oculto temporalmente.
5. Modo de vista “elementos ocultos” desactivada
6. Vista temporal desactivada
7. Modelo analítico desactivado.
8. Restricciones desactivadas

1.

2.

3. 4.

5.

6.

7.

8.

Después de verificar esto, se ocultarán los elementos 
que no son útiles en la vista de arquitectura, esto 
se realiza en la ventana de edición de gráficos en 
vista (teclas de acceso rápido VV o VG).

Otra de las formas para apagar elementos sin  utilizar 
esta ventana es seleccionando un elemento de la 
categoría que se quiere ocultar y apagarlo con la 
herramienta “Ocultar Categoría”. Esta herramienta 
se encuentra dando click derecho sobre el objeto, 
buscar “Ocultar en Vista” > “Categoría”. 

Esta es otra forma válida para ocultar los elementos 
que no nos serán útiles y la configuración se guardará 
igualmente en la ventana de visibilidad de gráficos.
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Cuando se ha terminado de ocultar los elementos 
que no serán útiles, se procederá a configurar los 
elementos que serán visibles según el criterio tomado 
en las vistas. 
Como por ejemplo, patrón y color de corte de muros, 
línea de proyección de corte de muros, proyección 
de ventanas, rangos de vista, etc.

Al hacer esto, aparecerá una Ventana Emergente 
en la cual se solicita colocar un nombre para la 
nueva plantilla.

Se le colocará el nombre deseado (En este 
ejemplo se le colocará 01_Arquitectura). Después   
aparecerá una ventana en donde aparecerán las 
plantillas de vista del proyecto y la plantilla que 
se acaba de crear mostrando las configuraciones 
que se le dieron a la vista trabajada y el número de 
vistas con la plantilla asignada. 

Debido a que la plantilla es nueva, el número de 
vistas con la plantilla será cero (0).

Lo que nunca se debe hacer al estar 
configurando una plantilla de vista, es ocultar 
objetos por elemento ya que al utilizar esta 
opción, este cambio solamente estará 
aplicado en la vista en la que se trabajó y 
al utilizar la plantilla en otras vistas de plano, 
este objeto y su categoría permanecerán 
encendidos.

NOTA

Al estar configurados todos estos aspectos se creará 
la plantilla de vista de plantas de arquitectura 
(planos constructivos) de la siguiente forma:

Dirigirse a la Cinta de Opciones > Ficha Vista > 
Grupo Gráficos > Herramienta Plantillas de Vista > 
Opción Crear Plantilla a partir de Vista Actual.
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Al haber chequeado que la plantilla contenga las 
configuraciones correctas, se le procederá a añadir 
a la vista que se acaba de trabajar ya que, a pesar 
de ser la vista matriz, Revit no coloca la plantilla 
automáticamente al finalizar las ediciones. 

Esto lo podremos revisar y asignar en el Panel de 
Propiedades > Grupo Datos de Identidad > Plantilla 
de Vista. 

Después de asignar una plantilla de vista, esta 
no podrá editarse con la herramienta inmediata 
“Visibilidad de Gráficos”. Cualquier edición que se 
desee hacer en la vista, deberá modificarse con la 
ventana emergente de Plantillas de Vista. 

Esta ventana aparece al dar click en la plantilla 
de vista asignada en el panel de propiedades o 
accediendo desde la Cinta de Opciones > Ficha 
Vista > Grupo Gráficos > Herramienta Plantillas de 
Vista > Opción Gestionar Plantillas de Vista.
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04
Material Práctico -

Aplicación de Parámetros

04.1. ELEMENTOS DE EXPRESIÓN GRÁFICA 
- CONFIGURACIÓN DE ELEMENTOS

04.1.1 Tipos de Líneas

Dentro de Revit es posible realizar configuraciones 
para que el programa aplique espesores de líneas 
y patrones que el usuario desea. En primer lugar 
se procederá a indicar una  lista fijo o definir un 
“estándar” para que el lector de este documento 
pueda guiarse en la configuración de información 
concreta y que ya no deba definir diferentes 
tipologías de líneas cuando cuente con el tiempo 
justo para realizar su proyecto.

Como primer listado se tienen los siguientes tipos 
de líneas que fueron indicados al inicio de este 
documento:

• Línea de Contorno Principal
• Línea de Contorno General
• De corte o Sección
• De Proyección
• Discontinua u Oculto
• De Centro o Eje
• Línea Guía
• Límites de Terreno o Diseño

Estos tipos de líneas son los tipos fundamentales 
para dar inicio al diseño o documentación de 
un proyecto. En el capítulo 1.2.4 Elementos del 
Lenguaje Técnico en Revit se indicaron diferentes 
maneras de lograr estos tipos de líneas desde su 
elaboración a mano a la elaboración en digital. 

En este capítulo se indicará la forma o la realización 
correcta para cada elemento, se recomienda seguir 
las instrucciones a lo largo del mismo ya que a 
pesar de realizar una configuración algo laboriosa 
para cada herramienta, el uso correcto de cada 
una significará ahorro de tiempo al organizar la 
información. Además de esto, al finalizar el proyecto, 
este puede ser utilizado como una plantilla que 
puede ser aplicada en proyectos posteriores.

En las siguientes páginas se brindará el estándar para 
estos elementos y se dará una breve explicación 
del proceso de configuración y creación de líneas.
Esta se realiza en Ficha Gestionar > Additional 
Settings > Line Styles / Line Weights / Line 
Patterns.
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Características de Líneas
Ficha Manage > Additional Settings > Line Styles / Line Patterns

Tipo de 
Línea

Características Visualización

Contorno 
Principal

Espesor de Línea: 1.0 o 1.2mm
Patrón de Línea: Continuo
Color de Línea: Negro o a definir por usuario

Contorno 
General

Espesor de Línea: 0.8mm
Patrón de Línea: Continuo
Color de Línea: Negro o a definir por usuario

Corte o 
Sección 

(Se refiere 
al tipo de 

línea, no a la 
herramienta)

Espesor de línea: 1.0 o 1.2mm
Patrón de Línea: Línea continua (15mm), espacio (1.5mm), 
línea continua (2.0mm), espacio (1.5mm), línea continua 
(2.0mm), espacio (1.5mm).

 
Color de Línea: Negro o a definir por usuario

Proyección
Espesor de línea: 0.2 o 0.5mm
Patrón de Línea: Línea continua
Color de Línea: A definir por usuario

Discontinua 
u Oculto

Espesor de línea: 0.2 o 0.5mm
Patrón de Línea: Línea continua (6mm), espacio (2mm), línea 
continua (6mm), espacio (2mm), etc.

Color de Línea: A definir por usuario

Centro o Eje

Espesor de línea: 0.2 o 0.5mm
Patrón de Línea: Línea continua (1.5mm), espacio (1mm), 
línea continua (1.mm), espacio (1mm), etc.

Color de Línea: A definir por usuario
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Línea Guía
Espesor de línea: 0.1mm
Patrón de Línea: Línea discontinua
Color de Línea: A definir por usuario

Límites de 
Terreno o 

Diseño

Límite de terreno

Espesor de línea: 1.0mm
Patrón de Línea: Línea de Sección o Corte
Color de Línea: R: 255 G: 000 B: 000

Alineación Municipal

Espesor de línea: 1.0mm
Patrón de Línea: Línea discontinua
Color de Línea: R: 255 G: 128 B: 000

Servidumbre de Paso

Espesor de línea: 1.0mm
Patrón de Línea: Trazo con punto punto

Color de Línea: R: 000 G: 128 B: 255

Perfil de terreno

Espesor de línea: 0.5mm
Patrón de Línea: Línea discontinua
Color de Línea: R: 000 G: 183 B: 000

Límites de Altura

Espesor de línea: 0.5mm
Patrón de Línea: Línea discontinua
Color de Línea: R: 255 G: 000 B: 128

Línea de 
Ruptura

Espesor de línea: 0.2 - 0.4 mm
Patrón de Línea: Continuo
Color de Línea: A definir por usuario

Tabla 7 Características de líneas utilizadas para expresión gráfica en planos. Sugerencia de visualización para 
planificación a elaborar en formato A1. Por Melanie Orozco. Guatemala, Diciembre de 2019.
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Espesores* de Líneas según Escala
Ficha Manage > Additional Settings > Line Weights

ESCALAS

N
úm

er
o

 d
e

 P
un

to
 e

n 
Re

vi
t

1:10 1:20 1:50 1:100 1:200 1:500 1:1000

1 1.00 mm 0.50 mm 0.20 mm 0.1 mm 0.05 mm 0.025 0.025**

2 2.00 mm 1.00 mm 0.40 mm 0.2 mm 0.10 mm 0.040 0.025**

3 3.00 mm 1.50 mm 0.60 mm 0.3 mm 0.15 mm 0.06 0.03

4 4.00 mm 2.00 mm 0.80 mm 0.4 mm 0.20 mm 0.08 0.04

5 5.00 mm 2.50 mm 1.00 mm 0.5 mm 0.25 mm 0.10 0.05

6 6.00 mm 3.00 mm 1.20 mm 0.6 mm 0.30 mm 0.12 0.06

7 7.00 mm 3.50 mm 1.40 mm 0.7 mm 0.35 mm 0.14 0.07

8 8.00 mm 4.00 mm 1.60 mm 0.8 mm 0.40 mm 0.16 0.08

9 9.00 mm 4.50 mm 1.80 mm 0.9 mm 0.45 mm 0.18 0.09

10 10.00 mm 5.00 mm 2.00 mm 1.0 mm 0.50 mm 0.20 0.10

11 11.00 mm 5.50 mm 2.20 mm 1.1 mm 0.55 mm 0.22 0.11

12 12.00 mm 6.00 mm 2.40 mm 1.2 mm 0.60 mm 0.24 0.12

13 13.00 mm 6.50 mm 2.60 mm 1.3 mm 0.65 mm 0.26 0.13

14 14.00 mm 7.00 mm 2.80 mm 1.4 mm 0.70 mm 0.28 0.14

15 15.00 mm 7.50 mm 3.00 mm 1.5 mm 0.75 mm 0.30 0.15

16 16.00 mm 8.00 mm 3.20 mm 1.6 mm 0.80 mm 0.32 0.16

* Para definir el espesor de cada línea según la escala, 
solamente se necesitó identificar el factor de aumento o 
reducción de la escala y teniendo este dato se procedió 
a realizar una regla de 3 iniciando siempre por los puntos 

definidos en la escala 1:100.

** En estos campos fue necesario dejar la misma dimensión de 
espesor de línea ya que Revit no permite un espesor menor a 
0.025mm debido a que este es demasiado pequeño y sería 
casi imperceptible.

Tabla 8 Manejo de espesores de líneas, configuración de puntos en Revit. Sugerencia de visualización para 
planificación a elaborar en formato A1. Por Melanie Orozco. Guatemala, Enero de 2020.

Por ejemplo, si se desea crear una línea de Contorno 
General que es de 0.8mm en un plano a escala 
1:200 se deberá utilizar un punto No. 16.

Otro ejemplo, es por si se deseara crear una línea 
de Proyección en un detalle a escala 1:50, ya que 
esta se elabora con punto 0.5mm, se deberá utilizar 
el punto No. 3, que es el que se asemeja a este 
espesor.



116

C O N F I G U R A C I Ó N  E L E M E N T O S  G R Á F I C O S

04.1.2 Configuración de Espesores de 
Línea

 Antes de proceder a configurar los tipos 
de líneas que se necesitan se deben configurar sus 
espesores dependiendo cada escala. Esto debido 
a que Revit mantiene las dimensiones que se le dan 
a los elementos del proyecto al inicio sin importar la 
escala, esto puede afectar al momento de utilizar 
una escala muy grande o muy pequeña y se estén 
utilizando los mismos espesores.

ESC. 1:50 ESC. 1:100 ESC. 1:200

En las imagenes se observa de forma clara el 
inconveniente de utilizar el mismo espesor de línea 
en diferentes escalas, por lo tanto se procederá 
a configurar estos espesores para que respondan 
según la escala que se está manejando.

Para esto es necesario que se realicen las 
configuraciones dentro de la ficha Manage > 
Additional Settings >  Line Weights.

Al dar click en esta opción aparecerá una ventana 
para configurar los espesores de líneas de Revit 
solicitando una medida de espesor en milímetros.
Para estas configuraciones se recomienda iniciar 
por la escala 1:100, que es la que representa los 
centímetros; en esta se colocarán los espesores 
de líneas en milímetros y según los puntos que se 
trabajan a mano.

Al terminar de configurar los espesores en escala 
1:100 se realiza una regla de 3 para definir el espesor 
de cada línea en todas las escalas restantes. 

CONFIGURACIÓN DE ESPESORES EN CADA 
ESCALA INICIANDO EN ESCALA 1:100

Por defecto, Revit coloca las escalas 1:10, 1:20, 
1:50, 1:100, 1:200 y 1:500 para proceder a su 
configuración pero es posible añadir escalas si hay 
alguna que se desee utilizar y no aparezca en esta 
ventana. Siempre se deben configurar los espesores 
de líneas en cada nueva escala que se agregue.
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AÑADIR NUEVA ESCALA

• CONTORNO PRINCIPAL, CONTORNO 
GENERAL Y PROYECCIÓN

Para este tipo de líneas, al no tener ningún patrón, 
solamente es necesario crear los tipos y asignar 
espesores dentro del proyecto.
Para esto se debe ir de nuevo a la ficha Manage > 
Additional Settings > Line Styles.

Al seleccionar la herramienta, aparecerá una 
ventana con los tipos de líneas creados en el 
proyecto, aquí aparecen algunos que Revit tiene 
en la plantilla por defecto.

En esta ventana se crearán los tipos de líneas que 
se necesitan. Para ordenarlos y clasificarlos se les 
puede colocar un prefijo para identificar cuáles 
están configurados para su uso específico. En este 
caso se le aplicará el prefijo “M_”.

Al crear este nuevo tipo, se procederá a configu-
rarlo agregando las características indicadas en la 
Tabla de Características de Líneas.

De la misma forma se crearán los otros 2 tipos de 
líneas restantes.
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• CORTE O SECIÓN

Debido a que esta línea necesita configurarse con 
distancias específicas para cada tramo, se proce-
derá a crear el tipo de línea para luego aplicar su 
espesor.

Para esto se utilizará la herramienta “Line Patterns” 
Ficha Manage > Additional Settings > Line 
Patterns.

Al entrar a esta herramienta, se abrirá una ventana 
de configuración. Dentro de esta  ventana, se creará 
el nuevo patrón de línea que se desea configurar 
dando click en el botón “nuevo”. Al hacer esto se 
abrirá una ventana en donde se colocará el nombre 
del tipo de línea y se aplicarán las dimensiones del 
esquema.

Se le dará click a “OK” y luego se procederá a 
crear el tipo de línea en “Line Styles” en donde, 
siguiendo las instrucciones indicadas para las 
líneas de contorno principal, se le aplicarán las 
características deseadas aplicando este patrón de 
línea que se acaba de crear.

El mismo procedimiento se seguirá para el resto de 
líneas que necesiten una configuración. Igualmente 
se deberá seguir el esquema de línea definido en la 
tabla de Características de Líneas.
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Igualmente se recomienda crear un tipo de línea 
para cada espesor, esto para auxiliarnos de todos 
los tipos al realizar la documentación del proyecto.

• LÍNEA GUÍA / PLANOS DE REFERENCIA

Para este tipo de línea no es necesario crear tipos 
adicionales o nuevos patrones de línea. Revit 
cuenta con su propio patrón de línea por defecto 
y este es funcional. 

La herramienta que se adapta a las condiciones 
de las líneas de guía es llamada “Reference Plane” 
(Combinación de teclas por defecto: RP). Con esta 
herramienta es posible trazar líneas o planos de 
referencia en donde se necesite auxiliarse de ellos en 
planta, sección o elevación y estos se representan 
en cualquier vista una vez se encuentren trazados 
perpendiculares a esta. 

Los planos de referencia, a pesar de existir en el 
modelo o vista, no se proyectarán en una impresión, 
estos no representan elementos de modelo o 
elementos gráficos, solamente sirven para auxiliarse.

Para las líneas de referencia, a pesar de contar ya 
con sus configuraciones, es posible crear diferentes 
tipos, esto si queremos definirlos según su uso 
(Referencias para columnas, muros, vigas, etc.).

Para crearlos, es necesario ubicarse en la ficha 
Manage > Object Styles > Annotation Objects.

Dentro de la ficha annotation se ubicarán los planos 
de referencia, se seleccionarán y bajo ese campo 
se creará una nueva subcategoría.
Siempre debe corroborarse que el nuevo tipo de 
línea se cree bajo la categoría correcta (Reference 
Planes).
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Al crear los diferentes tipos de planos de referencia 
se les configurará un color y un patrón de línea y se 
finalizará su edición quedando disponibles para su 
uso.

Al seleccionar la herramienta, se mostrará una 
ventana que consultará si se desea crear el polígono 
o línea basándose en coordenadas o realizando el 
sketch del polígono.

La forma de realización del polígono dependerá 
de si el modelador del proyecto cuenta con las 
coordenadas exactas del terreno. 

Regularmente el polígono de terreno y su derrotero 
lo proporciona el topógrafo encargado del 
levantamiento y hace entrega del mismo en un 
archivo CAD; de ser así, lo adecuado es solamente 
revisar que el polígono coincida con las dimensiones 
anotadas. 
Al corroborar que estas son las correctas, lo 
recomendable es insertar el archivo CAD como un 
link para luego crear el polígono mediante sketch y 
redibujarlo dentro del proyecto de Revit.

• LÍNEAS DE LÍMITES DE DISEÑO

Como fue indicado en anteriores capítulos, los límites 
de diseño consisten en las líneas que delimitan 
terreno, alineaciones, alturas máximas; en resumen, 
las que condicionarán el diseño del proyecto.

En algunas ocasiones estas son creadas con 
líneas de modelo o líneas de detalle agrupadas 
y aplicadas en cada vista; sin embargo la forma 
correcta de aplicar los límites de terreno es con la 
herramienta “Property Line”. 
Massing & Site > Modify Site > Property Line.

VENTANA DE INGRESO DE COORDENADAS 
PARA GENERAR POLÍGONOS

CREACIÓN DE POLÍGONO MEDIANTE SKETCH
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Cuando ya se cuente con estos polígonos y se 
haya corroborado su correcta ubicación dentro 
del proyecto, se procederá a configurar sus 
características de visualización.  

Debido a que las líneas de propiedad solamente 
tienen un tipo de boceto y la forma de modificar su 
visualización es por medio de filtros.

A continuación se explicará la forma de modificarlos 
en una vista.

1. Se seleccionará cada línea de propiedad 
y se le aplicará un texto característico 
en algún campo al que no se le de uso. 
En este caso, se aplicó el texto en el campo 
de “Comentario”, este campo es de instancia 
(esto significa que, lo que sea que se escriba en 
este espacio solamente se aplicará al objeto 
seleccionado), por lo tanto no afectará al resto 
de líneas de propiedad en el proyecto.

2. Al aplicar el comentario a cada línea, es 
necesario dirigirse a visualización de gráficos 
(teclas de acceso rápido “VG”) o dentro de las 
configuraciones de plantilla de vista, y colocarse en 
la ficha “Filtros”.
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3. Dentro de esta ventana se procederá a añadir 
un filtro nuevo. Al ingresar a esta opción se abrirán 
varias ventanas emergentes que apoyarán en la 
realización del filtro.  En el ejemplo se creará el filtro 
para el Polígono del terreno.

4. Al crear el nuevo filtro, se configurarán las 
condiciones bajo las que trabajará. Como ya se 
conoce, este filtro se debe aplicar bajo “Property 
Lines”, que pertenecen a la categoría “Site”. Luego 
se procederá a aplicar la regla de funcionamiento 
del filtro. 

A. B.
C.

A.   Se selecciona 
el filtro a aplicar.

B. Se selecciona la 
categoría a la que se 
aplicará el filtro.



123

C O N F I G U R A C I Ó N  E L E M E N T O S  G R Á F I C O S

C. Se aplicarán las condiciones de aplicación 
del filtro. Se seleccionará el campo que 
se rellenó con el texto del polígono y se le 
colocará la condicion que este debe seguir, 
si este debe ser exactamente igual, iniciar con, 
terminar con, etc. Dentro de estas condiciones 
hay varias opciones a aplicar, se escogerá la 
opción que más convenga.

5. Cuando ya estén aplicadas estas modificaciones 
se procederá a cargar el filtro dentro de la vista.

6. Al cargar el filtro se procede a dar 
características de visualización.

7. Al finalizar las ediciones se finaliza dando 
click en “OK” y el filtro se aplica solamente a la 
Property Line que cuenta con las características 
que condicionan la aplicación del filtro.

8. El mismo procedimiento se debe aplicar para 
cada línea de propiedad.
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• LÍNEAS DE RUPTURA

Este tipo de líneas se utiliza frecuentemente en 
planificaciones para visualización de detalles. 
Debido a esto se definirán las dimensiones de este 
tipo de línea según la escala.

Este tipo de elemento es posible crearlo con una 
familia de componente de anotación o bien, es 
posible dibujarlo con una “Masking Region”. De 
cualquiera de las dos formas es funcional.

Dimensiones de Líneas de Ruptura según Escala
Escala de 

Dibujo
Dimensiones de Ruptura

Escala de 
Dibujo

Dimensiones de Ruptura

1:25 1:200

1:50 1:500

1:100 1:1000

Tabla 9 Manejo de dimensiones de líneas de ruptura según escala. Sugerencia de visualización para planificación 
a elaborar en formato A1. Por Melanie Orozco. Guatemala, Enero de 2020.
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• DIMENSIONES O COTAS

Como inicio se definirán las dimensiones de texto 
permitidas para su uso según el dibujo técnico.

Para este tipo de elemento es necesario hacer 
uso de la herramienta “Dimension” en Revit, este 
requiere algunas configuraciones para que funcione 
adecuadamente o que presente las características 
que se necesitan.

Para este ejemplo se realizará un estilo de cota 
(Punto como punta de cota) en dos diferentes 
dimensiones de cota (2.5mm y 1.5mm) .
En primer lugar es necesario definir los tipos en la 
ficha Annotate > Dimension > menú desplegable.

Dentro de la plantilla por defecto que presenta 
Revit, se muestran distintos tipos de cotas; es posible 
tomar una de estas como base para poder crear 
la que se necesita. Se procederá a crear una cota 
con texto de 2.5mm Arial y puntos como flecha de 
cota. 

Características de Texto

Tipo Características Visualización

Título

Tamaño: 10mm 
Negrilla
Fuente: A definir 
por usuario
Color: A definir 
por usuario

Subtítulo

Tamaño: 5mm
Fuente: A definir 
por usuario
Color: A definir 
por usuario

Contenido

Tamaño: 2.5mm
Fuente: A definir 
por usuario
Color: A definir 
por usuario

Notas en 
Vista

Tamaño: 1.5mm, 
2mm o 2.5mm
Fuente: A definir 
por usuario
Color: A definir 
por usuario
Este tipo de 
texto puede 
tener negrilla o 
subrayado, todo 
depende del uso 
que se le desee 
dar en vista.

Tabla 9 Manejo de dimensiones y textos. Sugerencia de 
visualización para planificación a elaborar en formato 
A1. Por Melanie Orozco. Guatemala, Enero de 2020.
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Al crear el tipo de cota se procederá a realizar 
las configuraciones dentro de las propiedades de 
tipo. A esta cota se le modificaron las distancias de 
extensión de líneas, punto de 1mm como flecha de 
cota, aplicación de línea de origen de texto, etc. 
Igualmente se le modificó la el tamaño de texto, que 
en este caso sería de 2mm, distancia desde la cota. 
y el número de decimales a aplicar.

En el caso del número de decimales, se recomienda 
siempre el uso de dos decimales para que haya más 
exactitud en la indicación de medida. Más de estos 
decimales solamente se utiliza en caso se quiera 
dar una coordenada o la altura de MSNM (Metros 
sobre el nivel del mar) ya que para estas se necesita 
mayor exactitud.

Al finalizar las configuraciones, la cota quedaría de 
esta forma:

De la misma forma se realizarán los demás tipos de 
cotas.

Hay algunas ocasiones en donde se necesita 
acotar un espacio muy pequeño a una escala 
mayor; como en el siguiente ejemplo donde se trata 
de acotar una distancia de 0.15m (ej. espesor de 
muros) a escala 1:125: 

Como es posible ver, los puntos y el texto que 
indica la distancia, quedan demasiado grandes a 
comparación de el objeto a acotar. Para esto se 
creará una nueva cota con nuevo tipo de flecha 
debido a que revit solamente cuenta con un tipo 
de punto rellenado de 3mm.
Es necesario dirigirse a la ficha Manage > 
Additional Settings > Arrowheads.
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Al seleccionar esta herramienta, se mostrará una 
ventana de propiedades de tipo. En esta es posible 
visualizar diferentes tipos de flecha en donde se 
seleccionará la que más se adapte a la que se 
necesita.

En este caso seleccionaremos la opción de punto 
rellenado de 3mm. Se duplicará este tipo aplicando 
las características nuevas.

Al crear este nuevo punto, se procederá a crear el 
nuevo tipo de cota, para esta se necesita que el 
texto sea con un mínimo de 1.5mm de altura, que es 
lo que aún puede ser legible de forma impresa.
Se procede a realizar las configuraciones y se 
finaliza la edición.

Con esto ya es posible tener otro tipo de cota 
que se adapta a las dimensiones del objeto que 
se necesita acotar. Siguiendo estas instrucciones es 
posible obtener el siguiente resultado:

Como se visualiza, es el mismo objeto, mismo 
tamaño y mismo estilo de cota pero con diferentes 
dimensiones de texto y diferentes dimensiones de 
punto de cota. 

Para un proyecto, es mejor definir un estilo de cota 
para su uso en todos los tipos de plano, esto 
para conservar una línea gráfica en el mismo y no 
confundir a los lectores de cada plano.  Igualmente 
es necesario crear cotas del mismo estilo en 
diferentes dimensiones (como lo aplicado en el 
ejemplo anterior) para que se puedan aplicar según 
la escala de las vistas.



128

C O N F I G U R A C I Ó N  E L E M E N T O S  G R Á F I C O S

• MOBILIARIO Y VEGETACIÓN

 A lo largo del tiempo que se ha utilizado Revit 
en la facultad, los alumnos creen que lo adecuado, 
al hablar de plantas amuebladas y con vegetación, 
es utilizar ambientación en 3D; sin embargo lo más 
recomendable es el uso de familias en 2D. Esto 
debido a que al utilizar familias modeladas, el 
proyecto se vuelve más cargado, esto significa 
retraso al generar información e inversión de tiempo 
en ocultar o mostrar detalles de modelado que son 
innecesarios para dar a conocer el proyecto.

Además de todos estos inconvenientes también 
es posible encontrarse con que la biblioteca de 
familias en Revit es demasiado escasa o que la 
mayoría de familias que se encuentran y que tienen 
la representacón correcta y el modelado correcto 
son objetos por los que se debe pagar. 
Por esta razón es más sencillo lograr una biblioteca 
de bloques de AutoCAD con una gran cantidad 
de mobiliario y luego convertir estos bloques en 
familias 2D de Revit.

El uso de familias en 2D es restringido 
solamente para mobiliario y vegetación, esto 
porque es posible reemplazarlo por modelos 
3D en Lumion o montajes en Photoshop, que 
son los programas para producción de 
render y postproducción. 
Igualmente si se necesitan planos de 
mobiliario o detalles de muebles de 
carpintería, lo mejor es crear las familias en 
3D para generar los planos, pero aún así, lo 
mejor es mantener estas familias modeladas 
solamente si es necesario.

NOTA

En el siguiente ejemplo se procederá a realizar una 
familia sencilla de representación 2D para un árbol. 
Estas son familias complicadas de encontrar en 
Revit pero un poco más sencillas de encontrar para 
bloques de AutoCAD.

El bloque a utilizar es el siguiente:

Este bloque se trasladará a un archivo nuevo, 
después de esto se verificará la medida del bloque 
en CAD para corroborar el diámetro de la copa del 
árbol y adaptarlo, si es necesario, a las dimensiones 
que se desean.
Al finalizar, el bloque se explotará y todas las líneas 
que pertenecían al mismo deberán ubicarse en 
una misma capa y al finalizar esta modificación el 
archivo se purgará para evitar elementos extra en 
el modelo.
Al finalizar, se guardará el archivo preparándolo 
para insertar en el archivo RVT.
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En Revit, se procederá a crear una familia con las 
plantillas por default que presenta el software, aquí 
se seleccionará la categoría que corresponde al 

Cuando ya se esté en la edición de la familia se 
procederá a aplicar las unidades que se deseen 
dentro de la familia, en este ejemplo las unidades 
se configurarán en metros. Después de esto se 
procederá a insertar el archivo CAD al archivo RFA.

objeto a crear. En este caso se utilizará la plantilla 
de “Vegetación Métrica” ubicada en la librería 
“Spanish”.

Para esto se seleccionará la herramienta importar 
ubicada en la ficha “Insert” > Import CAD.
Las configuraciones en este caso serán como se 
muestra en la imagen:
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Al corroborar que los datos estén correctos, se 
dará click en “Open” y con eso el archivo quedará 
insertado.

Cuando se siga este procedimiento no se 
recomienda el uso de bloques demasiado 
saturados, ya que estos pueden llegar a 
complicar el proceso de creación de la 
familia y es posible que si se trata de realizar, 
el programa falle o se tarde demasiado 
en generar los tipos de líneas de Revit 
(procedimiento que se verá a continuación).

NOTA

Después de este proceso se debe corroborar que 
el archivo se haya insertado correctamente y con las 
dimensiones que se necesitan. Cuando se cumpla 
con estas condiciones, se procederá a explotar 
el archivo dentro de la familia. Este procedimiento 
puede demorarse dependiendo de la complejidad 
del bloque.

El objetivo de esto es hacer que el archivo CAD 
con el árbol convierta sus líneas o trazos en líneas 
de Revit, esto para que Revit lo pueda clasificar en 
el tipo de familia adecuado cuando se coloque 
dentro de un proyecto.

Cuando complete el procedimiento, se deben 
seleccionar todas las líneas que corresponden al 
árbol y se convertirán en línes simbolicas con la 
herramienta “Convert Lines”, esto para evitar que 
las líneas sean de modelo y aparezcan en vistas 
donde no se deseen ver. 
Este procedimiento igual puede tomar un poco de 
tiempo, como se dijo anteriormente, todo depende 
de la complejidad del bloque.

Luego de esto, todas estas líneas se colocarán en la 
subcategoría “Planting” que es donde corresponden. 
Cada familia tiene su propia categoría para asignar 
los elementos de detalle, esta deberá aparecer por 
defecto dentro de este menú desplegable.
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Al terminar estas configuraciones en la familia se 
procedera a colocarle una máscara. Esto para 
que el objeto no aparezca transparente dentro del 
proyecto.
Para esto deberemos utilizar la herramienta Masking 
Region. Annotate > Detail > Masking Region.

Para crear esta máscara, es posible redibujar el 
objeto, o bien, copiar algunos trazos de la misma 
familia dentro del boceto de la máscara.
Se debe corroborar que este boceto siempre siga 
perteneciendo a la categoría de la familia.

Cuando se finalice la edición se procederá a 
guardar la familia y cargarla al proyecto.
Ficha Insert > Family Editor > Load into Project.

Cuando esta ya aparezca en el proyecto, al 
seleccionarla, se podrá ver que pertenece a la 
categoría “Planting” que es la correspondiente para 
clasificar cualquier elemento de vegetación.

A esta familia, al igual que una familia 3D será 
posible ubicarla en un nivel, agregarle una distancia 
de elevación y agregar parámetros de clasificación 
por instancia y tipo en caso se necesite optar por 
estas opciones.

Como fue posible observar, hay diferentes 
metodologías para obtener objetos de visualización 
para los planos que lo necesitan. Algunas veces 
es cuestión de conocer las herramientas y saber 
su función para poder utilizarlas en beneficio del 
usuario.
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• RECOMENDACIONES PREVIAS A INICIAR 
LA PLANIFICACIÓN DEL PROYECTO

En el siguiente capítulo se procederá a dar un 
ejemplo de plano elaborado en Revit y se explicará 
su proceso. 
No se recomienda copiar los estilos y diagramaciones 
observadas. Es necesario que como profesional 
la persona ya comience a definir una forma de 
trabajar y realice sus propios machotes utilizando 
las herramientas que se explicarán en las siguientes 
páginas.

Se realizó un solo ejemplo para cada plano, el 
lector de este documento debe saber que cada 
ejemplo puede ser trabajado según el número de 
plantas que tiene el proyecto o según el número de 
detalles que apliquen. 
Para algunos planos del apartado de planificación, 
se trabajó el nivel típico de este proyecto que 
corresponde a los niveles 03 al 12 de este Edificio 
de Apartamentos.

Antes de iniciar con la planificación en el proyecto, 
se dan las siguientes recomendaciones:

1. - Es importante que en el modelo se conserven 
vistas de cada nivel típico donde se puedan 
observar todas las elevaciones, secciones, líneas 
de referencia y todos los llamados a detalle; esto 
es porque al comenzar a utilizar plantillas, siempre se 
pierden algunos elementos de anotación. El objetivo 
de estas vistas es que se puedan encontrar todos 
los elementos de vista creados en el proyecto, a 
estas les llamaremos Vistas de Trabajo en este 
documento. Ejemplo de vista de Nivel 03:

2. - Es importante mantener un orden en el 
nombramiento de vistas, es más fácil encontrarlas 
en donde se conserva un prefijo o nombramiento 
clave, que realizar la búsqueda bajo niveles que 
se nombren como “Copy 1, Copy 2, Copy 3”. Esto 
no sólo es para que el navegador de proyectos 
se vea ordenado, sino para facilitar la localización 
de información. Con esto es posible tener un 
esquema de nombramiento ya sea bajo la Guía 
de Aplicación de Estándares BIM o bien, sobre 
un nombramiento personal donde se pueda iniciar 
con el concepto de la guía. Por ejemplo, para la 
elaboración de este documento se antepuso la 
palabra “TESIS” seguida de un guión bajo (_) 
para identificar las vistas utilizadas en hojas:
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04.2. ANTEPROYECTO – PROCESO PLANOS DE PRESENTACIÓN

Se hace la aclaración que estos ejemplos son para una planificación de anteproyecto. Si se desea 
realizar una entrega de láminas de presentación, siempre hay programas adicionales a Revit con los que 
es posible auxiliarse; es posible generar información inicial desde este programa pero es importante resaltar 
que este es un programa de información técnica; para tener un mejor resultado en generación de láminas 
se recomiendan softwares que son desarrollados e implementados para esta tarea.

En planos de anteproyecto se dará una información básica del proyecto utilizando colores y la mayor 
cantidad de ambientación posible para aclarar el tema del diseño y su funcionamiento.

El listado de planos a trabajar en este capítulo es el siguiente:

1. Planta de Conjunto
2. Planta Arquitectónica
3. Elevaciones
4. Secciones
5. Visualización

04.2.1 Planta de Conjunto

Para este tipo de planta se debe crear una vista en:
Ficha View > Plan Views > Floor Plan > Nivel 01 
Según el concepto de esta planta es necesario visualizar desde las calles de acceso del proyecto hasta 
el último nivel del mismo. Para esto se configurará el rango de vista como se observa en la imagen:

  

Nivel de Calle

Nivel de Techos
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Al tener la planta es necesario configurar su visualización para que represente lo que se necesita. Para 
esta planta solamente se apagarán los Reference Planes, Símbolos de elevaciones y símbolos de 
secciones.
Para la vista se configurará el estilo de vista Shaded y se aplicarán los filtros de Property Lines creados al en 
el capítulo 4.1.2 Configuración de Espesores de Línea > LÍNEAS LÍMITE DE DISEÑO.

Después la vista se insertará en el plano y se configurará el recorte de vista, ejes y escala a utilizar. Para el 
ejemplo se aplicó la escala 1:200.

Para dar profundidad a la vista se recomienda aplicar Halftone a los elementos que se encuentran más lejos, 
esto es posible lograrlo de dos formas:

• Seleccionando cada elemento y sobreescribiendo sus gráficos en vista. Seleccionar elemento > Click 
derecho > Override Graphics in View > Halftone.
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O bien, dibujar una Masking Region en donde se encuentran los elementos más lejanos de la vista y aplicar 
una transparencia a los mismos.  Seleccionar elemento > Click derecho > Override Graphics in View > 
Transparency 50%.

Luego se añadirán a la vista los siguientes elementos de anotación:
• Ingresos
• Nombres de calles
• Cotas totales a ejes
• Cotas de anchos de calle
• Niveles NPT
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En este plano es posible aplicar sombras para mejor interpretación de la altura de volúmenes del edificio. 
Su uso queda a criterio de la persona que está realizando el plano, sin embargo en este tipo de plano la 
proyección de sombras ayuda a que se tenga mejor comprensión de los elementos que están en primer, 
segundo y tercer plano. Esta herramienta se encuentra en:
Barra de controles de vista > Sombras
Y su intensidad se puede regular en:
Barra de controles de vista > Graphic Display Options > Lighting > Shadows
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Al finalizar las configuraciones deseadas, se recuerda crear la leyenda de Simbología con la ayuda de la 
Herramienta Leyenda e insertar al plano.
View > Legends > Legend.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.2.2 Planta de Arquitectura

Para este tipo de plano se creará una vista del nivel que se quiere documentar, en este caso será el Nivel 
03.
Ficha View > Plan Views > Floor Plan > Nivel 03.
Al crearla, esta se configurará para que oculte los elementos de anotación sobrantes, para este ejemplo se 
ocultaron Reference Planes, símbolos de elevación y símbolos de sección.
Para el estilo visual de la planta se mantendrá el tipo Shaded, se mantendrá una escala 1:125 y se 
aplicarán los filtros de Property Lines creados al en el capítulo 4.1.2 Configuración de Espesores de Línea 
> LÍNEAS LÍMITE DE DISEÑO.

Para poder etiquetar los ambientes, es necesario ubicar elementos de habitación. Ficha Architecture > 
Room & Area > Room.

Algunas veces las habitaciones no se encuentran completamente cerradas o son áreas abiertas (Ej. ambientes 
donde la sala, comedor y cocina se encuentran juntos), en este caso se debe utilizar la herramienta Room 
Separator. Ficha Architecture > Room & Area > Room Separator.
Ejemplo:

Área cerrada
Área con Room 
Separator

Separación 
Habitación
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Después de haber colocado los elementos de Habitación en la vista, se procederá a añadir las anotaciones 
restantes:
• Cotas parciales y totales a ejes
• Cotas relevantes (en este caso se acotó la distancia entre el edificio y la alineación municipal)
• Indicación de Ingresos a apartamentos
• Ambientación (arbustos en balcones)

En este plano es posible aplicar sombras para mejor interpretación de la altura de muros y del volumen. Su 
uso queda a criterio de la persona que está realizando el plano. Esta herramienta se encuentra en:
Barra de controles de vista > Sombras
Y su intensidad se puede regular en:
Barra de controles de vista > Graphic Display Options > Lighting > Shadows
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Para este ejemplo, se desactivará la opción de mostrar sombras.

Al finalizar, esta planta se insertará en el plano u hoja destinada para presentación y se aplicará una 
simbología de plano con la ayuda de la herramienta Leyenda.
View > Legends > Legend.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.2.3 Elevaciones

Para crear las elevaciones que se necesitan, es necesario ubicarse en una planta de nivel 1 o de conjunto. 
Después de esto nos dirigiremos a la ficha Vista > Elevation.
 

       
Al tener seleccionada la herramienta, se procederá a crear la elevación en donde se considere conveniente. 
En este caso realizaremos una vista de la Elevación Oeste. 

  

Al haber creado la elevación, se procederá a configurar el alcance de la vista, esto es porque al crearla se 
mantiene una distancia colocada por defecto y puede que esta no cubra a cabalidad lo que se desee 
observar. Esta configuración se encuentra en la Paleta de Propiedades y se deberá manejar con algunos 
pasos:

1. Paleta de Propiedades > Extents > Far Clipping.
2. Configurar Clip with Line (Delimitación con Línea). 
3. Configurar el Far Clip Offset (Desfase de Delimitación Lejano) con la dimensión en metros a la que 
queremos que la elevación alcance a cubrir. En el caso de esta vista, se configurará para que tenga un 
alcance de 40.00m desde donde se creó la elevación. 
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Cuando se hayan configurado los pasos anteriores, se iniciará con las configuraciones de la vista, se 
procederá a apagar los elementos de modelo y de anotación que no son necesarios. Para esto utilizamos el 
comando VG (Visualización de Gráficos) y apagaremos lo que se necesite en las fichas que allí se muestran. 
En estas es posible apagar también archivos de AutoCAD que hayan auxiliado durante el desarrollo del 
proyecto.

También es posible configurar los estilos de visualización, para esta vista se utilizará de ejemplo el estilo 
Consistent Colors.

VENTANA DE VISUALIZACIÓN DE GRÁFICOS

40.00m

Inicio de Elevación

Delimitación de Vista
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Con esto la vista se modifica en varios aspectos y se comienza a ver el cambio desde una vista solamente 
generada en Revit a una vista trabajada con las herramientas de visualización que el programa ofrece, esta 
configuración no toma demasiado tiempo.

El siguiente paso es configurar la representación de los niveles.
Seleccionar uno de los niveles > Panel de propiedades > Editar tipo. 
Dentro de este buscar el campo Line Pattern, allí seleccionar un tipo de línea discontinua, en este caso se 
utilizó M_Discontinua 0.2. 
En la configuración también se le puede asignar un color, a esta le aplicamos el color RGB 128-128-128 
(Gris Oscuro) para que no resalte en el dibujo.

VISTA POR DEFECTO VISTA UTILIZANDO HERRAMIENTAS
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Al configurar esto, se procederá a agregarle la escala al dibujo, este deberá ser preferiblemente a la misma 
escala a la que se manejan las plantas. En este caso se utiliza la 1:125.
Otro de los puntos a considerar es que las elevaciones solo deberían mostrar la elevación del edificio sin 
mostrar ningún elemento bajo tierra.

Para solucionar este inconveniente se creará una región de relleno en la que se configurará la representación 
de “tierra” para que se vea como un pequeño corte del terreno. 
Annotate > Grupo “Detail” > Region > Filled Region > dibujar polígono.

            

Al dibujar el polígono, es necesario que se inicien las configuraciones dentro de la hoja, entre estas 
configuraciones está el recorte de vista, este se debe aplicar según el espacio disponible dentro de esta.

 

Elementos 
bajo tierra
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Después de configurar el recorte se configurará la profundidad de vista. Este ajuste se realiza con la 
herramienta “Depth Cueing” (Atenuación Lejana).
Barra de Controles de Vista > Visual Style > Graphic Display Options > Depth Cueing.

 

Otro de los puntos a chequear es que los objetos se representen con el espesor de línea adecuado según 
el plano en el que se encuentren. 
Para esto se utilizará la herramienta “Linework” (Tipo de Línea, comando LW), esta herramienta permite 
cambiar los espesores de línea de los elementos de modelo solamente en la vista donde se esté aplicando. 
Ficha Modify > View > Linework > Seleccionar tipo de línea > Click en el objeto o trazo a cambiar.

  

Como se puede observar en el ejemplo, los elementos de balcones pasan de simples líneas delgadas a 
líneas que representan un plano en la vista.
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Después de esto, se procederá a colocar elementos de entorno, como por ejemplo, vegetación y figura 
humana. Otros elementos a colocar serán las líneas que representen límites de altura y textos complementarios 
para indicación de estas proyecciones.

        

Para que la vista se complemente, se procederá a activar las sombras.
Barra de controles de vista > Shadows.

 
También se le colocará un fondo con color para representación del cielo. 
Barra de controles de vista > Graphic Display Options... > Background. En esta vista se utilizaron los 
siguientes colores:

       

COLOCACIÓN DE 
ELEMENTOS DE ENTORNO

PROYECCIONES 
DE LÍMITES DE 
DISEÑO
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Al finalizar se creará la simbología de plano. Para esto es necesario se creará una leyenda. 
Ficha View > Create > Legends > Legend. 

   
Al finalizar, se colocará en el plano y con esto concluimos nuestro plano de Elevación Oeste.

PLANO 
FINALIZADO

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.2.4 Secciones

Para crear estas vistas, al igual que las elevaciones, es necesario posicionarse en una vista de nivel 1 o una 
planta de conjunto. La herramienta se encuentra en la ficha View > Create > Section.

 

NOTA

Es importante que se tenga un claro 
concepto del uso de una sección, esta 
no es solo para visualizar muebles, es 
para que el interesado pueda ver puntos 
importantes de su proyecto, cumplimiento 
de normativas o simplemente geometrías 
varias de la edificación.

Al tener preparada la sección, se procederá a 
ingresar a la vista y realizar configuraciones similares 
a las observadas en la elevación. 

Además de esto, también se deberán configurar 
los filtros de vista para cortes de muros y elementos 
estructurales.

Visibility Graphic > Filter > Add > Filtros creados 
para representación de muros del modelo.
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Al configurar la visualización, procederemos a colocar la escala, al igual que las elevaciones, es más 
conveniente que esta se encuentre a la misma escala que las plantas, pero si a esta no cabe en el plano, 
es posible realizar un cambio. En esta vista se dejará a escala 1:125.

El siguiente paso será agregar sombras para darle profundidad al dibujo. 
Barra de Configuración de vista > Sombras.

A diferencia de las elevaciones, en esta vista si se puede visualizar una porción más grande de tierra, para 
esto igualmente se añadirán regiones rellenadas y líneas de ruptura para representación del corte de tierra.
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Luego de esto, se procederá a agregar elementos de anotación como textos de ambientes, cotas y niveles.  
Las cotas deben indicar puntos de interés, como por ejemplo, la dimensión que queda entre cielo falso 
y losas y vigas, porque de esto depende la colocación de instalaciones en el edificio.

Para esta vista igualmente se colocará la configuración de cielo (fondo) aplicada a la elevación. 
Barra de configuración de vista > Visual Style > Graphic Display Options... > Background.

CIELO FALSO

TIERRA + LÍNEA 
DE RUPTURA

CIELO FALSO

CIELO FALSO
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Además de configurar el cielo, al igual que la elevación, la sección necesita representar correctamente las 
profundidades de vista. Barra de configuración de vista > Visual Style > Graphic Display Options... > 
Depth Cueing.

      

  

NOTA

Para las secciones, algunos estudiantes 
solamente representan los elementos de 
la estructura como líneas, por ejemplo: las 
losas o voladizos utilizados en el diseño 
arquitectónico.
Es importante conocer los espesores de 
la losa que se maneja y demás elementos 
estructurales principales (columnas y vigas) 
para validez del proyecto.

LOSAS DEPRIMIDAS

VIGAS

LOSAS PARAPETOS
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En esta sección igualmente se añadirán los elementos de anotación para enriquecer la expresión gráfica, 
como proyecciones de límites de altura, perfiles naturales de terreno, notas importantes del proyecto y cotas. 
Igualmente añadiremos elementos de entorno como figura humana y vegetación.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.2.5 Visualización

Este plano es solamente para incluir algún tipo de visualización que explique la geometría del edificio. Es 
importante incluir estas imágenes para aclarar algunos puntos que se vieron en las vistas 2D, se hace la 
observación que este plano no reemplaza una lámina de presentación, este es solamente para dar a 
entender la idea del proyecto en obra.

Para añadirlas es necesario insertarlas en Drafting Views para que al insertar las vistas en el plano, estas se 
ubiquen con un título al pie de la imágen y que se puedan encontrar dentro del navegador del proyecto. 
View > Create > Legends > Legend. 

              
Al crearla, se procederá a cargar la imagen en la ficha Insert > Import > Image. 
Para mejor gestión de la información se recomienda nombrar a la imagen de la misma forma con la que 
se nombró a la leyenda dentro del proyecto o viceversa ya que algunas veces es necesario realizar 
actualizaciones de imágenes dentro de Revit y es casi imposible encontrar la indicada cuando ya se 
cuenta con un extenso banco de imágenes.
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Para este ejemplo se insertarán 3 imágenes más una planta de ubicación, por lo tanto será necesario 
reducir sus dimensiones. Para esto se modificarán sus medidas en la paleta de propiedades a 35 cm 
de ancho. Es necesario asegurarse que  la opción de “Lock Proportions” (Bloquear proporciones) se 
encuentre siempre activa, con esto la imagen evitará deformarse.

Al modificar las dimensiones e insertar los 3 renders, se procederá a ordenar las imágenes de acuerdo con 
una grilla, para esto acudiremos a View > Sheet Composition > Guide Grid. 

           

SIEMPRE DEBE 
ESTAR ACTIVO
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Al crearla, posicionarse en la hoja a la que se le quiere aplicar > Paleta de propiedades > Other > 
Guide Grid > Seleccionar la grilla recién creada.

Para esta grilla, Revit asigna un espaciado de 25.00 mm pero es posible modificarlo en la Paleta de 
propiedades > Guide Spacing.

Al ordenar todos los elementos como los necesitamos, se procederá a ocultar el Guide Grid, si se deja 
activo este elemento no se verá al imprimir, pero puede ser un poco incómodo cuando se desee insertar 
más elementos a la hoja. Para ocultarlo se pueden aplicar dos formas:

1. Desasignando el Guide Grid de VISUALIZACIÓN en la paleta de propiedades.
2. Ocultando el Guide Grid en vista (Lo más recomendable).

Para el ejemplo de las imágenes se aplicó la opción 2, como se puede ver, aunque la grilla se encuentre 
apagada, esta aún aparece asignada a la vista. 

    

LA PALETA DE PROPIEDADES 
PERMITE VER EL GUIDE GRID 
UTILIZADO EN LA HOJA AUNQUE 
ESTE SE ENCUENTRE APAGADO.
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Al finalizar, se debe crear una pequeña planta de 
ubicación de vistas, esto se hará con una planta 
de conjunto a una escala 1:500.
Esta, al ser una planta que no debe representar 
más que la ubicación de las vistas, solamente se le 
dejarán los ejes principales; debido a la escala a la 
que se encuentra.

Para poder resaltar de donde se originan las vistas, en este caso se procederá a insertar una imagen PNG 
de una cámara. Cuando ya se tenga seleccionada la imagen que deseamos colocar, debemos dirigirnos 
a Insert > Import > Image.

      
Se procederá a chequear que todo se encuentre como se necesita y con lo aprendido tendremos el plano 
finalizado.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3. PROYECTO – PROCESO PLANOS CONSTRUCTIVOS (ARQUITECTURA)

Para este tipo de planificación, algunas veces se cree que por ser información técnica no se debe enriquecer 
tanto en expresión gráfica, pero es al contrario. La riqueza en la expresión gráfica en estos planos permite 
una claridad de información en obra, con eso se garantiza una correcta construcción del proyecto.
Si hay un exceso de información o la información es escasa, esto puede traducirse en errores en obra.

Debido a todas estas razones, es necesario explicar la realización de un pequeño y básico juego de planos 
constructivos de arquitectura. Con estos, el lector podrá desenvolverse un poco más en sus proyectos 
personales y desarrollar su habilidad en la expresión gráfica de sus planos.
Para este capítulo se trabajará el siguiente listado de planos de un nivel típico:

1. Planto Matriz o Machote Nivel 03-12
2. Plano de localización de proyecto
3. Plano de ubicación de proyecto
4. Planta de Conjunto 
5. Planta de Arquitectura Nivel 03-12
6. Planta Acotada Nivel 03-12
7. Planta de Acabados Nivel 03-12
8. Planta de Tipos de Puertas y Ventanas Nivel 03-12
9. Elevaciones
10. Secciones
11. Detalles de Puertas y Ventanas
12. Detalles de Gradas y Rampas
13. Planta de Cargas de Ocupación
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04.3.1 Plano Matriz (Machote)

Se creará una vista del nivel típico 03 (Nivel 03-12). Ya que esta vista no contiene ninguna plantilla, es 
posible duplicar una existente e iniciar las configuraciones desde allí o iniciar una nueva plantilla. 
Esto se realiza en la paleta de propiedades > Identity Data > View Template. 

Esta vista necesita representar solamente la geometría importante de las plantas ya que es la información 
que servirá para plantear instalaciones. La configuración de visualización de gráficos deberá responder a 
lo indicado a continuación (enlistando lo planteado en el capítulo 3.1.3 de este documento): 

Plano Matriz (Machote)

Norte

Ejes

Bloques (Geometría principal del 
proyecto)

Caminamientos

Cotas relevantes (Anchos de calles, vías y 
caminamientos)

Cotas totales y parciales a ejes

Indicación de ingresos principales

Límites de Fase (si aplica)

Mobiliario Fijo y Urbano (si aplica)

Niveles NPT y MSNM en caminamientos, 
plazas, espacios de estacionamiento, 
ingreso de bloques

Nombre de calles y vías de acceso

Proyección de Restricciones Municipales 
(polígonos de terreno, alineaciones)

Proyección de Restricciones de Incentivos 
(si aplica)

Simbología de plano

Vehículos no detallados (para indicar 
cumplimiento de radios de giro)
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Algo que también es importante en estas plantas es representar correctamente la ubicación de ventanas 
y puertas. Uno de los errores recurrentes en Revit es que, debido al rango de vista general que se debe 
manejar, algunas ventanas altas de servicios sanitarios quedan sin visualizarse.

Para este tipo de inconvenientes es necesario utilizar la herramienta “Plan Region”. Se realizará un ejemplo 
tomando una ventana del servicio sanitario de uno de los apartamentos.
En este sanitario se encuentra una ventana de 0.40 x 0.60m con un sillar de 2.00m, el rango de vista de la 
planta se ubica de 1.20m a 2.00m por lo tanto la ventana no se proyectará en la vista y se percibe como 
si no se hubiera considerado alguna para ese ambiente.

SIN VENTANA
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La herramienta a utilizar se encuentra en la ficha View > Create > Plan Views > Plan Region. Al seleccionarla, 
Revit pasará al modo edición de polígonos y se deberá crear un recuadro que ocupe el espacio de la 
ventana y un poco más, si este es un poco más pequeño que la ventana, no la leerá y no se tendrá ningún 
resultado.

      

Al tener dibujado el polígono, se configurará el rango de vista de esta región de plano dentro de la paleta 
de propiedades. Allí se configurará una altura de corte con una mayor altura (definido por el sillar de la 
ventana).
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Después de esta edición es necesario ocultar este tipo de elementos en Visualización de Gráficos > 
Annotation Categories > Plan Region (al apagarlo no se elimina la edición en la planta). 

   

En este plano también se deben reflejar los límites de terreno, con esto cada experto en instalaciones o 
estructuras podrá saber hasta donde ubicar accesorios o tuberías para uso del proyecto. Configurar en:
Visibility Graphic Overrides > Filters >  Crear o Seleccionar Filtro para cada Property Line.
(Ver modificaciones en inciso 04.1 Elementos de Expresión Gráfica - Configuración de Elementos).

Y con esto quedaría finalizada la planta de Machote.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3.2 Plano de Localización

En este tipo de plano es necesario mostrar a una escala bastante amplia, las vías de circulación y los 
posibles accesos hacia el proyecto tomando en cuenta las principales calles de la ciudad.
Para este es necesario cargar un formato en tamaño oficio.

Se procederá a la creación de la vista en donde se ubicará el terreno del proyecto dentro de las calles de 
la ciudad, para esto será necesario importar un archivo CAD de la zona donde se encuentra el proyecto 
con el que se pueda apreciar la traza urbana, este se insertará dentro de una vista Drafting View. Este tipo 
de vista se puede encontrar en la ficha View > Create > Drafting View.

Si no se cuenta con un archivo CAD es posible dibujar esta traza con Detail Lines (Líneas de Detalle).

        
Cuando se cree la vista, se añadirá el archivo CAD en la ficha Insert > Import > Import CAD y se insertará 
en el archivo con las condiciones que se muestran en la imagen:
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Al insertarlo, aparecerá el archivo completo, este se seleccionará y se le dará click en el botón “Full Explode” 
que se activa en la pestaña Modify al momento de seleccionarlo.

  
Cuando se realice, las líneas del archivo CAD se convertirán a líneas de Revit. Con esto se podrá configurar 
la vista y a marcar el terreno de interés, colocando cotas y textos que ubiquen el terreno del proyecto 
dentro del mapa (utilizar regiones, líneas de detalle, textos y cotas). 
Se recuerda siempre el uso del norte y de elementos de anotación necesarios. El plano finalizado se vería 
de la siguiente forma: 

   

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3.3 Plano de Ubicación

En este plano ya se logra visualizar un poco más del terreno a tratar, en este ya se debe ubicar el proyecto 
dentro del terreno y que a una escala más detallada que la anterior se puedan ubicar calles y avenidas 
colindantes al mismo.

Para esto se generará una planta tipo planta de conjunto. Al igual que el plano anterior, esta planta debe 
quedar en una hoja oficio, por lo que se deberá manejar una escala que logre encajar dentro de este. 
Ejemplo:

   
Después de insertarlo en el plano, este debe llevar siempre la ubicación del norte y los elementos de 
anotación que lo complementen (nombres de calles y cotas generales de proyecto), para este ejemplo se 
le colocará solamente una escala gráfica. El plano se vería de la siguiente forma:

*Imagen representativa de plano 
finalizado, para mejor legibilidad ver plano 
adjunto en el apartado de Anexos
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04.3.4 Planta de Conjunto

Esta planta es útil para indicar las calles de acceso al proyecto y la interacción interior/exterior que tiene 
el proyecto con el entorno. 
Para esto se creará una planta que cuente con el rango de vista suficiente para que abarque desde el 
nivel más bajo de calle al nivel de cubierta. Al tenerla se le aplicará una plantilla nueva. 

    

En esta nueva plantilla, los colores deberán verse más suaves, se ubicarán los ingresos principales y 
secundarios del edificio (Ficha Annotate > Text) y límites de terreno con Property Lines (Ficha Massing & 
Site > Modify Site > Property Line).
Igualmente recordar colocar cotas de elevación y dimensiones de calles y aceras (Ficha Annotate > 
Dimension > Aligned y/o Spot Elevation). 

LÍMITES DE DISEÑO

CALLES Y NIVELES DIMENSIONES DE 
CALLES
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Debido a que esta planta debe mostrar elementos que se encuentran a mayor profundidad que otros, es 
posible aplicar opacidad de dos formas:

1. Aplicando Halftone con las herramientas de sobreescribir gráficos en vista seleccionando elemento por 
elemento. Seleccionar elemento > Click Derecho > Override Graphics in View > Halftone.

      

2. Crear una región en Ficha Annotate > Region > Masking Region en toda el área donde se quiere 
aplicar la opacidad (lo que se encuentre lejos de la cubierta del edificio) e ir aplicando una transparencia a 
este elemento de anotación jugando con este porcentaje en Override Graphics in View > Transparency.
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Con este procedimiento se logrará visualizar una diferencia de ubicación de planos dentro del dibujo.

Recordar siempre colocar la simbología (crear en Ficha View > Create > Legends). 

Primer Plano

Segundo Plano

Tercer Plano

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3.5 Planta de Arquitectura

Para esta planta se tomará como base la planta de machote. Al duplicarla es necesario dirigirse a la 
paleta de propiedades > Identity Data > View Template y crear una nueva plantilla para iniciar con las 
configuraciones específicas de vista.

El usuario deberá asegurarse de contar con el estilo visual Hidden Line, este modo de visualización permite 
que los elementos en las plantas muestren colores planos más una trama asignada en el material. Estos 
colores deben ser suaves, solamente para representación del material en la planta.

              
Cuando se hayan aplicado todos estos criterios, es necesario que se realice una revisión de los elementos 
proyectados en la planta, como líneas que pertenezcan a otro nivel, proyecciones de voladizos o 
representaciones de otros elementos que deban resaltarse en la planta de arquitectura del proyecto que 
se está trabajando.        

COLORES A TOMAR 
EN HIDDEN LINE

NOTA

Se debe evitar que los elementos de 
anotación queden sobre elementos de 
modelo o que cubran la mayor parte de un 
ambiente. Aunque esto se interprete como 
algo con poca importancia, es uno de los 
aspectos que le da claridad a un plano,
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Para poder etiquetar los ambientes, es necesario ubicar elementos de habitación. Ficha Architecture > 
Room & Area > Room.

Algunas veces las habitaciones no se encuentran completamente cerradas o son áreas abiertas (Ej. ambientes 
donde la sala, comedor y cocina se encuentran juntos), en este caso se debe utilizar la herramienta Room 
Separator. Ficha Architecture > Room & Area > Room Separator.
Ejemplo:

Separación 
Habitación



170

P R O Y E C T O  -  P L A N O S  C O N S T R U C T I V O S

Al finalizar la colocación de habitaciones para la planta, recordar colocar las cotas totales y parciales a 
ejes para la planta y la anotación de niveles utilizados en el proyecto. Ficha Annotate > Dimension. 

Igualmente se debe recordar la colocación de simbología creada para el plano, esta será creada con 
Leyendas. Ficha View > Create > Legends.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3.6 Planta Acotada

Para esta planta se tomará como base la planta de machotes, recordar siempre crear una nueva plantilla 
para evitar modificaciones en la plantilla incorrecta.
Paleta de propiedades > Identity Data > View Template.

Todos los elementos de modelo se colocaron en Halftone (se recomienda realizar una prueba de impresión 
para verificar la claridad del dibujo). Visibility Graphic Overrides > Select All > Halftone.

Al ingresar la planta a la hoja, se visualizarán los ejes fuera del límite del formato, entonces se procederá a 
copiar los ejes ya configurados en la planta de Machotes o de Arquitectura.  

           

Esto se logra con la herramienta  “Propagate Extents” (Propagar extensiones) la cual se activa solamente  
al seleccionar los ejes.

Ejes fuera 
del límite 
del formato

Ejes dentro 
del límite 
del formato
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Para que se logre el objetivo, los ejes de la planta de arquitectura deben estar en 2D sin ayuda de la 
región de recorte. Es necesario asegurarse que la región de recorte se encuentre lo suficientemente lejos 
de los ejes en ambas plantas.

Seleccionar ejes en planta de ejemplo > Modify > Propagate Extents > Seleccionar vista a donde 
se aplicarán las extensiones de ejes (En este caso será la planta acotada). 

       

Al aplicarlo, se podrá observar el cambio.

  

Después de esta configuración se colocarán las cotas de forma que obedezcan a una distancia entre ellas,  
para esto es necesario realizar una conversión de las dimensiones en centímetros a las dimensiones que se 
deben seguir según la escala. 

Antes Después
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Ejemplo: Si se quiere aplicar un espaciado de 
1cm entre cada cota, como se está utilizando 
la escala 1:125 en el dibujo, se hace una regla 
de 3= ((1x125)/100) esto da como resultado 
1.25cm, por lo tanto, esta es la dimensión a 
utilizar para el espaciado de las cotas. Para 
seguir esto se pueden utilizar simples líneas que 
se borrarán al finalizar la colocación de cotas 
o bien utilizar los planos de referencia, cualquier 
opción es válida.

1:100 = 1cm
1:125 = 1.25cm

Para la planta de cotas se debe encontrar los siguientes tipos de dimensiones:

Fuera de la planta
• Cota total de la construcción
• Cota total a Ejes
• Cotas parciales a Ejes
• Cotas parciales de construcción (vanos)
• Cotas parciales de muros (espesores de muros + vanos)

Dentro de la planta
• Cotas indicando espesores de muros, vanos, anchos totales de gradas.
• Cotas de elevaciónes del proyecto o niveles (Ej. -0.10, 0.00, +0.10, +0.15, etc.)

Se debe procurar colocar las cotas de forma ordenada, siempre verificando que sus extensiones no 
interrumpan el dibujo.

   
COTAS FUERA 
DE LA PLANTA

COTAS DENTRO 
DE LA PLANTA
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Para evitar el desorden en este tipo de plantas, se debe procurar por alinear la mayor cantidad de cotas 
unas con otras, esto para que se perciba una línea continua entre ellas, igualmente se debe evitar el 
traslape de cotas, para que en obra no equivoquen ninguna dimensión.

Luego se colocarán cotas de elevación igualmente evitando los traslapes con las cotas ya aplicadas al 
dibujo.
En caso sea necesario colocar una flecha a este tipo de cota, es necesario ubicarse en Paleta de 
propiedades > Edit Type > Graphics > Arrowhead.

EJEMPLO DE LÍNEAS 
A SEGUIR AL 
COLOCAR COTAS
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Antes de finalizar el plano, es necesario chequear que no se esté pasando por alto ninguna cota importante 
en el proyecto.

NOTA

Para estas plantas se colocaron cotas 
totales de ambientes y de apartamentos, 
se tomaron en cuenta los vanos de puertas 
y ventanas. Para poder acotar espesores 
de muros y elementos más detallados, es 
posible realizar plantas acotadas a modo 
de detalle, con una escala que permita 
acotar más elementos y que no se perciba 
como una vista desordenada.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3.7 Planta de Acabados

Para esta planta se utilizará como base la planta de machotes, recordar siempre duplicar la plantilla de vista 
en Paleta de propiedades > Identity Data > View Template.
Para esta planta se aplicará Halftone a todos los elementos de modelo EXCEPTUANDO los que se desea 
etiquetar, en este caso son muros y pisos.
Visibility Graphic Overrides > Select All (recordar evitar seleccionar muros y pisos) > Halftone.

Después de esto, se iniciará a colocar las etiquetas de material.

Para aplicar esta etiqueta el modelado de muros en Revit debe ser el correcto según la forma en que se 
construye (Acabado / Material de Núcleo / Acabado) es necesario que en las características del muro 
dentro de visualización de gráficos estos se configuren con el nivel de detalle medio y mantener activa la 
opción de Common Edges en Visibility Graphic Overrides, de lo contrario no se percibirán las capas 
de material.
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Cuando se proceda a etiquetar un muro (Annotate > Tag > Material Tag), puede que Revit indique que 
no hay ninguna etiqueta de material cargada en el proyecto y si se desea cargar alguna, se dará click en 
SÍ y esto arrojará la ventana de Revit donde muestra las familias de anotación que se desean cargar, este 
tipo de etiquetas se encontrarán en la carpeta Arquitectónica.
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Al cargar la etiqueta se etiquetará cualquiera de los materiales de muro, esta aparecerá con un signo de 
interrogación si el campo a etiquetar no tiene ningún dato. Para corregir la etiqueta o editarla según lo 
deseado por el usuario se procederá a editar la familia. 
Seleccionar etiqueta > Ficha Modify > Edit Family.

Al estar en el modo edición de la familia:
Seleccionar texto > Paleta de Propiedades > Label > Edit, este dato actual se cambiará por el campo 
Mark. Este campo sirve para tipificar y colocar una marca a los materiales o a objetos de modelo del 
proyecto. A este campo se le colocará el código CR+BL como representación del material a describir (este 
código se deberá aclarar en simbología).
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Cuando se cargue la familia al proyecto, esta aún conservará el signo de interrogación al colocarla. 
Para que indique el código que se necesita, se debe entrar a la configuración del material del muro. Al 
colocar el cógido correcto en el campo Mark del material, esta etiqueta tomará automáticamente 
el código ingresado en el parámetro.

Ya que la misma etiqueta funciona para pisos, es necesario realizar las mismas configuraciones colocando 
otro tipo u otra figura como etiqueta para poder hacer una diferenciación entre ambas en la simbología y 
que al leer el plano, estas dos no se confundan.

ETIQUETA DE 
PISO

ETIQUETA DE MURO
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NOTA
Otra opción es crear un elemento de 
anotación (familia) en donde se puedan  
anotar todos los acabados de un ambiente 
en una sola etiqueta como se muestra en la 
imagen (Muros, Cielos y Pisos). 

Al hacer esto, el programa no se está 
utilizando de forma correcta ya que se 
estaría anotando información en 2D (Ej. 
AutoCAD) y este no es el objetivo al utilizar 
un programa BIM. 
Sin embargo, este método de anotación 
puede ser utilizado si no se dispone de 
mucho tiempo o si se desea evitar el uso 
de un plano por cada tipo de acabado. 
Igualmente es posible utilizarlo cuando los 
acabados no están definidos al 100% y se 
desea trabajar de forma más rápida.

Al terminar de colocar las etiquetas dentro de la planta, esta se verá de la siguiente forma:

Se recomienda evitar el traslape de etiquetas y procurar alinearlas unas con otras ya que esto permite que 
el plano sea más legible.

Al finalizar el plano, se procederá a crear las planillas de materiales. 
Ficha View > Create > Schedules > Material Takeoff. 
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Al dar click en OK, Revit abrirá una una nueva ventana donde solicitará que se ingresen los campos que se 
desean ver en la Tabla. 
Para este ejemplo se necesitarán: Material Mark, Material Area y Material Description. 

Ahora se procederá a organizar la información.
Para esto es necesario dirigirse a la Paleta de propiedades > Other > Filter > Edit.
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- En la ficha Filter, se colocará como regla solamente mostrar el piso que corresponda al Material Mark 
colocado para el tipo de piso de nivel 3 como se observa en la imagen (Piso tipo CE-BG).

- En la ficha Sorting/Grouping se ordenará por Material Mark de forma ascendente y se le colocará que 
calcule los TOTALES de la Tabla, colocando títulos, cantidades y totales bajo el título de ÁREA TOTAL. 
En esta ficha es necesario asegurarse que esté desactivada la casilla Itemize every instance (Detallar 
cada elemento). 
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- En la ficha Formatting solamente se modificará el campo Material Area, que es donde se extraerá la 
información en metraje cuadrado. Esta debe tener en su opción final “Calculate Totals”.

La ficha Appearance se configurará como se muestra en la imagen. 
• Tabla con grilla de líneas delgadas
• Contorno exterior con punto 0.3mm. 
• Desactivar la opción “mostrar una celda en blanco antes de los datos”.
• En texto se configura que no muestre el título, solamente se mostrarán los encabezados. 
• El texto para títulos será de 4mm, el texto para encabezados será de 2mm y el texto para el contenido 

de la Tabla será de 2mm.

Al finalizar las configuraciones, se dará click en OK y se podrá visualizar el resultado en la ventana de la 
Tabla.
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Hay dos maneras de editar la descripción del material.
• Directamente en la Tabla dando click en la celda de descripción y teclear la información que se necesita
• Editando el campo “Description” dentro de cada material.

  o  

Luego de estas configuraciones, se procederá a darle medidas a cada columna de la Tabla, esto se realiza 
seleccionando la columna a modificar > Modify > Columns > Resize. En este ejemplo se aplicaron las 
siguientes dimensiones:

- A Material Mark, 25.00 mm
- A Marerial Area, 25.00 mm
- A Material Description, 100.00 mm

Al configurar las dimensiones se procederá a mejorar el aspecto gráfico a la Tabla para poder insertarla en 
el plano. Seleccionar encabezados > Modify > Group.
Después de esto aparecerá una celda en blanco donde se colocará el título PLANILLA DE ACABADOS 
EN PISO. Para modificar el estilo de texto de esta celda Seleccionar celda de título> Modify > Font. 

1.

2.
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Cuando esto se termine de configurar, se le cambiará el texto a los encabezados. Para realizarlo seleccionar 
celda de encabezado > Teclear título deseado (esto no afecta el nombre de cada campo en Revit).

El mismo procedimiento se empleará a la planilla de acabados en muro, solo que esta se creará bajo la 
categoría Walls.

Al finalizar las Tablas se insertarán en el plano, se colocará la respectiva simbología y las notas de plano 
generadas en una leyenda.

*Imagen representativa 
de plano finalizado, 
para mejor legibilidad 
ver plano adjunto en el 
apartado de Anexos



186

P R O Y E C T O  -  P L A N O S  C O N S T R U C T I V O S

04.3.8 Planta de Tipos de Puertas y Ventanas

Utilizar la planta de machote como base. Para modificarla se recuerda siempre duplicar la plantilla ya que 
cualquier cambio que se haga sobre la plantilla existente, afectará la planta de machote. 
Paleta de propiedades > Identity Data > View Template.
Para esta planta es importante ver los tipos de puertas y ventanas. Todas las categorías de modelo 
quedarán en Halftone Visibility Graphic Overrides > Select All (recordar evitar seleccionar puertas 
y ventanas) > Halftone.

Es necesario que para esta plantilla también se corrobore tener encendidas las categorías de anotación 
“Door Tags” y “Window Tags” en Visibility Graphic Overrides > Annotation Categories. 

Buscar la herramienta para etiquetar por categoría, se encuentra en la ficha Annotate > Tag > Tag by 
Category. Al tener seleccionada la herramienta, se buscará dar click a una ventana o a una puerta y (en 
caso no se tenga una etiqueta cargada en plantilla) Revit mostrará un mensaje que consultará si se desea 
cargar una etiqueta en ese momento. Se le dará click en “Sí”.

Esto abrirá una ventana que ubica al usuario en la llibrería de Revit. Si se ingresa a la carpeta “Spanish_
INTL” > Anotaciones > Arquitectónica, se encontrarán las diferentes etiquetas de elementos de modelo. 
Para este ejemplo se cargará la familia de etiqueta de ventana.
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Cuando se seleccione la etiqueta deseada, se dará click en Open y Revit la cargará al proyecto, 
procediendo a colocarla en el elemento que se había seleccionado previamente. 

Esta familia se puede modificar para tener un diseño personal. Para poder modificarla, se deberá seleccionar 
la etiqueta > Ficha Modify > Edit Family.

Dentro de esta, al igual que con las etiquetas de acabados en muro, se chequeará que la etiqueta esté 
tomando el parámetro Type Mark, ya que este es el adecuado para tipificar las ventanas del proyecto. 
Paleta de propiedades > Graphics > Label > Edit.
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Al haber cambiado esta etiqueta, se le dará el diseño que el usuario desea.

Cuando se haga este tipo de familias, es necesario asegurarse que el espesor de las líneas utilizadas para 
hacer el recuadro se encuentren con el espesor correcto, para esto se debe abrir el panel Object Styles 
Ficha Manage > Settings > Object Styles.
Dentro de la familia tiene un espesor No. 1 este se aplicará a las configuraciones de puntos en el proyecto 
que se está trabajando.

   

Al verificar todas estas configuraciones, la familia se guardará y se procederá a cargar la familia dentro del 
proyecto. 

INDICA SILLAR

INDICA DINTEL

INDICA LA MARCA O 
CÓDIGO COLOCADO 

EN LA FAMILIA
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Allí se seleccionará la familia que se guardó y se reemplazará en la vista.

 

Para que la familia reconozca un código (V-01) como se ve en el ejemplo, es necesario que se ingrese a 
las propiedades de tipo seleccionar ventana > Edit Type > Type Mark.

NOTA

El parámetro también puede ser modificado 
utilizando la familia de etiqueta*. Primero 
se debe etiquetar el elemento, se da click 
sobre el texto que indica el parámetro, este 
pasará a un modo de edición permitiendo 
teclear el código deseado (ver imágenes), 
el programa igualmente notificará que se 
estará afectando varios elementos y si se 
desea continuar, si se aplicó correctamente, 
se dará click en OK. Esto es más práctico 
pero no es recomendado, ya que dentro 
de la ventana de propiedades del tipo es 
más fácil verificar que se esté ingresando el 
código correcto.

*Esto se puede 
aplicar con etiquetas 
de cualquier tipo 
(de material, puertas, 
ventanas, vigas, 
columnas, etc.).

También existe una herramienta que permite que se etiqueten todas las familias de ventana en la vista que 
se tiene abierta en ese momento. Esta herramienta se nombra “Tag All”.
Ficha Annotate > Tag > Tag All. 
Aparecerá una ventana que consulta qué tipo de etiquetas se desean aplicar en ese momento, aquí 
apareceran TODAS las etiquetas que están cargadas en el proyecto. En la columna de “Category” se 
buscará la categoría Window Tags y se seleccionará la etiqueta creada (MT_Etiqueta de Ventana).
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También aparecen otras opciones en esta ventana, permite indicar si se deseea añadir una directriz (leader), 
a qué longitud y en qué posición se colocará la etiqueta. En este ejemplo se aplicará a 10.00mm y se 
ajustará cuando ya todo se encuentre etiquetado.
Al aceptar las configuraciones, la etiqueta aparecerá aplicada en todas las familias.

El mismo procedimiento se deberá seguir para aplicar etiquetas a las puertas utilizadas, solamente se deberá 
cargar la etiqueta de puerta cuando se desee utilizarla.

INDICA 
DINTEL

INDICA MARCA O 
CÓDIGO COLOCADO 
EN LA FAMILIA
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Para crear una Tabla de ventanas, es necesario buscar la herramienta Schedule/Quantities. Esta se encuentra 
en la ficha View > Create > Schedules > Schedule/Quantities. 

Al seleccionarla aparecerá el listado de elementos del modelo, allí es posible elegir la categoría sobre la 
cual se desee crear la Tabla.
Schedule/Quantities > Windows > TESIS_PLANILLA DE VENTANAS.

   
Al igual que en la Tabla de materiales, aparecerá una ventana donde se solicitará aplicar los campos que 
se desean ver. Por ahora se seleccionarán los campos: Type Mark, Count, Sill Height, Description.

1. En la pestaña “Filter” se añadirá la condición para filtrar por Type Mark. En esta se seleccionará la 
opción “begins with” (empieza con) y se tecleará la letra V (recordar que este filtro obedecerá la regla 
que se le indique, en este caso se le está diciendo que muestre solo los elementos cuyo Type Mark inicie 
con la letra V).
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2. En la pestaña “Sorting/Grouping”. El orden se hará por Type Mark de forma ascendente (los códigos 
aparecerán de la A a la Z y del 1 en adelante). También se le dirá que calcule el total de ventanas de los 
tipos y que aparezca con el título TOTAL DE VENTANAS. 
Desactivar la opción “Itemize every instance” (detallar cada elemento) para que aparezca solamente 
el total de ventanas por tipo. 
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3. En la pestaña Formatting se dejará todo con las configuraciones por defecto, solamente, al campo 
Count se le aplicara Calculate Totals en Field formatting.

4. En la pestaña Appearance se configurará el tipo de visualización de la Tabla, esta queda a criterio del 
usuario y como desee manejar la apariencia de las mismas. Para este ejemplo se manejará como la imagen:

Para la Tabla es necesario añadir los campos Height y Width. Estos campos se podrán posicionar según el 
orden de los datos que se quiera ver en la Tabla. 
Para el ejemplo se dejará en el siguiente orden:
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Ahora se agruparán los elementos que guardan una descripción en común (por ejemplo, se agruparon los 
campos Ancho, Alto, Sillar y Dintel bajo el título “Dimensiones”)  y se agruparán todos los campos 
bajo el título PLANILLA DE VENTANAS.

El mismo procedimiento se realizará para la creación de la Tabla de tipos de puertas utilizados en el proyecto, 
solamente es necesario recordar que la Tabla se creará bajo la categoría de Puertas, implementando 
siempre un nombramiento correcto para facilidad en localizar la información.

               
La Tabla, con todas las configuraciones necesarias, debería verse similar a la planilla de ventanas, en el 
caso de este ejemplo, la Tabla quedó de esta forma:
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Cuando se termine de configurar, se añadirá al plano y se habrá terminado. Siempre es necesario recordar que 
se debe añadir una simbología al plano para evitar confusiones malas interpretaciones con las etiquetas del 
plano.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.3.9 Elevaciones

Para las elevaciones se creará una vista que abarque todo el proyecto mostrando sus diferentes volumenes.

En primer lugar, la vista se insertará en el plano, esto para realizar las configuraciones con recortes de vista. 
En esta plantilla se utilizará el estilo visual “Hidden Line” (línea oculta), esto porque en la vista es 
necesario que resalten los elementos de anotación, etiquetas, cotas y textos por lo tanto el color pasa a 
segundo plano.

Al verificar que el plano esté en el lugar correcto, se iniciará a colocar los elementos de anotación, en esta 
vista se incluyen:
• Proyecciones de Restricciones Municipales (alturas máximas)
• Perfiles de topografía
• Cotas parciales y totales entre niveles
• Ambientación como trazos (sin color)
• Nombre de espacios visibles
• Niveles
• Colores y texturas suaves (si se desea)

Adicionalmente, se añadirán las etiquetas que se fueron creando a lo largo del avance en el juego de 
planos, por ejemplo, etiquetas de tipos de puertas, ventanas, acabados en muro y acabados en piso 
(si aplica). En esta vista igual se puede aplicar la herramienta Tag All.
Ficha Annotate > Tag All.
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Recordar siempre aplicar las profundidades de vista con la herramienta Depht Cueing. Para la vista se utilizó 
la configuración mostrada en la imagen:
Graphic Display Options > Depht Cueing. 

 

Primer plano

Segundo plano Tercer plano
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Al finalizar, igualmente se puede considerar el uso de color, siempre se recomienda que en este tipo de 
planos el uso sea solamente en donde se necesite enfatizar el color del material. También se recomienda 
que los colores sean suaves (estos no deben interrumpir las notas técnicas del plano). 

Para representar los colores de los materiales en cada estilo visual,  estos deben aplicarse en las 
configuraciones gráficas de cada material.

Cuando ya se tenga claro que las configuraciones de gráficos de materiales corresponden a sus 
características reales, se procederá a jugar con los estilos visuales para tomar una desición de cuál formará 
parte del plano técnico. 

  

ESTILO VISUAL 
SHADED

ESTILO VISUAL 
HIDDEN LINE

ESTILO VISUAL SHADED

ESTILO VISUAL HIDDEN 
LINE



199

P R O Y E C T O  -  P L A N O S  C O N S T R U C T I V O S

04.3.10 Secciones

Se creará una sección en donde se crea conveniente. La sección creada se insertará en el plano y se 
configurarán las regiones de recorte y regiones rellenadas en caso se necesiten.

Al igual que en los planos de diseño y elevaciones, se colocarán los elementos de anotación necesarios 
para dar a entender el proyecto. En la vista se utilizarán las siguientes notas:

• Proyecciones de Restricciones Municipales (alturas máximas)
• Perfiles de topografía
• Cotas parciales y totales entre niveles
• Ambientación como trazos (sin color)
• Nombre de espacios visibles (etiquetas de habitación)
• Niveles
• Colores y texturas suaves (si se desea)
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Se recuerda también aplicar la configuración de profundidad de vista para mejorar la expresión gráfica 
utilizando la herramienta Depht Cueing. Graphic Display Options > Depht Cueing. 

  

Se añadirán también todas las notas, cotas de elevación y etiquetas creadas a lo largo de la planificación. 

Primer plano

Segundo plano
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A este plano también se le puede dar color si se cree conveniente. Los estilos visuales recomendados son 
Hidden Line y Shaded ya que estos colocan colores suaves a la vista.

  

ESTILO VISUAL 
SHADED

ESTILO VISUAL 
HIDDEN LINE

*Imágenes representativas de plano finalizado, para mejor legibilidad ver plano adjunto en 
el apartado de Anexos
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04.4. PROYECTO – DETALLES ARQUITECTÓNICOS Y ÁREAS

Este tipo de planos sigue siendo parte de los planos constructivos de arquitectura, sin embargo, se hace 
su clasificación ya que es otro tipo de diagramación y posiblemente otro tipo de tema que interese 
específicamente en la guía.

Para este tipo de planos, como su nombre lo dice, es necesario detallar los elementos que forman parte 
del conjunto arquitectónico. No quiere decir que todo elemento deba llevar un detalle, sino simplemente 
los elementos que necesiten más atención o que requieran un plano completo para su explicación. Entre 
estos podrían estar los detalles de puertas, ventanas, barandillas, celosías, muros verdes, muebles de obra, 
escritorios, detalles de acabados que requieran fabricación por aparte, etc.

NOTA

Se hace la aclaración que a pesar de no 
ser necesario detallar elementos específicos 
de fabricación, el arquitecto debe tener 
una idea de cómo construir o fabricar sus 
detalles de fachada o mobiliario diseñado, 
ya que al momento de conversar con 
el propietario del proyecto, este pueda 
decidir si es un detalle que le parece fuera 
del alcance de inversión del proyecto o si 
está de acuerdo en que se implemente en 
otros lugares.

En estos solamente se dará un indicio de su 
fabricación para que el encargado del elemento 
arquitectónico pueda decidir qué tipo de 
herramientas o accesorios implementar.

Adicionalmente, en este capítulo se explicará 
el proceso de realización de planos de áreas, 
algunas veces se tiene la idea equivocada que el 
plano de áreas es el mismo que un plano realizado 
con la herramienta “Room”, esto es incorrecto. Para 
este tipo de planos es necesario crear tipos de 
áreas a abarcar para que Revit pueda hacer una 
clasificación, generar simbologías o esquemas de 
color y generar Tablas para su cuantificación.

Para estos ejemplos se explicará el proceso de:

1. Plano de detalles de puertas y ventanas
2. Plano de detalles de gradas y rampas
3. Plano de Cargas de Ocupación
4. Plano de Áreas de Proyecto
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04.4.1 Detalles de Puertas y Ventanas

Dentro de estos planos se detallarán las puertas y ventanas del proyecto. Estos brindan información al 
encargado de la fabricación de los mismos y, en caso se encuentren diseños y geometrías específicas, el 
fabricante se puede guiar de las geometrías brindadas para generar sus propios planos de taller. 

En estos planos no es necesario indicar la fabricación de estos elementos al 100% ya que todo queda a 
criterio del fabricante (por ejemplo: perfilería, tipos de anclajes, tipos de soldaduras, tipos de accesorios a 
utilizar, etc.).

Para crear los detalles hay dos diferentes métodos, el primero es creando una leyenda de plano en 
donde se pueden insertar las vistas y el segundo es creando vistas de plano.
En primer lugar se detallará el proceso de creación con una leyenda de plano. 

OPCIÓN 01
Es necesario dirigirse a la pestaña View > Create > Legends > Legend. Allí, como siempre, aparecerá una 
ventana que consulte el nombre que se le desea dar a la leyenda y la escala a la que se desea crear. Para 
este ejemplo se aplicará la escala 1:25.

 

Al estar dentro de la ventana de edición de leyenda, es necesario dirigirse a la pestaña Annotate > Detail 
> Component > Legend Component. Cuando se seleccione la herramienta, se activará una cinta de 
opciones bajo las herramientas de Revit, en esta será posible escoger qué tipo de familia se quiere detallar 
y la vista que se quiere colocar dentro de la leyenda, dentro de las vistas es posible escoger si se desea 
una vista de planta o de elevación (Frontal o Posterior). 
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Dentro de este menú buscar la familia de puerta que corresponde al tipo de puerta que se desea documentar, 
Family > Doors:Puerta_Abatible_Madera_1Hoja: 0.70 x 2.10m  View > Floor Plan
(Es acá donde se vuelve a ver la importancia del nombramiento y el control que se lleve en el proyecto, 
ya que si se cuenta con una gran cantidad de tipos de puertas, será difícil localizar la correspondiente a 
cada tipo).

     

Al colocarla dentro de la vista, se aplicarán: 
• Regiones rellenadas para representar el corte de los muros.
• Cotas que indiquen las medidas de la representación en 2D. 

El mismo procedimiento se hará con la elevación. Se puede realizar en la misma leyenda para tener las dos 
vistas juntas, o bien, se puede crear una leyenda para cada vista.
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Al finalizar la edición de las vistas, estas pueden ser colocadas en una hoja y seguir documentando de la 
misma forma.

NOTA

Las desventajas que tiene realizar la documentación de detalles con leyendas son las siguientes:

- Es difícil la ubicación del tipo de familia correcto a documentar cuando se desean insertar las vistas.
- No es posible colocar cotas de nivel ni etiquetas de tipo dentro de las leyendas.
- Las leyendas no se pueden clasificar dentro de diferentes tipos de vista en la interfaz de Revit (como 
la clasificación de vistas de planta, elevaciones, secciones o 3D), estas se encontrarán siempre en 
leyendas, por lo que  se debe especificar el tipo de detalle en el nombramienro para localizar las 
vistas con mucha más rapidez.

OPCIÓN 02

El siguiente método consiste en crear los detalles de puertas y ventanas bajo vistas creadas en el proyecto. 

Crear una vista de planta (donde se vea la puerta) > Aplicar región de recorte para documentarla. 
Esta será la tipo P-01 que es de 0.90 x 2.10m. 
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Configurar la vista dejando solamente visibles puertas y muros para su documentación. Al realizar las 
modificaciones en la vista se recuerda siempre guardar la nueva plantilla de vista para documentar los 
demás detalles.
Aplicar:
• Dimensiones de puerta
• Notas que describan elementos importantes en el detalle
• Etiqueta de puerta

 

Posteriormente se procederá a crear la vista de elevación para el detalle de puerta.
View > Create > Elevation. 
Después de crearla, se le aplicará una región de recorte que solamente cubra el área de la puerta y se 
aplicarán:
• Dimensiones de puerta
• Notas que describan elementos importantes en el detalle
• Etiqueta de puerta

       
Al tener las vistas de planta y elevación se colocarán ambas en el plano. Para efectos de comparación de 
resultados, se colocará el detalle realizado en leyenda y al lado el detalle realizado con vistas de modelo.
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Como es posible observar, no hay mayor diferencia entre ambos métodos de documentación, el método de 
trabajo y la forma de generar la información queda a criterio del usuario.

Al haber terminado los detalles en planta y elevación, también es posible auxiliarse con un detalle en 3D. Se 
realizará un ejemplo con este mismo tipo de puerta. 
Seleccionar puerta en planta > Modify > View > Selection Box.

      
Configurar de la siguiente forma: Visibility Graphic Overrides 
• Apagar todos los elementos de modelo excepto muros, pisos y puertas
• Colocar Halftone a todos los elementos excepto puertas
• Transparencia del 60% a los muros

Para poder acotar es necesario definir un plano de trabajo. 
Este se define en la ficha Architecture > Work Plane > Set. Para este ejemplo se colocarán cotas para 
indicar la altura de la puerta, por lo tanto el plano de trabajo se colocará en el muro anfitrión.

DETALLES CON 
VISTAS DE MODELO

DETALLES CON 
LEYENDAS
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Al realizar estos pasos y luego dar click sobre el botón Show Work Plane, Revit mostrará el plano de trabajo a 
utilizar encendiendo un plano en color celeste claro, este plano se puede apagar dando click nuevamente 
en el botón Show. Este se encuentra en la ficha Architecture > Work Plane > Show.

      

Cuando ya se esté seguro de haber ubicado el plano en el lugar correcto, se procederá a colocar las 
cotas.
Annotate > Dimension.
También es posible colocar el Work Plane en el piso para colocar cotas que indiquen el ancho de la puerta.

SE DA CLICK 
SOBRE LA CARA 
DEL MURO
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Para colocar etiquetas, es necesario utilizar la herramienta Tag by Category.
Annotate > Tag > Tag by Category
La vista 3D debe estar bloqueada antes de proceder a añadir etiquetas. Por lo tanto se bloqueará en el 
ícono de “bloquear 3D que se encuentra en la barra de control de vista, al hacerlo Revit solicitará que la 
vista sea renombrada, aquí se le colocará el nombre que el usuario crea conveniente.
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Para este tipo de detalles también es posible añadir un poco de color, igualmente es posible lograrlo al 
cambiar el estilo visual. 

    

Para este ejemplo, se dejará el estilo Hidden Line.
Dentro del plano, ya depende mucho del usuario de Revit el orden en su información, para el ejemplo se 
colocará una vista de planta, la elevación y a la par de estas se colocará el 3D.

El plano no necesariamente debe tener un detalle por hoja, es posible colocar varios detalles utilizando el 
mayor espacio posible. 
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Para efectos del ejemplo, se duplicará el mismo detalle las veces que sea necesario para ejemplificar 
el plano terminado. Es necesario recordar que es imprescindible la colocación de simbologías y notas;  
también si se desea complementar la información, es posible añadir una Tabla filtrando los tipos de puertas 
o ventanas que se incluyen en el plano.

El plano finalizado quedaría de la siguiente forma:

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.4.2 Detalles de Gradas y Rampas

Para este tipo de detalles es necesario representar la geometría de todos los tipos de gradas y rampas 
que se hayan implementado en el proyecto. Este plano es solicitado por la Coordinadora de Reducción 
de Desastres -CONRED- ya que son los encargados de evaluar que las salidas de emergencia dentro del 
proyecto estén completamente aptas para su función.

En este tipo de planos no es necesario indicar refuerzos, tipo de concreto o especificaciones estructurales 
(esto corresponde al ingeniero estructural) solamente indica la geometría. En este tipo de plano no es 
necesario ver patrones de superficie ni detalles de vegetación o mobiliario por lo tanto deben ocultarse (el 
mobiliario fijo deberá permanecer activado en caso haya algún mueble fijo o sanitario cercano al módulo 
de gradas o en caso esto afecte directamente a su geometría). 

Para ejemplificar el plano se hará un detalle de las gradas de niveles típicos (Nivel 03 al 12). 
Crear planta de nivel en View > Plan Views > Floor Plan y recortar la vista para visualizar solamente las 
gradas.

 

Las gradas tienen la siguiente configuración:
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Para esta vista se aplicarán las siguientes configuraciones de visualización:
• Ocultar todo el mobiliario y artefactos sanitarios
• Colocar filtros para aplicar color de muros (Visibility Graphic Overrides > Filters)
• Retirar patrón de relleno a la categoría Floor
• Mantener vista en estilo visual Hidden Line
• Aplicar líneas de ruptura

Siempre es necesario indicar la dirección en la que se puede bajar o subir de nivel y el número de escalones 
que contiene. Revit cuenta con dos herramientas para este efecto. 

La herramienta que indica la dirección de las escaleras es “Stair Path”. 
Annotate > Symbol > Stair Path > Clic a la escalera que se desea etiquetar.
Se dará click a los dos caminos de gradas que se aplican al nivel (gradas de nivel 02 al 03 y las del nivel 
03 al 04).

     

Para colocar el número de escalones en el módulo existe la herramienta “Tread Number” (Numerar huellas y 
contrahuellas). Annotate > Tag > Tread Number. 
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Esta herramienta, al seleccionarla, activará algunas configuraciones. Para el ejemplo se realizó la configuración 
de la imagen:

    

Al terminar de realizar estas configuraciones, se procederá a seleccionar las escaleras en donde se desea 
etiquetar el número de escalones.

         

Cuando se añadan estas etiquetas, se terminarán de colocar los elementos de anotación necesarios para 
completar el detalle de las gradas y se colocará en plano. Las notas aplicadas en el ejemplo son:

• Ancho de tramos de escaleras
• Anchos de escalones
• Ángulos de escalones (en caso se necesite).
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Después de esto se ubicarán algunas secciones para aclarar las alturas de los escalones y alturas de 
barandillas y estas se añadirán al plano para comenzar a diagramar. 

A las secciones se le aplicarán los mismos elementos de anotación de las plantas o algunos más, como 
regiones para cubrir uniones con losa (por practicidad) o líneas de proyección de gradas ocultas.
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También es permitido que de estas vistas se extraigan llamados a detalle para indicar alturas o cotas de 
geometrías. Estas vistas de detalle se pueden crear con la herramienta “Callout”.
Ficha View > Create > Callout.

En este ejemplo se utilizará la herramienta para hacer un llamado a detalle del final de la escalera que 
va de nivel 03 a nivel 04. Al crear el rectángulo de la vista de detalle, se abre automáticamente la vista 
creada para poder editarla. En ella se podrán crear los elementos de anotación necesarios para detallar 
la dimensión de huellas y contrahuellas.

En este ejemplo se aplicó:
• Altura de escalones
• Ángulos de inclinación de escaleras
• Notas para indicar elementos de modelo

          

Para CONRED es importante conocer también las extensiones de barandillas al finalizar la escalera. Debido 
a eso se generarán dos detalles más que se tomarán de la vista de planta.

*VISTA DESPUÉS DE AÑADIR 
ELEMENTOS DE ANOTACIÓN
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También es posible complementar con un detalle 3D. Para este se seleccionarán las gradas y se aislarán en 
vista. Seleccionar gradas > Modify > View > Selection Box.
Se configurará la vista con las mismas configuraciones aplicadas en planta:
• Ocultar todo el mobiliario y artefactos sanitarios
• Colocar filtros para aplicar color de muros (Visibility Graphic Overrides > Filters)
• Retirar patrón de relleno a la categoría Floor
• Mantener vista en estilo visual Hidden Line
• Aplicar líneas de ruptura

Al finalizar todas estas vistas se deberán organizar dentro del plano a como convenga y se colocará la 
simbología.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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04.4.3 Planta de Cargas de Ocupación (Áreas)

Este tipo de planos es requerido por CONRED para efectuar un cálculo de cargas de ocupación del 
proyecto y verificar si se está cumpliendo con la cantidad de salidas de emergencia para los metros 
cuadrados de uso del edificio.
Dentro de Revit esta vista requiere el dibujo de polígonos con la herramienta adecuada para posteriormente 
ser etiquetados bajo un nombre o código de área según el proyecto.

Para iniciar se debe configurar los Area Schemes que se planea utilizar, este paso se realiza antes de  
generar las vistas ya que al ser creadas no se permite el cambio de categoría de plano. A estos es 
necesario añadirles un nombre y una descripción corta que indique el uso. 
Architecture > Room & Area > Area and Volume Computations.

          

Se abrirá una ventana con dos fichas, para crear los tipos de áreas es necesario ubicarse en la ficha Area 
Schemes.
• Dar click en New para crear un nuevo tipo de plano.
• Para editar nombres dar click en la celda “Name” y para editar descripción dar click dentro de la celda 

“Descripción”.

Para este ejemplo de Cargas de Ocupación se dejará como se ve en la imagen y se dará click en OK:
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Ahora ya es posible crear una vista para el nivel que se está trabajando, como se indicó antes, para este 
ejemplo será trabajado el nivel típico (Nivel 03 al 12). 
View > Create > Plan Views > Area Plan.
Al hacer click en esta opción, saldrá la ventana en donde se puede elegir la vista deseada, solamente es 
necesario asegurarse que la vista esté creada bajo la categoría correcta. Aquí solamente aparecerán 
las categorías creadas en Area Schemes.

                  
Al dar click en OK, Revit preguntará si se desea crear contornos automáticos, se le responderá que NO. 

Luego de esto se configurarán los elementos de vista en Visibility Graphics.
• Todos los elementos se colocarán en Halftone exceptuando la categoría áreas. 

Al tener la base, se procederá a crear los polígonos para cerrar áreas. Estos polígonos, al crearse en plantas 
que están sobre la misma categoría (Cargas de Ocupación) estarán conectados para el cálculo de áreas 
dentro de una Tabla de cuantificación y dentro de un esquema de color en el archivo.
Una vez creados, estos no se podrán trasladar a otro tipo de planta (Ej: Áreas de Construcción).
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Estos polígonos se crean con la herramienta Area Boundary. 
Architecture > Room & Area > Area Boundary

Los polígonos serán creados según los criterios de áreas tomadas por CONRED, en este ejemplo, al trabajar 
un nivel exclusivo de apartamentos, solamente hay dos clasificaciones: Apartamentos y Área Comun.

         

Al terminar de colocar los polígonos, a estos deberá asignarseles un área.
Architecture > Room & Area > Area  
Al activarla se deberá dar click en todos los polígonos creados y esta añadirá una etiqueta por defecto.

Seleccionar el área colocada con la tecla Tab (hasta localizar una X que va de esquina a esquina del 
polígono), al hacer click en esta, se activará la paleta de propiedades del área, en ella se debe llenar las 
casillas Name, Comment y/o Type. Esto se debe hacer con cada área de la planta. 
Para este ejemplo se aplicarán las características que se ven en la imagen:

     

Planta sin 
Area Boundary

Planta con 
Area Boundary
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Cuando se crea esta planta, los boundaries no conservan ningún color ya que no están clasificados dentro 
de un esquema, por lo tanto aparecerán con un color amarillo claro. 

Para añadir un esquema de color es necesario ubicarse en
Architecture > Room & Area > Color Schemes. 
Al dar click en esta herramienta se abrirá una ventana que permite añadir un esquema nuevo, a este se 
le colocará el título CARGAS DE OCUPACIÓN y se configurará bajo el parámetro “Type” de cada 
boundary.  Para este ejemplo se añadieron automáticamente los esquemas COMÚN y OCUPACIÓN que 
son los dos tipos de área de la planta. (Ver paleta de propiedades ejemplo en Pág. 215).

  

Al configurarlo, este se debe añadir a la vista trabjada por medio de la herramienta Color Fill Legend.
Annotate > Color Fill > Color Fill Legend > colocar esquema en vista.
Cuando esta se añade, lo hace bajo un texto que indica que ningun esquema ha sido asignado a la vista.
Seleccionar esquema > Modify > Edit Scheme > aplicar esquema creado (Cargas de Ocupación).



222

P R O Y E C T O  -  D E T A L L E S  C O N S T R U C T I V O S

   

Al finalizar se deberá colocar la vista en el plano.

*Imagen representativa de plano finalizado, para mejor legibilidad ver plano adjunto en el 
apartado de Anexos
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Conclusiones

• Con el apoyo de una guía donde se brinden 
instrucciones para el uso del programa Revit, 
los estudiantes podrán aplicar estos métodos 
de trabajo dentro de sus propios proyectos 
comparándolos con diferentes escenarios y 
logrando implementar lo aprendido dentro de 
las entregas a lo largo de la carrera.

• Cuando se comprenden los requerimientos 
técnicos  y  legales  que solicita cada  
dependencia municipal, es posible que el 
estudiante sepa qué elementos se deben 
visualizar y  de  qué forma deben ser 
representados en los planos de proyectos 
arquitectónicos.

• Al contar con las configuraciones generales 
dentro de Revit, como espesores de líneas 
y definición de familias varias de anotación 
en un archivo, es posible aplicar estas mismas 
configuraciones para todos los proyectos que el 
estudiante desee trabajar, esto para simplificar 
el flujo de  trabajo en sus entregas académicas.

• Al definir las configuraciones de vista y creación 
de plantillas, el estudiante podrá mantener una 
correcta línea gráfica en todos los proyectos 
que desarrolle en la carrera, esto permitirá que 
poco a poco mejore y eficientice el tiempo 
invertido en planificaciones de proyectos.
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Recomendaciones

• Complementar por el estudiante el uso de la 
guía con la práctica en sus propios proyectos, 
esto para que al desarrollar planificaciones 
personales se apliquen las instrucciones 
adecuadas sin necesidad de consultar el 
documento.

• Que el estudiante conozca la lista de 
planos que solicita cada dependencia 
municipal previamente a iniciar un proyecto. 
En los documentos proporcionados en cada 
asignatura se indica la ubicación de cada 
terreno, con esto es posible conocer con qué 
permisos debe contar el proyecto académico y 
podrá saber qué planos serán requeridos para 
su aprobación.

• Se requiere que el estudiante, al conocer de las 
configuraciones de archivo, creación de familias 
de anotación y aplicación de plantillas de vista 
dentro de Revit, comience a definir su propia 
línea gráfica con la ayuda de las instrucciones 
de la guía, esto para que mantenga su propia 
identidad dentro de sus proyectos y pueda 
aplicarlo dentro del entorno estudiantil y en un 
futuro, para su desempeño profesional.
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Anexo 01

Contenido

Línea de tiempo, conformación de la Unidad Digital 
y Tecnología.
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Anexo 02

Contenido

Encuestas realizadas a estudiantes y catedráticos 
de la Facultad de Arquitectura de la Universidad 
de San Carlos de Guatemala.
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Encuestas de Evaluación de Lenguaje 
Gráfico en Revit (Catedráticos)

Preguntas Incluidas en la Encuesta

Dentro de las preguntas que podrían ser incluidas  
se realizó una selección y se aplicaron las que  
permitieran  conocer resultados directos acerca del 
desempeño de los alumnos al presentar un proyecto. 
Esto siempre con relación al tema de expresión 
gráfica.

- Pregunta 1:

¿Cómo considera la claridad y calidad de las 
proyecciones ortogonales con la que los alumnos 
presentan sus proyectos en asesorías? (Plantas, 
elevaciones, secciones, vistas de detalle).

Esta pregunta permite que los catedráticos den 
su opinión hacia las proyecciones ortogonales 
que han realizado y entregado sus alumnos en los 
diferentes cursos. Esto toma en cuenta los elementos 
básicos de expresión gráfica (uso de dimensiones y 
notas relevantes para comprender el proyecto).

- Pregunta 2:

¿Cómo considera la claridad y calidad de los planos 
con la que los alumnos presentan sus proyectos en 
entregas? (Plantas, elevaciones, secciones, detalles).

Esta pregunta permite que los catedráticos den su 
opinión hacia los planos que presentan los alumnos. 
Aquí se toma en cuenta el uso de notas de plano, 
notas generales del proyecto, simbologías, tablas 
de descripción de elementos o cuantificación de 
los mismos.

- Pregunta 3:

En un proyecto arquitectónico, ¿considera tan 
importante la representación bidimensional como la 
tridimensional (renders y/o maquetas)? ¿Por qué?

Esta pregunta tiene como objetivo consultar 
a los catedráticos si ellos consideran que la 
representación gráfica en planos es tan importante 
como los renders o maquetas. 

- Pregunta 4:

¿Considera que los estudiantes toman en cuenta 
los criterios aprendidos en la asignatura de Dibujo 
Técnico para los cursos de Práctica Integrada, 
Herramientas Digitales y Diseño Arquitectónico?

Esto permite conocer si, según el punto de vista de 
los catedráticos, los alumnos siguen aplicando y 
manteniendo los conocimientos básicos aprendidos 
desde el principio de la carrera hasta el final de 
esta.

- Pregunta 5:

¿Considera que los alumnos comunican de mejor 
manera sus proyectos al entregar planos hechos 
a mano comparados con los elaborados con la 
ayuda de herramientas digitales? ¿Por qué?

Esta pregunta permitirá conocer el criterio de los 
catedráticos ante las diferentes opciones de 
entrega que hay en la facultad. Con esta pregunta 
se logrará definir la opinión de los catedráticos en 
porcentajes y en razones escritas por ellos mismos.

- Pregunta 6:

¿Considera que los alumnos deben instruirse un 
poco más por su cuenta en el uso de herramientas 
digitales para mejorar la calidad de presentación?

Durante la carrera, algunos profesores brindan 
manuales para guiar a los alumnos en la entrega 
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de proyectos. Con esta pregunta es posible saber 
si los catedráticos están de acuerdo con que los 
alumnos busquen documentos y diferentes recursos 
para aprender.

- Pregunta 7:

¿Considera adecuada la implementación de una 
guía que instruya al alumno en el uso de herramientas 
digitales previo y durante las asignaturas?

Con esta pregunta es posible conocer si los 
catedráticos están de acuerdo con la realización 
de un documento que guíe al alumno no sólo en el 
uso de la herramienta sino también de los criterios 
aplicados para hacer que las herramientas en un 
software funcionen como deben y proyecten lo que 
de verdad se necesita.

- Pregunta 8:

¿Considera importante el uso e implementación de la 
tecnología para realizar proyectos arquitectónicos 
dentro de la facultad para nuestra época actual? 
¿Por qué?

En ocasiones los alumnos mencionan que hay 
algunos catedráticos que se resisten al cambio de 
la metodología de trabajo a mano por el trabajo 
a computadora. Con esta pregunta se logrará 
identificar si estos comentarios son ciertos, en qué 
porcentaje y dando oportunidad a los catedráticos 
de explicar el por qué de su preferencia.

Encuestas de Evaluación de Lenguaje 
Gráfico en Revit (Estudiantes)

Preguntas Incluidas en la Encuesta

Las preguntas seleccionadas permitirán tener una 
opinión de los alumnos acerca de su desempeño 
en los diferentes cursos. Estas también servirá como 
una autoevaluación ya que se le consulta sobre 
conceptos básicos que se adquieren al principio 
de la carrera.

- Pregunta 1:

¿Considera adecuados los documentos de 
apoyo brindados en Herramientas Digitales I para 
la comprensión y el estudio de los alcances de 
documentación arquitectónica del software Revit? 
¿Por qué?

Esta pregunta dará a conocer la opinión del 
alumno sobre los documentos de apoyo que se le 
han brindado en el curso de herramientas digitales, 
esto para saber si creen necesario otro documento 
que los apoye o si les es suficiente con los actuales.

- Pregunta 2:

¿En qué lugares ha realizado entregas de juegos de 
planos trabajados en Revit durante su carrera?
Esta pregunta se plantea para tener una idea 
o contar con el porcentaje de estudiantes que 
han realizado una entrega de documentación 
de proyecto fuera de la universidad. Esto para 
comprobar que los alumnos, a estas alturas de la 
carrera, ya realizan entregas profesionales por su 
cuenta, por lo cual es necesario dar una mejor guía 
en el tema.

- Pregunta 3:

¿Conoce las herramientas que se pueden utilizar 
en Revit para mejorar el lenguaje gráfico en 
una planificación y que sirven para simplificar su 
manipulación?
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Esta es una pregunta de autoevaluación en donde 
se le consulta al alumno el porcentaje de manejo 
de la herramienta que cree tener.

- Pregunta 4:

¿Cuáles herramientas de Revit ha utilizado para 
eficientizar el trabajo en entregas de juegos de 
planos?

Esta pregunta complementa la anterior. Dentro de 
Revit hay herramientas específicas para mejorar el 
lenguaje gráfico y optimizar el trabajo, en este inciso 
se le pide al alumno enlistar las herramientas que 
ha utilizado; esto para evaluar qué porcentaje las 
conoce o las ha puesto en práctica.

- Pregunta 5:

A su criterio, ¿qué software cree que es más 
conveniente para realizar una planificación de 
forma digital?

En este inciso se le dan las siguientes opciones al 
alumno: 
• AutoCAD
• Revit
• Ambos son útiles
• Otro
Esto debido a que algunos alumnos prefieren 
trabajar planificaciones en otros software ya sea 
porque ven a Revit complicado de manejar o 
porque se sienten más cómodos trabajando en otro 
programa. Lo que se quiere obtener es el porcentaje 
de alumnos que, a pesar de contar con clases en la 
facultad, prefieren trabajar en otro software.

- Pregunta 6:

¿Conoce la diferencia entre los planos entregables 
para una fase de diseño y los planos entregables 
para una planificación arquitectónica?

Esta pregunta es para verificar qué porcentaje de 
alumnos conoce la diferencia entre ambas. 

- Pregunta 7:

¿Ha realizado planos de presentación 
arquitectónica en Revit?

Antes de realizar esta pregunta, se explicará de 
una forma breve la diferencia entre ambas. Después 
de eso se plantea la pregunta 7. Esta servirá para 
verificar si los alumnos han realizado planos de  
presentaciones arquitecónicas en Revit.

- Pregunta 8:

¿Ha realizado una planificación arquitectónica 
completa en Revit?

Esta pregunta verificará qué porcentaje de 
alumnos considera que ha realizado una 
planificación completa en Revit.

- Pregunta 9:

¿Considera correcto desarrollar un proyecto en 
Revit y realizar su planificación arquitectónica 
en el mismo software para entregas de Práctica 
Integrada I, II y Diseño Arquitectónico? ¿Por qué?

Esta pregunta se plantea ya que, al igual que la 
pregunta 5, algunos alumnos prefieren realizar el 
modelado de un proyecto en Revit pero exportan 
plantas y realizan la planificación en otro software. 
Con esta pregunta se comprobará si cierto 
porcentaje continua realizando esta práctica o ya 
comienza a utilizar Revt para el trabajo completo.

- Pregunta 10:

A su criterio, ¿cuáles son los planos a entregar en 
fase de Diseño?

Con esta pregunta el estudiante podrá enlistar 
los planos que considera útiles para una fase de 
Diseño. Esto será útil para verificar qué porcentaje 
realmente conoce cuáles son los entregables para 
comprender el proyecto en este nivel.
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- Pregunta 11:

A su criterio, ¿cuáles son los planos a entregar para 
una planificación arquitectónica?

Al igual que la pregunta anterior, en este inciso el 
estudiante podrá enlistar los planos que considere 
apropiados. Igualmente, verificará qué porcentaje 
de ellos realmente conoce los entregables que se 
brindan en esta fase.
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1. ¿Cómo considera la claridad y calidad de las 
proyecciones ortogonales con la que los alumnos 
presentan sus proyectos en asesorías? (Plantas, 
elevaciones, secciones, vistas de detalle).

• Excelente
• Buena
• Regular
• Mala

2. ¿Cómo considera la claridad y calidad de 
los planos con la que los alumnos presentan sus 
proyectos en entregas? (Plantas, elevaciones, 
secciones, detalles).

• Excelente
• Buena
• Regular
• Mala

3. En un proyecto arquitectónico, ¿considera tan 
importante la representación bidimensional como la 
tridimensional (renders y/o maquetas)?

• Sí
• No
¿Por qué?

4. ¿Considera que los estudiantes toman en cuenta 
los criterios aprendidos en la asignatura de Dibujo 
Técnico para los cursos de Práctica Integrada, 
Herramientas Digitales y Diseño Arquitectónico?

• Sí
• No

ENCUESTA DE EXPRESIÓN GRÁFICA EN REVIT PARA CATEDRÁTICOS

Estas encuestas nos mostrarán el punto de vista de los catedráticos ante los resultados de los alumnos 
dentro del semestre evaluando qué tan bueno es el desempeño de los mismos en las asesorías y entregas.

5. ¿Considera que los alumnos comunican de mejor 
manera sus proyectos al entregar planos hechos 
a mano comparados con los elaborados con la 
ayuda de herramientas digitales?

• Sí
• No
¿Por qué?

6. ¿Considera que los alumnos deben instruirse un 
poco más por su cuenta en el uso de herramientas 
digitales para mejorar la calidad de presentación?

• Sí
• No

7. ¿Considera adecuada la implementación de una 
guía que instruya al alumno en el uso de herramientas 
digitales previo y durante las asignaturas?

• Sí
• No

8. ¿Considera importante el uso e implementación 
de la tecnología para realizar proyectos 
arquitectónicos dentro de la facultad para nuestra 
época actual?

• Sí
• No
¿Por qué?
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1. ¿Considera adecuados los documentos de 
apoyo brindados en Herramientas Digitales para 
la comprensión y el estudio de los alcances de 
documentación arquitectónica del software Revit?

• Sí
• No
¿Por qué?

2. ¿En qué lugares ha realizado entregas de juegos de 
planos trabajados en Revit durante su carrera?

• En la Universidad
• En el Trabajo
• En ambos

3. ¿Conoce las herramientas que se pueden 
utilizar en Revit para mejorar el lenguaje gráfico en 
una planificación y que sirven para simplificar su 
manipulación?

• Sí (100%)
• No (0%)
• En un 25%
• En un 50%
• En un 75%

4. ¿Cuáles herramientas de Revit ha utilizado para 
eficientizar el trabajo en entregas de juegos de planos?

5. A su criterio, ¿qué software cree que es más 
conveniente para realizar una planificación de forma 
digital?

• AutoCAD
• Revit
• Ambos son útiles
• Otro

6. ¿Conoce la diferencia entre los planos entregables 
para una fase de diseño y los planos entregables para 
una planificación arquitectónica?

• Sí
• No
Si la conoce, ¿cuál es?

ENCUESTA DE EXPRESIÓN GRÁFICA EN REVIT PARA ALUMNOS
Esta encuesta evaluará el nivel de conocimiento adquirido dentro de los cursos de Herramientas Digitales, Práctica 

Integrada I y II; y Diseño Arquitectónico en cuanto a los planos solicitados para entregas de proyectos.

Ya que hay una diferencia entre ambas y la definición 
de las dos es:
FASE DE DISEÑO: Todo lo que corresponde a 
presentación arquitectónica para dar a conocer un 
diseño.
FASE DE PLANIFICACIÓN: Todo lo que corresponde a 
planos constructivos de arquitectura.
Al saber esta diferencia, responda lo siguiente:

7. ¿Ha realizado planos de presentación 
arquitectónica en Revit?
• Sí
• No

8. ¿Ha realizado una planificación arquitectónica 
completa en Revit?
• Sí
• No

9. ¿Considera correcto desarrollar un proyecto en Revit 
y realizar su planificación arquitectónica en el mismo 
software para entregas de Práctica Integrada I, II y 
Diseño Arquitectónico?
• Sí
• No
¿Por qué?

10. Si ha desarrollado un proyecto en Revit, ¿se ha 
auxiliado de otros softwares para desarrollar plantas, 
elevaciones y secciones en entrega de planos y láminas 
de arquitectura?. Indique cuáles.

11. A su criterio, ¿cuáles son los planos a entregar en 

fase de Diseño?

12. A su criterio, ¿cuáles son los planos a entregar 
para una planificación arquitectónica?
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Anexo 03

Contenido

Planos varios trabajados como ejemplo de 
entregas en diferentes asignaturas de la carrera de 
Arquitectura de la Universidad de San Carlos de 
Guatemala.
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ESCALA:

FECHA:

INDICADA

CURSO:

PRÁCTICA INTEGRADA 1

CATEDRÁTICO:

HOJA:

GRUPO No. 0:

201314935 CRUZ ORTÍZ MARÍA ESTEPHANY

201315103 RODRIGUEZ AVILA JONATHAN H.
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PLANTA DE ACABADOS NIVEL 01

PLANILLA DE ACABADOS EN MURO
CODIGO DESCRIPCIÓN

A-02 MURO DE MAMPOSTERIA + REPELLO EXTRAFINO (VER FICHA DE ACABADOS)
A-04

A-05 AZULEJO SUG BLANCO HEXAGONAL DE 0.33 X 0.33 m DE VITERRA, SISA DE 2 mm COLOR
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PLANILLA DE ACABADOS EN PISOS
CODIGO DESCRIPCION

PE-01
PE-08 PISO IMITACION MADERA (VER FICHA TECNICA)

PI-01 PISO CERÁMICO TIPO NOVA COLOR BLANCO DE FERCO + SISA DE 2MM
SIN ARENA DE 60X60 CMS (VER FICHA TECNICA)

PI-06 PINTURA EPOXICA PARA PISO DE ALTO TRAFICO COLOR AMARILLO.
(VER FICHA DE ACABADOS)
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INDICA TIPO DE PUERTA

INDICA TIPO DE VENTANA

INDICA INICIO Y SENTIDO
DE MODULACIÓN EN PISO

S
D

3.20 m
0.90 m

V-01

P
M
C

PISO
MURO
CIELO

P00

0.00 INDICA ANCHO DE PUERTA

INDICA SILLAR DE VENTANA

INDICA DINTEL DE VENTANA

INDICA MATERIAL EN PISO

INDICA MATERIAL EN MUROS

INDICA MATERIAL EN CIELO

DESCRIPCIÓNTIPO

ACABADOS EN MUROS

C+PL

CP

CP+A

C+P

CERNIDO + PIEDRA LAJA

CERNIDO PLÁSTICO

CERNIDO PLÁSTICO + 
AZULEJO ANTIDESLIZANTE

CERNIDO + PINTURA PARA 
EXTERIOR

DESCRIPCIÓNTIPO

ACABADOS EN PISO

BB

BC

FCE

LO

ML

PC

PC+A

TC

AL

BALDOSA DE BARRO

BALDOSA DE CONCRETO

FUNDICIÓN DE CONCRETO 
ESTRIADO

FUNDICIÓN DE CONCRETO

MADERA LAMINADA

PISO CERÁMICO

PISO CERÁMICO + 
ANTIDESLIZANTE

FUNDICIÓN DE CONCRETO 
PARA TRÁFICO

ALFOMBRA

DESCRIPCIÓNTIPO

ACABADOS EN CIELOS

PYL PLACAS DE YESO 
LAMINADO

NOTA:
PERFILERIA
1. TODOS LOS PERFILES SON DE ALUMINIO TIPO BOLSA ANODIZADO EN COLOR NEGRO. 
EL ANODIZADO DE LAS PIEZAS DEBERA SER UNIFORME EN CALIDAD DE COLOR Y 
TEXTURA. DEBERAN ENTREGARSE SIN NINGUN DEFECTO.
2. TODAS LAS RANURAS ENTRE EL ALUMINIO, MAMPOSTERIA Y ESTRUCTURA IRAN 
SELLADAS CON SILICON GE012A DE GENERAL ELECTRIC O SIMILAR. EL SILICON SE 
APLICARA PERIMETRALMENTE POR DENTRO Y POR FUERA DE LA VENTANA. NINGUNA 
RANURA DEBERA SER MAYOR A 3MM.

VENTANAS:
1. EL VIDRIO SERA CLARO LAMINADO DE 8MM DE ESPESOR. SALVO ESPECIFICACION 
CONTRARIA DE ACABADO Y ESPESOR.
2. LOS VIDRIOS DEBERAN ENTREGARSE LIMPIOS, SIN RAYONES Y LIBRES DE DEFECTOS.
3. LAS JUNTAS A HUESO EN VIDRIO SON, CANTO VIVO LIJADO CON SEPARACION ENTRE 
VIDRIOS DE 3MM SELLANDOSE LA UNION CON SILICON TRANSPARENTE.

NOTAS DE VENTANERÍA:
1. PREVIA FABRICACION DE LA VENTANERIA, SE DEBERAN RECTIFICAR LAS MEDIDAS DE 
TODOS LOS VANOS EN OBRA.
2. LAS VENTANAS SE SUJETARAN A LA MAMPOSTERIA Y SILLARES CON TORNILLOS NO 
FERROSOS DE 2" CON ZOQUETES DE PLASTICO A UN ESPACIAMIENTO MAXIMO DE 0.40M, 
EL PRIMER TORNILLO IRA A 0.10M DE LAS ESQUINAS DE LAS VENTANAS. LA SUJECION A 
LA ESTRUCTURA DEBERA HACERSE CON EL MISMO ESPACIAMIENTO DE 0.40 MAXIMO. SI 
FUERA NECESARIO UNA SUJECION MEJOR, DEBERA SER PROPUESTA POR EL 
VENTANERO.

PUERTAS DE VIDRIO:
1. EN PUERTAS DE VIDRIO, EL VIDRIO SERA CLARO TEMPLADO DE 10MM DE ESPESOR.

COLEGIO DE INGENIEROS DE GUATEMALA

UNIVERSIDAD DE SAN CARLOS

PROYECTO:

FECHA:

ESCALA:

DOCENTE:

GRUPO:

CURSO:

SECCIÓN: A E I

P. INTEGRADA 121/03/2017

INDICADA

ARQ. ROLANDO PEREZ

2 9A

1 : 125
PLANTA DE ACABADOS + UBICACIÓN DE PUERTAS Y VENTANAS - SEGUNDO NIVEL

PLANTA DE
ACABADOS

ESPECIFICACIONES EN PISOS

TIPO DESCRIPCIÓN

AL

FUNDICIÓN DE CONCRETO PARA TRÁFICO, COLOCADA
EN INTERIOR SOBRE CAPA DE SELECTO + ALFOMBRA
MODULAR DE 4' X 8' COLOR AZUL, ACABADO
GRANULADO RÍGIDO T=0.004

BB
BALDOSAS DE BARRO, COLOCADA EN EXTERIOR,
MODULADA POR BLOQUES DE 0.07 X 0.13 X 0.29, SOBRE
CAPA DE SELECTO.

BC
BALDOSAS DE CONCRETO PARA TRÁFICO, COLOCADA
EN EXTERIOR, MODULADA POR BLOQUES, SOBRE CAPA
DE SELECTO.

FCE

FUNDICIÓN DE CONCRETO CON MORTERO DE CAPA
GRUESA A BASE DE CIMIENTO GRIS, ACABADO
ESTRIADO CON SISAS @ 0.025 + 1 MANO DE PRIMER+ 2
MANOS DE IMPERMEABILIZANTE

LO
FUNDICIÓN DE CONCRETO CON MORTERO DE CAPA
GRUESA A BASE DE CIMIENTO GRIS, ACABADO CERNIDO-
1 MANO DE PRIMER+ 2 MANOS DE IMPERMEABILIZANTE

ML

FUNDICIÓN DE CONCRETO PARA TRÁFICO, COLOCADA
EN INTERIOR + PISO DE MADERA LAMINADA, REGLAS DE
1" X 2" X 4' + CAPA DE BARNIZ, ACABADO MATE +
TRATAMIENTO PESTICIDA

PC
MORTERO ADHESIVO PARA MEZCLA SECA, TIPO
NIVELADOR + REVESTIMIENTO FINAL CON PISO
CERÁMICO 0.60 X 0.60 T=0.02 M COLOR MARFIL

PC+A

MORTERO ADHESIVO PARA MEZCLA SECA, TIPO
NIVELADOR + REVESTIMIENTO FINAL CON PISO
CERÁMICO 0.60 X 0.60 + ANTIDESLIZANTE T=0.02 M
COLOR CREMA O SIMILAR

TC
FUNDICIÓN DE CONCRETO PARA TRÁFICO, COLOCADA
EN EXTERIOR, FUNDIDA POR PLACAS SOBRE CAPA DE
SELECTO.

ESPECIFICACIONES EN MUROS

TIPO DESCRIPCIÓN

C+P
MURO DE MAMPOSTERÍA REFORZADA DE 0.14 X 0.19 X 0.39 + CERNIDO
+ 2 MANOS DE PINTURA DE EXTERIORES COLOR CAFÉ TERRACOTA
COLOCADO SOBRE MALLA GEOTEXTIL.

C+PL
MURO DE MAMPOSTERÍA REFORZADA DE 0.14 X 0.19 X 0.39 +
FACHALETA IMITACIÓN PIEDRA LAJA TONOS VERDES ADHERIDO CON
CAPA BASE DE PEGAMIX.

CP
MURO DE MAMPOSTERÍA REFORZADA DE 0.14 X 0.19 X 0.39 + CERNIDO
PLÁSTICO COLOR BLANCO DE 0.005 COLOCADO SOBRE MALLA
GEOTEXTIL.

CP+A

MURO DE MAMPOSTERÍA REFORZADA DE 0.14 X 0.19 X 0.39 + CERNIDO
PLÁSTICO COLOR BLANCO DE 0.005 COLOCADO SOBRE MALLA
GEOTEXTIL + AZULEJO ANTIDESLIZANTE 0.20 X 0.40 COLOR AZUL
INDIGO COLOCADO HORIZONTALMENTE HASTA H=2.50.

PLANILLA DE PUERTAS

TIPO CANT ANCHO ALTO DESCRIPCION

P-01 2 2.15 2.16
PUERTA PRINCIPAL, DOS HOJAS, VIDRIO TEMPLADO DE 10MM. SISTEMA
PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE 120CM Y
CERRADURA A PISO

P-02 11 1.45 2.10
PUERTA DE DOBLE HOJA DE MADERA, MARCO DE MADERA, BASTIDOR
DE MADERA + LAMINADO DECORATIVO WILSONART CODIGO´ASTRO
STRANDZ #4940K - 18 PREMIUM AEON

P-03 11 0.90 2.10
PUERTA DE MADERA UNA HOJA, MARCO DE MADERA, BASTIDOR DE
MADERA + LAMINADO DECORATIVO WILSONART CODIGO´ASTRO
STRANDZ #4940K - 18 PREMIUM AEON

P-04 13 0.70 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-05 1 1.00 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-06 13 0.90 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-07 16 0.80 2.10

PUERTA DE MADERA DE UNA HOJA PARA SERVICIO SANITARIO, MARCO
DE METAL PINTADO CON SHERWIN WILLIAMS CODIGO BUTTERFIELD
#SW6676, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO ASTRO STRANDZ #4940K-18 PREMIUM AEON

P-08 8 1.00 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-09 12 0.60 0.50

PUERTA ATAMBORADA DE UNA HOJA PARA DUCTO, MARCO DE
MADERA, MARCO DE MADERA, BASTIDOR DE MADERA + LAMINADO
DECORATIVO WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18
PREMIUM AEON

P-10 3 1.50 2.10
PUERTA ATAMBORADA DE DOS HOJAS, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-11 1 2.00 2.10
PUERTA ATAMBORADA DE DOS HOJAS, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-12 6 0.80 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-13 2 1.20 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-14 3 1.00 2.10
PUERTA ATAMBORADA DE UNA HOJA, MARCO DE MADERA, MARCO DE
MADERA, BASTIDOR DE MADERA + LAMINADO DECORATIVO
WILSONART CODIGO´ASTRO  STRANDZ #4940K - 18 PREMIUM AEON

P-15 2 2.18 2.16
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-16 1 1.45 2.16
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-17 1 1.20 2.19
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-18 2 1.15 2.16
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-19 1 1.27 2.16
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-20 1 1.13 2.16
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-21 1 2.13 2.16
PUERTA DE VIDRIO CON DOS HOJAS, VIDRIO TEMPLADO DE 10MM.
SISTEMA PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE
120CM Y CERRADURA A PISO

P-22 1 2.15 2.19
PUERTA PRINCIPAL, DOS HOJAS, VIDRIO TEMPLADO DE 10MM. SISTEMA
PARA PUERTA AUTOMATICA TIRADOR TIPO ESCALERA DE 120CM Y
CERRADURA A PISO

V-02 12 0.92 2.14
PVC LIVIANO COLOR BLANCO ABATIBLE + HOJA PROYECTABLE SERIE 60
SIN RETÍCULA +
VIDRIO CLARO DE 5mm

PLANILLA DE VENTANAS

TIPO CANTID
AD SILLAR DINTEL DESCRIPCIÓN

V-01 28 0.00 4.00 VENTANA DE CUERPOS FIJOS PVC LIVIANO COLOR NEGRO FIJO +
VIDRIO CLARO DE 10mm
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DETALLES
ESTRUCTURALES 01

DIGITALIZACIÓN EDIFICIO T1_FARUSAC
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JULIO 2017

ARQ. MOSHE ASTURIAS
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PLANTA DE COLUMNA Y ZAPATA

 1 : 25

SECCIÓN DE COLUMNAISOMÉTRICO COLUMNA Y ZAPATA

ISOMÉTRICO COLUMNA
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SECCIÓN DE ZAPATA

 1 : 10

PLANTA DE COLUMNA
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0 m

0.1
0 m

1.4
0 m

0.30m.0.30m.0.30m.0.30m.0.30m.0.30m.0.30m.0.30m.0.30m.

2.70 m. 1.20 m

3.90 m.

2.9
0 m

Niv.-5.95 m

Niv.-4.20 m

S

-2.497 m

SÓTANO 2

-5.997 m

SÓTANO 3

C D

3
A221

-
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0.7
1 m

0.9
4 m

0.3
0 m

1.5
0 m

-
---

3.3
9 m

-
---

0.9
1 m

0.2
1 m

0.1
8 m

0.1
8 m

0.30m. 0.30m.

Niv.-4.55 m

Niv.-4.37 m

Niv.-4.20 m

145°

Armadura superior No. 4
@0.20m

Armadura inferior
No. 4 @ 0.20m

Refuerzo de varilla
No. 3 @0.40m

0.30 m.0.30 m.

0.1
8 m

.

0.1
8 m

.

Armadura superior
Hierros No. 4 @0.20m

Armadura inferior
Hierros No.4 @0.20m

Refuerzo de Varilla 
No3 @ 0.40m

Pasamanos tubo de 
acero inoxidable Ø2"

Tubo de acero inoxidable Ø2"
Barra de Acero inoxidable 3/4"

Placa de acero Ø 3 x 1/2"

0.1
7 m

.

0.0
2 m

Tubo redondo de Ø2" calibre
1.5 mm en acero inoxidable

Tapón convexo de Ø2" en inox 
soldado a travesano

Platina de 1/4" soldada a tubos

Tapa metálica de 2mm de espesor
soldada a tubo

Tubo en acero inox Ø2"

Hormigón

Tornillo autoperforante
de 1/2"

Cerámico antiderrapante

Placa de acero Ø 
3 x 1/2"

Tubo de acero 
inoxidable de Ø 2 "

0.0
2 m

0.0
5 m 0.0

7 m

0.05 m

R = 0.03

Tubo de acero inox Ø2" 

Soldadura TIG 1/4" 

Soldadura MIG 1/4" 

Soporte 
pasamanos

SOPORTE PASAMANOS Y TUBO VERTICAL

SOPORTE  TUBO VERTICAL Y HORIZONTALES

Tubo de acero inox Ø1 1/2" 

Soporte Travesaños

Soldadura MIG 1/4"

Pasamanos tubo de acero 
inoxidable Ø2" 

D-X

D-X

Tubo de acero inoxidable Ø2" 

Tubo de acero inoxidable Ø 1 1/2"
con tapa lateral soldada 

Armadura superior
Hierros No. 4 @0.20m

Armadura inferior
Hierros No. 4 @0.20m

Refuerzos
Varilla No 3
@0.40m

Viga de 0.14 x 0.40
4Varillas No. 4
Est. No 4 @0.15m

Muro de Pit de Elevadores
Block de Concreto
(Ver Detalle en Plano de Pit de Elevadores)

ESPECIFICACIONES

1. Para la unión de tubos del pasamanos de escaleras se utilizarán las soldaduras del tipo indicado 
en cada detalle, siendo estos los descritos a continuación:

Soldadura TIG (Tungsten inert gas): Empleando electrodo permanente de tungsteno, aleado con 
porcentaje no superior a un 2%.

Soldadura MIG/MAG (Metal Inert Gas/Metal Active Gas): Soldadura por arco bajo gas protector con 
un electrodo consumible.

0.2
0 m

0.9
3 m

Varillas No. 4
Esl. No 3 @ 0.15m

Refuerzos de escalera
(Ver D-1)Piso
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EQUIVALENCIAS
Ø NOMINAL (mm) Ø NOMINAL (plg)

110 mm

Ø NOMINAL (cm)

11 cm 4 plg

160 mm 16 cm 6 plg

200 mm 20 cm 8 plg

250 mm 25 cm 10 plg

315 mm 31 cm 12 plg

60 mm 6 cm 2 plg

1. LA TUBERÍA DE INSTALACIÓN DE DRENAJES SE 
COLCARÁ SUSPENDIDA DE LA LOSA Y CUBIERTA POR 
EL CIELO FALSO DE LA EDIFICACIÓN.

NOTAS GENERALES

2. EL ANCLAJE A LA LOSA SERÁ POR MEDIO DE 
COLGANTES TIPO PERA, DIRECTAMENTE PERNADOS 
A LA LOSA Y AJUSTADOS AL PVC DIÁMETRO DE LA 
TUBERÍA
3. LA COTA INVERT DE INICIO SERÁ -0.60 m. A PARTIR 
DEL NPT, DICHA COTA SERÁ APLICADA AL 
ARTEFACTO MAS LEJANO DEL RAMAL.

4. LA TUBERÍA SERÁ COLOCADA CON UNA PENDIENTE 
RESPECTIVA DEL 1.00%.

5. EL SISTEMA SERÁ DISEÑADO DENTRO ÁREA DEL 
AMBIENTE AL QUE SIRVE YA QUE BAJO EL SE 
COLOCARÁ CIELO FALSO CON PANEL TABLAVERDE 
(RESISTENTE A LA HÚMEDAD) PARA PREVENSIÓN DE 
FUGAS.

CODO 90° EN POSICIÓN HORIZONTAL
DIAMETRO INDICADO

DESCRIPCIÓNSÍMBOLO

SIMBOLOGÍA DRENAJES

CODO 90° EN POSICIÓN VERTICAL
DIAMETRO INDICADO
CODO 45° EN POSICIÓN HORIZONTAL
DIAMETRO INDICADO
YEE 45° EN POSICIÓN HORIZONTAL
DIAMETRO INDICADO

SENTIDO DE PENDIENTE

INDICA TAPÓN DE PVC

TUBERÍA PVC DE DRENAJE 
SANITARIO  PVC DIÁMETRO 
INDICADO

INDICA DUCTO

TUBERÍA PVC DE DRENAJE 
PLUVIAL  PVC DIÁMETRO INDICADO

INDICA COLGANTE TIPO PERA @2.0MTS

INDICA CAJA

INDICA REJILLA

TEE SANITARIA EN POSICIÓN HORIZONTAL
DIAMETRO INDICADO

TUBERÍA PVC DE VENTILACIÓN       
PVC DIÁMETRO INDICADO

BAJADA DE DRENAJE 
PLUVIAL
ANCLADA EN DUCTO
PVC DIÁMETRO 4"

SUBIDA DE 
VENTILACIÓN
ANCLADA EN DUCTO
PVC DIÁMETRO 3"

BAJADA DE DRENAJE 
SANITARIO

ANCLADA EN DUCTO
PVC DIÁMETRO INDICADO

REGISTRO DE DRENAJE 
SANITARIO
EN DUCTO

TAPÓN PVC DIÁMETRO 6"

CONEXIÓN DE 
DRENAJE 

A VENTILACIÓN 
EN DUCTO

SALIDA DE VENTILACIÓN
PVC DIÁMETRO 3"

h= 0.40 m SOBRE LOSA 
FINAL

BAJADA DE DRENAJE 
PLUVIAL
SUSPENDIDA EN LOSA
PVC DIÁMETRO 4"

BAJADA DE DRENAJE 
SANITARIO
SUSPENDIDA EN LOSA
PVC DIÁMETRO INDICADO

SUBIDA DE 
VENTILACIÓN
ANCLADA EN DUCTO
PVC DIÁMETRO 3"

CONEXIÓN A 
VENTILACIÓN

+ REGISTRO SANITARIO
PVC DIÁMETRO 6"
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Anexo 04

Contenido

Planos completos en formato A1 ajustados a 
Tabloide de proyecto Edificio de Apartamentos 
trabajado como ejemplo para realizar la 
planificación arquitectónica.
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PLANILLA DE ACABADOS EN PISO
CÓDIGO ÁREA DESCRIPCIÓN

CE-BG 13760.09 m² PISO CERÁMICO COLOR BEIGE FORMATO 0.60 X 0.60 M, SISA DE COLOR
SIMILAR A PISO.

ÁREA TOTAL 13760.09 m²

PLANILLA DE ACABADOS EN MURO
CÓDIGO ÁREA DESCRIPCIÓN

CR+BL 28358.48 m² CERNIDO + PINTURA BLANCA
CR+NE 7933.19 m² CERNIDO + PINTURA NEGRA

M+PC 1193.29 m² ESTRUCTURA METÁLICA (VER DETALLE DE ESTRUCTURA EN PLANOS DE
DETALLES) + PINTURA AUTOMOTRIZ CAFÉ

NV+CE 837.72 m² MORTERO NIVELADOR 0.01M + CERÁMICO COLOR BEIGE FORMATO 0.60 X
0.60M

ÁREA TOTAL 38322.68 m²
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PLANTA DE UBICACIÓN DE PUERTAS Y VENTANAS NIVEL 03 AL 12

PLANILLA DE VENTANAS
CÓDIGO

DIMENSIONES
DESCRIPCIÓNANCHO ALTO SILLAR DINTEL CANTIDAD

V-01 1.40 2.00 0.42 2.42 320

MARCO DE ALUMINIO ANODIZADO COLOR NEGRO, PANEL
FIJO INFERIOR DE 50 CM DE ALTURA + VIDRIO LAMINADO
DE 4.4.1, PANEL INTERMEDIO DE 110 CM + PANELES
SUPERIORES PROYECTABLES DE 60 CM CON VIDRIO CLARO
DE 05 MM. O SIMILAR (VER FICHA DE ACABADOS PROVISTA
POR DESARROLLADOR).

V-02 0.40 1.60 0.82 2.42 100

MARCO DE ALUMINIO ANODIZADO COLOR NEGRO, PANEL
FIJO INFERIOR DE MITAD DE VANO + VIDRIO TIPO
SANDBLAST DE 05 MM. PANELES SUPERIORES PROYECTABLES
DE MITAD DE VANO CON VIDRIO CLARO DE 05 MM. O
SIMILAR (VER FICHA DE ACABADOS PROVISTA POR
DESARROLLADOR).

V-03 0.40 2.40 0.02 2.42 100

MARCO DE ALUMINIO ANODIZADO COLOR NEGRO, PANEL
FIJO INFERIOR DE MITAD DE VANO + VIDRIO TIPO
SANDBLAST DE 05 MM. PANELES SUPERIORES PROYECTABLES
DE MITAD DE VANO CON VIDRIO CLARO DE 05 MM. O
SIMILAR (VER FICHA DE ACABADOS PROVISTA POR
DESARROLLADOR).

TOTAL DE VENTANAS 520

PLANILLA DE PUERTAS
CÓDIGO

DIMENSIONES
DESCRIPCIÓNANCHO ALTO SILLAR DINTEL CANTIDAD

P-01 1.00 2.10 83 PUERTA ABATIBLE DE MADERA COLOR A DEFINIR

P-02 1.50 2.10 0.00 2.10 60 PUERTA ENCHAPADA DE MADERA, CORREDIZA,
COLOR A DEFINIR SEGÚN ESPECIFICACIONES

P-03 0.90 2.10 324 PUERTA ABATIBLE DE MADERA COLOR A DEFINIR

P-04 0.70 2.10 0.02 2.12 100 PUERTA ENCHAPADA DE MADERA, CORREDIZA,
COLOR A DEFINIR SEGÚN ESPECIFICACIONES

P-05 3.25 2.10 0.02 2.12 60
PUERTA ENCHAPADA DE MADERA, PLEGABLE (5
HOJAS), COLOR A DEFINIR SEGÚN
ESPECIFICACIONES

P-06 2.00 2.40 0.02 2.42 100
PUERTA DE PVC + PANELES DE VIDRIO,
CORREDIZA, COLOR A DEFINIR SEGÚN
ESPECIFICACIONES

P-07 0.70 2.10 0.02 2.12 203 PUERTA ABATIBLE DE MADERA COLOR A DEFINIR

P-08 1.60 2.10 0.02 2.12 100
PUERTA ENCHAPADA DE MADERA, PLEGABLE (5
HOJAS), COLOR A DEFINIR SEGÚN
ESPECIFICACIONES

TOTAL DE PUERTAS 1030
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ELEVACIÓN OESTE
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SECCIÓN LONGITUDINAL 01
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NOTAS DE PLANO

1. DENTRO DEL PLANO SE MUESTRAN DETALLES QUE INDICAN DIFERENTES TIPOS DE PUERTAS, SIN EMBARGO, 
PARA EFECTOS DE REPRESENTACIÓN DEL PLANO, SOLAMENTE SE DUPLICÓ LA VISTA DEL DETALLE DE P-01 
PARA MOSTRAR LA OPCIÓN DE DIAGRAMACIÓN DEL MISMO Y REPRESENTAR LA VISUALIZACIÓN CON 
DIFERENTES TIPOS DE PUERTAS INSERTADAS EN EL PLANO.
2. PREVIO A LA FABRICACIÓN DE PUERTAS Y VENTANERÍA, SE DEBERÁ CORROBORAR LAS MEDIDAS 
RESULTANTES DE VANO DENTRO DE LA OBRA.

SIMBOLOGÍA

0 INDICA EJE

LÍMITE DE TERRENO

ALINEACIÓN 
MUNICIPAL

INDICA TIPO DE PUERTA

INDICA VENTANA

P-01
0.00

S

D
V-01

0.00

0.00 INDICA TIPO

P-01
2.12

1.00

EXTERIOR

INTERIOR

0.
03

0.
04

2.
00

0.
04

P-01
2.12 2.

10

0.
04

2.
00

0.
04

0.
03

2.
10

0.03

0.95

0.03

1.00

P-01
2.12

C

C
C

AROL INA
ACADEM

IA
OA

TEMALENSISINTE

ICUA

O
RB

IS
CO

A R
S

E T
ÆC

R

NS
P

TUL ARULP S SUPERVISOR:

UNIVERSIDAD DE SAN CARLOS
DE GUATEMALA

FACULTAD DE ARQUITECTURA

PROYECTO:

UBICACIÓN:

FACULTAD DE ARQUITECTURA
CAMPUS_CIUDAD UNIVERSITARIA
ZONA 12 
GUATEMALA,GUATEMALA

HOJA:

PLANO DE:

ESCALA:

FECHA:

DOCUMENTACIÓN:

MELANIE OROZCO             201315051

SUPERVISORDECANO FARUSAC

INDICADA

Detalles de Puertas y
Ventanas

EDIFICIO DE APARTAMENTOS

P011

Abril 2020

Approver

1 : 25
PLANTA DETALLE P-01

1 : 25
ELEVACIÓN DETALLE P-01

3D P-01

1 : 25
PLANTA DETALLE P-02

1 : 25
ELEVACIÓN DETALLE P-02

3D P-02

1 : 25
PLANTA DETALLE P-03

1 : 25
ELEVACIÓN DETALLE P-03

3D P-03

1 : 25
PLANTA DETALLE P-04

3D P-04

1 : 25
ELEVACIÓN DETALLE P-04

PLANILLA DE PUERTAS
CÓDIGO DIMENSIONES

DESCRIPCIÓNANCHO ALTO SILLAR DINTEL CANTIDAD
P-01 1.00 2.10 83 PUERTA ABATIBLE DE MADERA COLOR A DEFINIR

P-02 1.50 2.10 0.00 2.10 60 PUERTA ENCHAPADA DE MADERA, CORREDIZA,
COLOR A DEFINIR SEGÚN ESPECIFICACIONES

P-03 0.90 2.10 324 PUERTA ABATIBLE DE MADERA COLOR A DEFINIR

P-04 0.70 2.10 0.02 2.12 100 PUERTA ENCHAPADA DE MADERA, CORREDIZA,
COLOR A DEFINIR SEGÚN ESPECIFICACIONES

P-05 3.25 2.10 0.02 2.12 60
PUERTA ENCHAPADA DE MADERA, PLEGABLE (5
HOJAS), COLOR A DEFINIR SEGÚN
ESPECIFICACIONES

TOTAL DE PUERTAS 627

1 : 25
PLANTA DETALLE P-05

1 : 25
ELEVACIÓN DETALLE P-05

3D P-05
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SIMBOLOGÍA

COLUMNAS

MUROS DE CORTE

MUROS DE MAMPOSTERÍA

MUROS PANELES / TABIQUE

0 INDICA EJE

INDICA NÚMERO DE VISTA 
DE SECCIÓN EN PLANO

INDICA NÚMERO DE PLANO 
EN DONDE SE UBICA LA VISTA

1
A-101

Ref
1

A101

INDICA NÚMERO DE VISTA DE 
DETALLE EN PLANO

INDICA NÚMERO DE PLANO EN 
DONDE SE UBICA LA VISTA

C

C
C

AROL INA
ACADEM

IA
OA

TEMALENSISINTE

ICUA

O
RB

IS
CO

A R
S

E T
ÆC

R

NS
P

TUL ARULP S SUPERVISOR:

UNIVERSIDAD DE SAN CARLOS
DE GUATEMALA

FACULTAD DE ARQUITECTURA

PROYECTO:

UBICACIÓN:

FACULTAD DE ARQUITECTURA
CAMPUS_CIUDAD UNIVERSITARIA
ZONA 12 
GUATEMALA,GUATEMALA

HOJA:

PLANO DE:

ESCALA:

FECHA:

DOCUMENTACIÓN:

MELANIE OROZCO             201315051

SUPERVISORDECANO FARUSAC

INDICADA

Detalles de Gradas y
Rampas

EDIFICIO DE APARTAMENTOS

P012

Abril 2020

Approver

1 : 50
DETALLE DE GRADAS MÓDULO 01

1 : 50
SECCIÓN 01 - MÓDULO DE GRADAS 01

1 : 50
SECCIÓN 02 - MÓDULO DE GRADAS 01

1 : 50
SECCIÓN 03 - MÓDULO DE GRADAS 03

1 : 20
DETALLE DE DIMENSIONES DE GRADAS

1 : 20
DETALLE DE ALTURA DE BARANDILLA

1 : 10
DETALLE DE REMATE DE BARANDILLA 01

1 : 10
DETALLE DE REMATE DE BARANDILLA 02

3D MÓDULO DE GRADAS 01
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